
Personality 
Select a personality. This menu includes your <Dominant> personality and any additional personalities you have 
defined for you to select for this message.



Stationery popup
Selects a stationery file for the new message.



Retrieve new mail
Transfer new mail for the personalities that have the Check mail option turned on in the Personalities Options. 
Or, as specified in the list on the right.



Include Headers
If this is on, the message’s (or the first of multiple messages) header information is included in the saved 
document. If this is not checked, only the body of the message is saved.



Guess Paragraphs
If this is on, extraneous carriage returns are removed from the message(s), leaving returns only at the ends of 
paragraphs and converting multiple spaces into tabs.



Stationery
Save as a Stationery file.



Send Queued messages
Send all the queued messages (marked “Q”) in your Out mailbox.



Delete messages marked for deletion
Delete the messages on the server that are marked Delete in Eudora. This is for messages that were left on the 
server with the Leave mail on server, Skip messages over ? k, or Fetch all message headers option.
To mark a message Delete, either click on the Trash icon in the message toolbar, or select Delete from the Server
Action popup of the message summary.



Retrieve messages marked for retrieval
Retrieve the messages on the server that are marked Fetch or Fetch & Delete in Eudora. This is for messages 
that were left on the server with the Leave mail on server, Skip messages over x k, or Fetch all message 
headers option.
To mark a message Fetch or Fetch & Delete, either click on the icons in the message toolbar, or select an option 
from the Server Action popup of the message summary.



Delete all messages that have been retrieved
Delete all the messages on the server that have already been transferred to the PC you are on.



Delete all messages on server
Delete all of your messages on the server. Be absolutely sure this is what you want to do because there is no 
way to undo it.



Fetch all message headers to In mailbox
Retrieve the header and the first few lines of every new message. If you select this option, the messages are 
filtered but Copy and Transfer actions are not done (the message won’t leave the In mailbox). Set the Server 
Action in the message summaries to specify what you want to do with the messages the next time you check mail.
Important:    If you delete the message header, and you have the Delete from server when emptied from Trash 
option on in the Checking Mail Options, the message is gone completely from Eudora and the server.



Apply Options to Personalities
Specify the personalities that you want to use with this mail transfer (hold down the Shift key to select multiple 
personalities in sequence, or the Ctrl key to select them out of sequence).



Find dialog
Use this dialog to find a character string within one message, multiple message, or even multiple mailboxes.



Find
Initiates a new search in a current message.



Next
Continues a search until the character string is found in either the same message or one of the other messages in 
the current mailbox.



Next Message
Begins a search at the next message following the current message.
Eudora continues the search even if it has to open more than one message or a new mailbox.



Next Mailbox
Begins the search at the next mailbox following the current mailbox.
Eudora continues the search among all messages in that mailbox and any subsequent mailboxes, including the In,
Out, and Trash mailboxes.



Character String Field
Specifies the character string to be found.
You can type the string into this field or highlight the character string you want (somewhere in Eudora), then select 
Enter Selection from the Find submenu. This automatically inserts the highlighted string into this field.



Match Case
When this is checked, Eudora searches for exact matches of the character string, including any capitalization.



Summaries Only
When this is checked, Eudora searches only the Sender and Subject fields of message summaries as they appear
in mailbox windows. (This is much faster than a full search).



Checking Spelling dialog
Use this dialog to check for misspellings in the body of current message composition windows, text files, and 
signature files. It includes a built-in dictionary and also allows for the creation of a custom user dictionary.
You can set the spell checker to ignore capitalized words, words with numbers, and mixed case words, to report 
mixed case and doubled (repeated) words, and to suggest alternative spellings.



Unknown
The unknown word is one that is not found in Eudora's    dictionary or your own custom dictionary. You can act on 
an unknown word using the buttons in this dialog.



Change To
Gives a suggestion for the correction, and lets you enter your own text if the suggestion does not work. You can 
also click on a suggestion in the Suggestions field and it will be entered in the Change To field.
To change the unknown word to the text in the Change To field, click on the Change or Change all button.



Suggestions
Lists suggestions for the correct spelling of the unknown word.
If the Always Suggest option is turned on (click on Options to see what options are on), all suggestions are listed
here by default. If the option is turned off, click the Suggest button to display the suggestions.



Ignore
Leaves this occurrence of the unknown word as it is and continues the spelling check.



Ignore all
Leaves all occurrences of the unknown word as they are and    continues the spelling check.



Change
Changes the unknown word to the text in the Change To field.



Change all
Changes every occurrence of the unknown word to the text in the Change To field.



Suggest
Displays in the Suggestions field all the suggestions for the correct spelling of the unknown word. If there are no 
suggestions in the dictionary, then none are listed.
If you want the suggestions displayed automatically, click on the Options button and turn on the Always Suggest 
option.



Add
Adds the unknown word to your custom dictionary.



Edit Dictionary
Displays the User Dictionary dialog so that you can add or delete words or clear your dictionary.



Edit Dictionary dialog
Use the User Dictionary dialog to add words to or delete words from your dictionary, or to clear the entire 
dictionary.



Word
Specifies what word is to be added or deleted from your dictionary.
You can type this into the field, or select a word from the dictionary.



Dictionary
Lists the words in your dictionary.



Add
Adds the word in the Word: field to your dictionary.



Delete
Deletes the word in the Word: field from your dictionary.



Clear
Clears the dictionary so that it is left empty.



Options
Displays the spell checking Preferences dialog so that you can set your spell checking options.



Check Spelling Preferences
Lists the six spell checking options. A check mark in the box next to the option name indicates that it is turned on.



Ignore capitalized words
If this is checked, words that start with capital letters are ignored.



Ignore words with numbers
If this is checked, words that contain numbers are ignored.



Ignore words with mixed case
If this is checked, words that contain both upper and lower case characters are ignored.



Report words with mixed case
If this is checked, words that contain both upper and lower case characters are reported and identified as Mixed 
case.



Report doubled words
If this is checked, words that appear twice in sequence in text are reported and identified as Doubled words.



Always suggest
If this is checked, Eudora's suggestions for the correct spelling of an unknown word are displayed    in the 
Suggestions field by default.



New Mailbox dialog
Use this dialog to create a new mailbox.



Name the new mailbox
Enter the name of the new mailbox.



Make it a folder
If this is checked, the new mailbox is created as a folder.
The New Mailbox dialog is displayed again so that you can create a mailbox that goes into the folder.



Don’t Transfer
If this is checked, the new mailbox is created but the selected messages are not transferred into it.



Change Queueing...
Use this dialog to queue the current messages, unqueue messages, or set a time for queued messages to be 
sent.



Send Message:
These options specify when the selected messages should be sent.



Right Now
Sets the message to send immediately when you click the OK button.



Next Time Queued Messages are Sent
Sets the message to be sent the next time queued messages are sent.



On or after
Sets a time and date for the message to be sent.
The message is saved in the Out mailbox with a T in the status column, just as if it were a normal queued 
message. However, the message is not sent until the specified time. For the message to be sent at the correct 
time, Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora is 
opened.



Time
Specifies what time the message will be sent.
Change the default time if you want the message to be sent at a different time. The message is saved in the Out 
mailbox with a T in the status column, then sent at the specified time. For the message to be sent at the correct 
time, Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora is next 
opened.



Date
Specifies what date the message will be sent.
Change the default date if you want the message to be sent at a different date. The message is saved in the Out 
mailbox with a T in the status column, then sent on the specified date. For the message to be sent at the correct 
time, Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora is next 
opened.



Don't Send
Changes the message status from queued to saved.



Change Password
Change the password for the selected account (personality).



Enter Password
Enter the password for the selected account.



Filters

The Make Filter dialog lets you create quick, simple filters that perform one operation—a mail transfer based on
one match condition—a piece of header information. The Filters window lets you create more complex, 
powerful filters that use multiple match conditions and perform multiple filter actions. (You can also use the 
Filters window to create simple filters such as those created by the Make Filter dialog.)

Note: To toggle from the left and right window panes, press F6.

To create or modify a detailed filter, do the following:

1. Click the New button or select an existing filter.

2. Choose the options for how you want the filter to be used, as an automatic filter to be invoked on any 
Incoming and/or Outgoing mail, and as a Manual filter that can be invoked when you choose Filter 
Messages from the Special menu. Any combination of these options works.

3. Define the criteria for the filter; use the header item pop-ups and the text fields to specify which header 
items should include a particular string of text. You can define two related terms for the criteria so that your 
filter is as specific as possible. 

4. Define the action or actions to be taken on messages that fit the and save the filters. 

Some filter actions have an associated icon. For these actions, Eudora places the action icon next to the filter in
the filters list. Up to five icons can appear per filter.

The Actions options are as follows:

None ¾ No action.

Make Status ¾ Assigns the selected status to message summaries.

Make Priority ¾ Assigns the selected priority level to messages. If you select a set level, messages are set to 
that priority. If you select Raise or Lower, messages are raised or lowered one priority level based on their pre-
filter level.

Make Label ¾ Assigns the selected label to messages. Label colors and names are set in the Labels options 
panel.

Make Personality ¾ Assigns the selected personality to messages. For outgoing messages, the message is 
sent from the assigned personality. For incoming messages, all your responses to the message will be from the
assigned personality until you change the personality associated with the incoming message or your response.

Make Subject ¾ Assigns the new subject to message summaries (does not affect the subject in the message 
itself). If you choose this option, the entire subject of the message is replaced with the new subject. Use the “&”
symbol to stand for the old subject if you want to add the new subject to the old subject. For example, entering 
New Subject [was &] results in New Subject [was Old Subject].

Play Sound ¾ Plays the selected sound when messages are filtered.

Open ¾ Opens the Mailbox and/or Message when a message is received. If you set a previous action to filter 
messages into a mailbox, then that mailbox is opened.



Print ¾ Prints one copy of each message.

Notify User ¾ Notifies you As Normal and/or In Report when messages are received. The As Normal option 
notifies you based on the options you have selected in the Getting Attention options panel. The In Report option
notifies you by opening the Filter Report window and displaying in that window a filter report that details what 
filter actions have been done. 

Notify Application ¾ Notifies the selected application when messages are received, and provides information 
from the message. Specify the application to use and the part of the message to be included.

Use the Browse button to select an application, or enter the command line yourself. The command line should 
include the path to the executable, any options, and the following substitution variables, all separated by blank 
spaces:

%1 Date
%2 To
%3 From
%4 Subject
%5 Cc
%6 The entire message

For example, the command line to send the subject of a message to a pager might look like this:

C:\apps\pager.exe -c %4

Forward To ¾ Forwards messages to the e-mail address given. Forwarded messages are placed in the queue 
in the Out mailbox, and sent the next time you send queued messages.

Redirect To ¾    Redirects messages to the e-mail address given. Redirected messages are placed in the 
queue in the Out mailbox, and sent the next time you send queued messages.

Reply with ¾ Replies to messages with the selected stationery message. Replies are placed in the queue in 
the Out mailbox and sent the next time you send queued messages. One typical use of this action is to reply to 
specific senders with stationery telling them that you’re on vacation: “I’m out till the 10th. I’ll reply to your 
message when I get back.” 

Server Options ¾ Sets the message’s server status to Fetch and/or Delete (incoming server only). The Fetch 
option specifies that the entire message be transferred from the server the next time mail is checked, and the 
Delete option specifies that the message be deleted from the server the next time mail is checked. If you select 
both, the message will be transferred and deleted.

Copy To ¾ Copies messages to the selected mailbox.

Transfer To ¾ Transfers messages to the selected mailbox.

Skip Rest ¾ Stops filtering for the message (the message is not matched to the rest of the filters in the filter 
list).

When the filters are invoked (automatically or manually), each message is matched against each filter in order 
from top to bottom. If the message meets a filter’s criteria, the actions are done as specified until there are no 
more actions, then the message is matched against the next filter. If at any point a Skip Rest action is done, 
nothing else is done with that message, and the next message is filtered.



You can change the width of the filters list to create more or less space for your list. To do this, put the arrow 
over the bar to the right of the list and drag the line to the left or right. 



Filter List
Displays the filters you have defined.
Filters are invoked from top to bottom as shown in the list. This order may be important when overlapping matches
exist.



Up
Moves the selected filter up in the filter list, changing the order it is invoked.



Down
Moves the selected filter down in the filter list, changing the order it is invoked.



New
Adds a new filter named “Untitled” to the filter list. The filter is named automatically based on the information you 
enter in the Header and Matching Text fields.



Remove
Removes the selected filter from the filter list. The filter is deleted when you save changes to the Filters window.



Incoming
If this is checked, the filter is invoked on all incoming messages.



Outgoing
If this is checked, the filter is invoked on all outgoing messages after they are sent.



Manual
If this is checked, the filter is invoked only when you select Filter Messages from the Special menu.



Header
Specifies which section of the message the filter will search. You can select an option from the popup menu or 
enter one yourself. This is helpful if you want to use a header item that does not appear on the menu, such as X-
Persona (for an alternate personality).
The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc), the «Any Header» option 
searches all message headers (including hidden headers that are shown with the Blah Blah Blah option), and the
«Body» option searches the message body.



Match
Specifies the type of match the filter performs when comparing the character string to the specified header.
contains or does not contain
If the specified header item contains or does not contain the text string, filter the message.
is or is not
If the specified header item is or is not a complete match of the text string, filter the message.
starts with or ends with
If the specified header item starts with or ends with the text string, filter the message. The starts with item refers 
to the first non-whitespace character after the colon, so any spaces after the colon are ignored.
appears or does not appear
If the header item appears or does not appear in the message, filter the message (the text field is ignored). This is 
useful for filtering messages based only on the types of fields they contain.
intersects nickname
If the text string is included in a nickname (whether it is a full address or a nickname within the nickname), filter the
message.



Matching Text
Specifies the character string that the filter searches for.
Keep this as specific and brief as possible. The greater the complexity of the search string, the less the likelihood 
of an exact match.



Conjunction
Specifies how the second criteria is to be used.
ignore
Ignore the second term; if the message matches the first term, filter the message.
and
If the message matches both the first and second terms, filter it.
or
If the message matches either term, filter it.
unless
If the message matches both the first and second terms, do not filter it. (This lets you exclude certain variations of 
the first term.)



Filter Actions
None (Filter Action) ¾ No action.
Make Status ¾ Assigns the selected status to messages. Select a status from the popup menu.
Make Priority ¾ Assigns the selected priority to messages. Select a priority from the popup menu.
Make Label ¾ Assigns the selected label to messages. Select a label from the popup menu.
Make Subject ¾ Assigns the subject to messages. Enter a subject in the text field. The new subject is given in the
message summary in the mailbox window, but the subject is not changed in the message itself. To include the text 
of the previous subject in your new subject, use the “&” symbol. For example, typing test message:& in this field 
results in the subject test message:previous subject.
Play Sound ¾ Plays the selected Sound when messages are received. Select a sound using the file dialog from 
the Sound button.
Open ¾ Opens the Mailbox and/or Message when a message is received. If you set a previous action to filter 
messages into a mailbox, then that mailbox is opened.
Print ¾ Prints one copy of each message.
Notify User ¾ Notifies you As normal and/or In report when messages are received. The As normal option notifies
you based on the options have selected in the Getting Attention Options. The In report option notifies you by 
displaying a Filter Report that details what filter actions have been taken.
Notify Application ¾ Notifies the selected application when messages are received, and provide information from
the message. Specify the application to use and the part of the message to be included. Use the Browse button to 
select an application, or enter the command line yourself. The command line should include the path to the 
executable, any options, and the following substitution variables, separated by blank spaces:

%1 Date
%2 To
%3 From
%4 Subject
%5 Cc
%6 Filename (will contain the entire message)

For example, the command line to send the subject of a message to a pager might look like this:
C:\apps\pager.exe -c %4

Forward To ¾ Forwards messages to the e-mail address. Enter an e-mail address in the text field. Forwarded 
messages are placed in the queue in the Out mailbox, and sent the next time you send queued messages.
Redirect To ¾ Redirects messages to the e-mail address. Enter an e-mail address in the text field. Redirected 
messages are placed in the queue in the Out mailbox, and sent the next time you send queued messages.
Reply With ¾ Replies to messages with the selected stationery file. Select a stationery file from the popup menu. 
Replies are placed in the queue in the Out mailbox, and sent the next time you send queued messages.
Server Options ¾ Assigns the selected server actions to messages (incoming server only). The Fetch option 
specifies that the entire message be transferred from the server the next time mail is checked, and the Delete 
option specifies that the message be deleted from the server the next time mail is checked. If you select both, the 
message will be transferred and deleted.
Copy To ¾ Copies messages to the selected mailbox. Select a mailbox from the popup menu.
Transfer To ¾ Transfers messages to the selected mailbox. Select a mailbox from the popup menu. If you add a 
new Transfer To action, a dialog is displayed asking if you want to add an implied Skip rest action. If you do not, 
subsequent actions in that or other filters could cause the message to be transferred out of the first mailbox you 
transferred it to.
Skip Rest ¾ Stops filtering for the message (the message is not matched to the rest of the filters in the list).



Mailboxes Window

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, and move 
mailboxes among folders. Mailboxes or folders that are bolded have unread messages.

By default, the Mailboxes window is provided as the first window in a five-window tool group docked vertically to
the left side of the main Eudora window.

To open a mailbox or folder within the window, double-click it, or click it once and press Enter. You can move 
among the folders and mailboxes using the up and down arrow keys, or close or open folders using the left and 
right arrow keys. You can also start typing the name of the mailbox or folder you want, and it is highlighted 
when you have typed enough unique characters to identify it (the item must be displayed, so a mailbox that is in
a closed folder cannot be selected).

Right-click any item in the Mailboxes window and a pop-up menu is displayed whose commands let you, 
depending on the item, create, remove, and rename mailboxes and folders, open existing mailboxes and 
folders, and empty the trash from the Trash mailbox.

The folder trees displayed in the Mailboxes window, and some of the operations available from the pop-up 
menu, depend on whether your incoming mail server for one or more mail accounts uses the POP or the IMAP 
protocol. 



 Mailboxes

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, and move 
mailboxes among folders. Mailboxes or folders that are bolded have unread messages.

By default, the Mailboxes window is provided as the first window in a five-window tool group docked vertically to
the left side of the main Eudora window.

To open a mailbox or folder within the window, double-click it, or click it once and press Enter. You can move 
among the folders and mailboxes using the up and down arrow keys, or close or open folders using the left and 
right arrow keys. You can also start typing the name of the mailbox or folder you want, and it is highlighted 
when you have typed enough unique characters to identify it (the item must be displayed, so a mailbox that is in
a closed folder cannot be selected).

Right-click any item in the Mailboxes window and a pop-up menu is displayed whose commands let you, 
depending on the item, create, remove, and rename mailboxes and folders, open existing mailboxes and 
folders, and empty the trash from the Trash mailbox.

The folder trees displayed in the Mailboxes window, and some of the operations available from the pop-up 
menu, depend on whether your incoming mail server for one or more mail accounts uses the POP or the IMAP 
protocol. 

To create a new mailbox or folder in the Mailboxes window, do the following:

1. Right-click on the folder. A pop-up menu is displayed.

2. From the pop-up menu, choose New. A dialog is displayed requesting the name of the new mailbox or 
folder.

3. Type in the new name, check the Make it a folder option if you want to, and click OK. If you chose to make
it a folder, enter the name of the mailbox when the dialog appears again, and click OK. The new mailbox or
folder is displayed in the lists, and is added to the Mailbox and Transfer menus.

To rename a mailbox or folder, do the following:

1. Click the mailbox or folder name once, pause, then click again to highlight just the name. 

2. Type in the new name. Or, right-click the item and choose Rename, or click once on the item and press F2,
then type in the new name. 

3. Press Enter to accept your change, or Esc to cancel it.

To move a mailbox from one folder to another, in the Mailboxes window select the one you want to move and 
drag it to where you want it.

To remove a mailbox or folder, either right-click it and choose Delete from the pop-up menu, or click once on it 
to highlight it and then press the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other mailboxes or 
folders are stored, you are prompted to confirm the deletion for each such item selected. Click Remove it to 
delete the current item for which you are being prompted, or click Remove all to remove all items selected for 
deletion—no further prompts will appear. Or click Cancel to cancel the deletion. If you delete a non-empty 



mailbox or folder, all messages, mailboxes, and folders contained within the mailbox or folder are also deleted.



 Address Book Files and Entries
Lists all your Address Book files and entries.
Files are shown as book icons and can be opened and closed by double-clicking on them.
· To select multiple files and entries, hold down the Shift key and make selections in sequence, or hold down the 

Ctrl key and make selections out of sequence.
Lists all your Address Book files and entries.
· To open and close an Address Book file (shown as a book icon), double-click on it.
· To select multiple files and entries, hold down the Shift key and make selections in sequence, or hold down the 

Ctrl key and make selections out of sequence.



 View By
Determines how the Address Book entries are displayed in the list-by Nickname, Address, Name, Postal address, 
Phone, or Fax.



 New (Address Book)
Creates a new entry or file.
The New Nickname dialog is displayed, prompting you to name the entry. You can also put the entry on the Quick 
Recipient List or Make the entry a file.



 Delete (Address Book)
Removes a selected entry or file from the list.



 To (Address Book)
Creates a new message addressed to the selected entry, or adds the selected entry to the active message.
To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and
make selections out of sequence.
You can also drag selected entries to the recipient fields of open messages.



 Cc (Address Book)
Creates a new message CC’d (carbon copy) to the selected entry, or adds the selected entry to the active 
message.
To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and
make selections out of sequence.
You can also drag selected entries to the recipient fields of open messages.



 Bcc (Address Book)
Creates a new message Bcc’d (blind carbon copy) to the selected entry, or adds the selected entry to the active 
message.
To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and
make selections out of sequence.
You can also drag selected entries to the recipient fields of open messages.



 Expand Nickname
If this is checked, the full address(es) are inserted into the message address fields (instead of the nickname) when
you use the To, Cc, or Bcc buttons.



 Nickname
The Nickname for the entry.



 Recipient List
If this is checked, the nickname is included in the Quick Recipient List.
To put multiple entries on the Quick Recipient List, select the entries then check this option for any one of them.



 Address(es)
The e-mail addresses that are included in the nickname.
You can use full addresses and nicknames in this field, just be sure any nicknames you use are defined in another
entry. Separate each address or nickname with a comma or a carriage return (Enter). This is the only place you 
can use a carriage return to separate addresses.
If you do not have a Name defined for the entry (in the Info tab), all of the addresses in this field will be included in 
outgoing mail.



 Notes
Your notes for the entry. This information is not included in an outgoing message.



 Name
The name of the entry.
If there is more than one address for an entry, only the Name is given in the To field of outgoing messages, not the
list of addresses. This is similar to Bcc, because the recipient list is hidden to each recipient.



 Postal Address
The postal address the entry. This information is not included in an outgoing message.



 Phone
The phone number for the entry. This information is not included in an outgoing message.



 Fax
The fax number for the entry. This information is not included in an outgoing message.



 New Nickname
The New Nickname dialog lets you create a new entry for your Address Book.



 What do you wish to call it?
The nickname for the new entry.



 File
The file that the entry should go into.
This option is not available if you select the Make it an address book option.



 Put it on the recipient list
If this is checked, the entry is included in the recipient list.



 Make it an address book
If this is checked, a file is created instead of a new entry.



 Directory Services
Use Directory Services to access two different services, Ph and Finger.
Ph and Finger inquiries will only work if you have the appropriate software running on your server.



 Server button
Displays a list of servers that the active server knows about. Double-click on a server in the list to add it to your 
Server field.
This is not always a comprehensive list of Ph servers.



 Server field
Lists the server from the Server field of the Hosts Options dialog.
You can enter a different server name for this session. The next time you open the window, the server will be reset
to the name in the Options dialog.



 Command
Specifies the name or address being searched for, whether you will use Ph or Finger.



 Response
Displays the server or host response.



 Ph
Initiates a Ph query for the text in the Command field.



 Finger
Initiates a Finger query for the text in the Command field.



 To
Adds the selected query results to the To field of a new message (opens a new message if necessary).



 Cc
Adds the selected query results to the Cc field of a new message (opens a new message if necessary).



Bcc
Adds the selected query results to the Bcc field of a new message (opens a new message if necessary).



 Keep on top
If this is on, when you use the To, Cc, or Bcc buttons the Directory Services windows stays active (on top of the 
message window).



 Signature Name
The name of the new signature you are creating.



Real Name
The real name assigned to this e-mail account: generally a first and last name. The text you enter here is included 
in the From field of all your outgoing messages from this account, and identifies to your recipients whom the mail 
is from.



Return Address
The return e-mail address used in outgoing messages and your recipients' replies for this account, if the address 
is different from this personality's incoming e-mail account. The address you enter is included in the From field of 
all your outgoing messages from this account, and when a recipient replies to a message from this personality, the
reply is sent to this address. If you do not enter an address in this field, Eudora uses the personality's incoming e-
mail account as the return address. Note: If you do enter an address in this field, first test the address to be sure 
that mail sent to it is indeed delivered to you. If you use an invalid return address, no one will be able to reply to 
your mail sent from this personality.



Login Name
This is the name you use to log in to this e-mail account, if the account requires a user login. Login names 
generally consist of the text before the at sign (@) in your return address or incoming e-mail account. For 
example, in the return address beatrixp@qualcomm.com, the login name is beatrixp.



SMTP Server
This is the name of the outgoing mail server for this account. SMTP stands for Simple Mail Transfer Protocol. 
Outgoing messages you send are routed through this server. If the computer that this personality's incoming mail 
account is on also runs an SMTP server, you can leave this field blank. Otherwise, enter the full name of the 
computer running the SMTP server.



Default Domain
This is the domain name that Eudora automatically adds to an unqualified name addressed in messages sent from
this account. An unqualified name is a name that doesn't have an "@" sign followed by a domain name. This can 
be used to save time when addressing large numbers of messages to users in the same domain.



Default Stationery
The default stationery to use for all outgoing messages sent from this account. Select a stationery file from the 
popup, or select <No Default> for no default stationery. See the User Manual for details on using stationery with 
alternate personalities.



Default Signature
This sets the default signature to use for all outgoing messages sent from this account, but only when you are not 
using stationery (that is, only when the Default Stationery popup in this dialog is set to <No Default>). If you have 
chosen a stationery file in the Default Stationery field, then the signature saved with that stationery will override 
your setting here.
Select a signature from this popup, or select <No Default> for no default signature. If you select a signature, 
Eudora automatically attaches that signature to the end of all outgoing messages sent from this account. You can 
always change the signature in a particular outgoing message using the Signature popup in the composition 
window. See the User Manual for more details about using signatures with alternate personalities.



Check Mail
If this option is on, then mail checking is activated for this account in the following ways:
If you have specified a number in the Check for mail every ? minutes option in the Checking Mail Options, then 
when automatic mail-checks are performed at these intervals, mail for this account is checked too.
Each time you do a manual check for mail, by selecting the Check Mail command from the File menu or via 
another method, mail is checked for this account too.
If this option is off, then mail for this personality is not checked during manual or automatic mail-checks, except 
that you can override the setting and still check for the personality's mail using the Mail Transfer Options dialog 
(POP account only) or the Check Mail command on the popup menu displayed by right-clicking in the 
Personalities window.



Transfer to New Mailbox
Click this button to transfer the filtered message to a new mailbox that you will specify. The text field is filled in with
a suggested new-mailbox name based on your selected content match condition (From, Any Recipient, or 
Subject). You can change this name if you like.



Transfer to Existing Mailbox

Click this button to transfer the filtered message into one of your existing mailboxes. Select the mailbox from 
the button next to the field. The default mailbox is the In box. When you click the button, a version of the 
Transfer menu appears, letting you choose the mailbox from the Transfer menu.



Delete Message

Click this button to delete the message that satisfies the filter match conditions, transferring it to your Trash 
mailbox. This feature is useful for deleting junk e-mail, or “spam” as it is called in the Internet world.



From
If you are making a filter from an existing e-mail message, the sender of the e-mail’s name and e-mail address is 
in this field. You can modify this field. For example, if you want all messages from this person to go to a specific 
mailbox, just leave this field as is.



Any Recipient
This field searches all possible recipient items. The default is your name and e-mail address. You can change the 
name in this field. For example, if you want mail to this recipient other than you to be placed into a specific 
mailbox, enter the name and e-mail address of that person in this field.



Stationery

Stationery files are templates for outgoing messages. If you find yourself repeatedly sending the same 
message, save the message as a stationery file and send it whenever you need to with the New Message With 
or Reply With commands. This way you don’t have to copy and paste text into a message; you can just open a 
pre-written message and edit it as necessary.

The Stationery window displays a single-column list of your stationery files.

Note: You can only select one item at a time in the list; you cannot select multiple items.

If you right-click a stationery item in the list, a context menu is displayed with the following commands (the 
standard Eudora window-management commands appear at the bottom):

• New — Create a new piece of stationery (a new stationery file). An untitled stationery window opens; enter 
the stationery name and from the File menu, choose Save As Stationery.

• Edit — Open an editing window for the selected stationery item. Make your changes and from the File menu, 
choose Save As Stationery, or close without saving to discard your changes.

• Delete — Delete the selected stationery item. Eudora asks you to confirm the deletion. Use the Del key 
(Delete) as a shortcut for this command.

• Rename — Rename the selected stationery file. Use the F2 key as a shortcut for this command, or click the 
stationery file’s name box, then edit the name right in the box.

• New Message With — Create a new message with the selected stationery. As a shortcut for this command, 
either select the stationery item and press Enter, or just double-click the stationery item.

• Reply With — Reply with the selected stationery to the sender(s) of the received messages that are currently
selected.

• Reply to All With — Reply with the selected stationery to the sender(s) and all recipients of the received 
messages that are currently selected.

You can also display the context menu and create new stationery by right-clicking anywhere in an empty 
Stationery window or by right-clicking anywhere off a stationery item in a non-empty Stationery window. 



Signatures

A signature is a few lines of text that is added automatically to the end of an outgoing message when it is sent. 
A signature can be whatever you want, but it is mostly used to give contact information (telephone, address, 
etc.). You use only one signature at a time in a message, but you can create as many different signatures as 
you want.

Note: Your signature is not displayed in the Eudora message window, but is added to the end of the 
message when it is sent.

The Signature window displays a single-column list of your signature files.

Note: You can only select one item at a time in the list; you cannot select multiple items.

If you right-click a signature in the list, a context menu is displayed with the following commands (the standard 
Eudora window-management commands appear at the bottom):

• New — Create a new signature. Eudora prompts you for the name of the new signature, then opens an 
editing window for you to type the signature text. Save the text with the File menu Save command, or close 
without saving to discard.

• Edit — Open an editing window for the selected signature. Double-click a signature as a shortcut for this 
command. Save your changes with the File menu Save command, or close the window without saving to 
discard your changes.

• Delete — Delete the selected signature. Eudora asks you to confirm the deletion. Use the Del key (Delete) as
a shortcut for this command.

• Rename — Rename the selected signature. Use the F2 key as a shortcut for this command, or click the 
signature item’s name box, then edit the name right in the box.

You can also display the context menu and create a new signature by right-clicking anywhere in an empty 
Signature window or by right-clicking anywhere off a signature item in a non-empty Signature window.



Address Book

The Address Book is where you keep information about individuals or groups that you correspond with. Each 
entry in the Address Book includes a nickname for a person or group, their full e-mail addresses, a real name, 
any contact information, and any notes. You can also use the Address Book to put nicknames on the Quick 
Recipient List, and to address a new message.

You can use the View By option to display the entries using any of the fields except the Notes field. For 
example, if you want to view the entries by nicknames, choose View By Nickname. If you view by a field that 
doesn’t contain any data, the entry is displayed with <>.

You can also start typing in the list of entries, and the appropriate entry will be selected when you enter enough 
unique characters to identify it.

Note: To toggle from the left and right window panes, press F6.

To create a new file of Address Book entries, do the following:

1. Click New, or right-click anywhere in the entry list and from the pop-up menu, choose New. A dialog is 
displayed asking what you want to call it.

2. Enter a name for the file and choose Make it an Address Book, then click OK to create it. The file is 
displayed in the list, and you can now add entries to the file.

To create a new entry to be included in an existing file, do the following: 

1. Click New or right-click anywhere in the entry list and from the pop-up menu, choose New. 

2. Select an address from anywhere in Eudora and drag it to the Address Book, or drag a message summary 
to the Address Book. A dialog is displayed. 

3. Enter a Nickname for the entry. A Nickname (sometimes called an alias) is an easily remembered, shorter 
substitute for the e-mail addresses in the entry. Nicknames can be used in place of proper e-mail 
addresses in the To, Cc, and Bcc fields of outgoing messages. For example, “buddies” may be a 
nickname that stands for a list of five complicated e-mail messages for five friends of yours. You’ll be 
sending mail addressed to “buddies” rather than having to enter those five complicated e-mail addresses 
in the recipient fields.

4. Specify which file this entry belongs in (if you have multiple files). 

5. If you want the nickname on your recipient list, select the Put it on the recipient list option. You cannot 
create a file within a file, so do not use the Make it an Address Book option. 

6. To create the entry, click OK. Then you can enter the information for that entry.

7. In the Address(es) tab, enter the complete e-mail addresses of the people (or person) to be included in 
the nickname, separating the addresses with commas or returns (this is the only place you can use a 
return to separate addresses). You can also use nicknames in this field, but be sure that any nicknames 
you use are defined in their own entry. You can use a mix of nicknames and complete e-mail addresses.

Note: Be sure there is no other information in this field except addresses or nicknames, or your messages 
will be addressed incorrectly.



9.            In the Name field (in the Info tab), enter the real name of the person or group. If there is just one address
for the entry, the real name and the address are included in the To field for your recipient to see. If there is 
more than one address for the entry, the real name is the only thing included in the To field for your 
recipients—they do not see the whole list of recipients. If there is nothing in the Name field, the recipients 
do see the whole list.

In the other fields provided in the Info (Postal Address, Phone, and Fax) and Notes tabs, you can enter 
contact information for the person or group, and any notes to yourself. This information is not included in 
outgoing messages.

We recommend that you have at most 2,500 entries per file. If you have a large number of entries, you may 
want to consider using a Ph server (for information, see the “Sources” section of the Eudora Reference 
Manual).

10.        To save your changes to the Address Book, from the File menu, choose Save.

To include a nickname in the Quick Recipient List, do the following:

1. Right-click the appropriate Address Book entry in the list and from the pop-up menu, choose Add to 
Recipient List. The nickname for the selected entry is included on the Quick Recipient List, and the entry 
is bolded in the Address Book list.

To remove a nickname from the Quick Recipient List, do the following:

1. Right-click the item in the Address Book list and from the pop-up menu, choose Remove From Recipient. 
The nickname for the selected entry is removed from the Quick Recipient List, and the entry is unbolded in 
the Address Book list.

If you change a nickname, the Quick Recipient List is updated as appropriate. 

Note: You can add or remove multiple nicknames to or from the Quick Recipient List by selecting multiple 
entries before right-clicking. Hold down the Shift key to select multiple entries in sequence, or the Ctrl 
key to make disjoint selections.



Directory Services

Eudora lets you look individuals up on the Internet, within your company, and in your Eudora Address Book (if 
you have one set up) using four directory service protocols: Ph, Finger, LDAP (Lightweight Directory Access 
Protocol), and Eudora Address Book.

The directory service protocols available to you for your search are listed in the Protocols section of the window.
The Protocols section of the Directory Services window lists the directory service protocols available to you that
you can use when creating and modifying databases for looking up individuals via these services.

Note: The Eudora Address Book protocol does not appear in the list until you have created an Address 
Book in Eudora.

To sort the protocols alphabetically, click the column heading (Registered Drivers). Shift-click the column 
heading to sort in reverse order.

You can resize the column by dragging the divider line to the right of the column heading to the left or right.

The databases you can use to look up your target individual are listed in the Databases list. The Databases 
section of the Directory Services window lists the databases that are available to you for searching for 
individuals over the Internet, within your company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

• ldap.bigfoot.com

• ldap.switchboard.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com

• Eudora Nicknames [or the name of your nicknames file; this last item appears only if you have a Eudora 
Address Book set up]

You can modify or delete these databases, and you can also create new databases and modify and delete 
them. 

You use the databases in this list to perform your lookup queries. To perform a query, you must first select one 
or more databases in the list. To select a database, click the checkbox to the left of the database name, until a 
checkmark appears in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list by that column, alphabetically. Shift-click the column heading to sort in 
reverse order.

To look someone up on the Internet, within your company, or in your Eudora Address Book, do the following:

1. In the Databases list, select the database(s) you want to search in your query.

2. To select a database, click the checkbox to the left of the database until a checkmark appears in the box. You 



can select multiple databases, and you can use multiple protocols. You must select at least one database in the
list in order for Eudora to perform the query. 

Note: Eudora remembers which databases you’ve selected when you quit and restart the        

program.

4. In the Query field, type a text string you want to search against.

If one or more of your selected databases use a protocol other than Ph, your entry in this field will always 
be interpreted as a name. If you only have Ph servers selected as your databases, you can enter any 
commands that Ph will interpret.

5. After you’ve typed the text, start the query by pressing Enter or clicking the Start button.

The query begins, and the Start button changes to Stop.

6. To stop the query before it is completed, click the Stop button.

When the query is completed, or if you click Stop to cancel the query, the Stop button changes back to Start.

To resize columns, position the mouse pointer over the divider line to the right of the desired column, and drag 
the line to the left or right.



Filter Report

If the Generate Filter Report option is turned on in Getting Attention options panel found in Options under the 
Tools menu. So when filters are used, Eudora generates a filter report. This report can be viewed in the Filter 
Report window found under the Tools menu.

If filter report generation is enabled via the option mentioned above, then each time a filter operation is 
performed, Eudora adds the entry or entries to the Filter Report window and activates the window.

The Filter Report window displays three columns of data:

• Mailbox — Lists the names of the mailboxes into which messages have been filtered during the current 
Eudora session. Each listing represents one filter operation for that mailbox.

• Messages — For each mailbox listed in the Mailbox column, lists the number of messages filtered into that 
mailbox during the filter operation.

• Time — For each mailbox listed in the Mailbox column, lists the time that the messages were filtered into that 
mailbox during the filter operation.

By default, the entries in the window are sorted by time. However, you can click the column headings and sort 
the display by mailbox names (Mailbox) or by the number of messages filtered (Messages).

Note: Whenever new entries are added to the list, Eudora always appends them to the bottom of the list in 
order of arrival, ignoring the current sort order. Simply click a column heading to re-sort.

Select one or more entries in the list and double-click the selection, or press Enter, and Eudora opens the 
mailbox windows associated with those selections.

The Filter Report listing is a cumulative log of the filter actions for the current Eudora session. Eudora 
automatically clears the log when you quit the program.

Closing the Filter Report window does not erase the contents of the filter report, as it did in previous versions of 
Eudora. Only quitting Eudora erases this information.



File Browser

Use this window to browse the Windows desktop. You can use this window to find files to attach to new 
outgoing messages, for example.

The File Browser window performs some, but not all, of the functions of the standard Windows 95 and Windows
NT 4.0 Explorer programs.

The File Browser window contains three controls:

• Drive Selector (top box) — A pop-up menu in this field contains a fixed set of high-level folders on your 
system, just like the corresponding control in Windows Explorer. The Drive Selector field determines what 
gets displayed in the Folder Browser (middle section). When you first launch Eudora, the Drive Selector 
automatically sets itself to the drive containing your Windows folder. Note that the first entry in the pop-up 
menu is a shortcut called “My Attachments” that points to your Eudora attachments folder.

• Folder Browser (middle section) — This is a tree control that displays the folder hierarchy whose root is the 
selection entered in the Drive Selector field. For example, if in the Drive Selector box you choose the C: 
drive, then the Folder Browser displays the folder tree-hierarchy branching down from the C: drive folder. 
Right-click a folder item in the Folder Browser to display the standard Windows context menu for that folder.

• File List (bottom section) — This is a list control that displays the files contained in the folder selected in the 
Folder Browser. You can select one or more file items in the list, then right-click the selection to display the 
standard Windows context menu for those files. (Note: Eudora does not fill in the Send To submenu on the 
context menu.) When selecting multiple items, use the Shift key to select a range of items, and use the Ctrl 
key for disjoint selections.

The File List control shows these four columns:

• Name — Displays the name of the file and the icon associated with the file.

• Type — Based on the file name extension, displays the file type as set in the Options dialog of Windows 
Explorer.

• Size — Displays the size of the file in kilobytes (K), where 1K = 1,024 bytes.

• Modified — Displays the date and time that the file was last modified.

As in Windows Explorer, you can click any of the four column headings to sort the listing by the data in that 
column.

You can also resize the widths of the columns by dragging the separator line between the column heading 
labels. Position the pointer over the separator until you see a splitter cursor, then drag the line to left or right.

In the File List control, double-click an item in the Name column, or select one or more items in the column and 
press Enter, to open the selected items. For program files, this action launches the program. For document 
files, this action generally launches the registered viewing or editing application for that document. Eudora 
displays an error dialog if it is unable to open a file in this way.

To adjust the relative heights of the Folder Browser and File List controls, position the pointer over the separator
bar between the Folder Browser and File List controls until the splitter cursor appears, then click and drag the 
separator up or down. Note that the File Browser window maintains a minimum height for the Folder Browser 



and File List controls, so you cannot close them all the way.

To manually refresh the File Browser window display, right-click anywhere in the File Browser window but not 
on a Folder Browser item or File List item, then choose Refresh from the context menu. (Tip: A good place to 
right-click is in the Drive Selector box.) Alternately, press the F5 key while keyboard focus is in the File Browser 
window.

You can select one or more files in the File List control and drag them to a message composition window to 
attach those files to that outgoing message. This is especially handy if you keep the File Browser window 
docked and open. (For multiple file selections, use the Shift key to select a range, and use the Ctrl key to make 
disjoint selections.)

You can also select one or more items in the File List control and drag them to another application that can 
receive such files.

In general, the File Browser window lets you drag items out of the window (copying them rather than moving 
them), but the window is not a proper drop target; you cannot drop items into the window that you’ve dragged 
from elsewhere on your desktop. In particular, you cannot move files by dragging them to a target folder in the 
Folder Browser control. You also cannot drag and drop items within the File Browser window (from one control 
to another, for example). You can, however, manage the files and folders in the window using the commands on
the window’s context menu, such as Cut, Copy, Paste, and Delete. 



Personalities

Use this window to manage, access, and apply your e-mail accounts —    “multiple personalities” — when you 
use more than one account.

The Personalities window displays two columns of data:

• Persona — The identifying name assigned to the personality. <Dominant> indicates your principal e-mail 
account, which is the account Eudora uses whenever you don’t specify otherwise, and is the account 
associated with all mail stored before you began using alternate personalities.

• Account — The incoming mail account assigned to the personality. This is generally in the form 
loginname@incomingmailserver.

To resize the column widths, position the pointer over the divider line between the column headings, until a 
splitter cursor appears. Then just drag the divider to left or right. Note that it is possible to completely collapse 
the Persona column.

Note: You cannot manually sort the information in the Personalities window. Clicking on a column heading 
does not do a sort 

Note: You can select multiple items in the Persona column to perform some of the operations listed below. 
Use the Shift key to select a range of items, and use the Ctrl key to make disjoint selections.

If you select one or more personalities in the Persona column and right-click the selection, a context menu is 
displayed with the following commands (the standard Eudora window-management commands appear at the 
bottom):

• Check Mail — Check mail now for all selected personalities.

• Send Queued Messages — Send messages queued by all selected personalities now.

• Message — This submenu lets you perform message-creation functions using only one selected personality. 
The submenu is unavailable if multiple personalities are selected in the Persona column. 

- New Message As — Create a new message as the selected personality. As a shortcut for this command,
double-click a personality in the Persona column, or select the personality and press Enter.

- Reply As — Reply as the selected personality to the sender(s) of the one or more received messages 
that are currently selected.

- Reply to All As — Reply as the selected personality to the sender(s) and all recipients of the one or 
more received messages that are currently selected.

- Forward As — Forward as the selected personality the one or more received messages that are 
currently selected.

- Redirect As — Redirect as the selected personality the one or more received messages that are 
currently selected.

- Send Again As — Resend as the selected personality the one or more received or composition 
messages that are currently selected.

• New — Create a new personality. When you select this command, Eudora walks you through the New 
Account Wizard. Enter a Personality Name (e.g., My Laptop Account) and click Next. You then have the 
choice to create a new e-mail account or import the settings from an existing e-mail account — that is, 



“clone” an existing personality. If you choose a new e-mail account, Eudora prompts you for your name, 
your return e-mail address, your login name, and your incoming e-mail server (POP or IMAP). Fill in each 
item as instructed. If you choose to import the settings from an existing e-mail account (clone a personality), 
Eudora asks you to choose the account to clone, then asks you to confirm the settings and optionally 
change them. If you leave them unchanged, the cloned account is created when you click Finish. If you 
choose to change them, Eudora walks you through the settings as above: name, return address, login 
name, and incoming e-mail server. Change these settings as desired, and when you are complete, the new 
account is created.

• Modify — Modify the selected personality. You can only modify one personality at a time. When you select 
this command, the Account Settings dialog displays, with its fields filled in with the information associated 
with that personality. See the description of this dialog below.

• Delete — Delete all selected personalities. Note, however, that you cannot delete the <Dominant> 
personality. You are prompted to confirm the deletion for each personality you have selected to delete. Note 
that these deletions are permanent and cannot be undone! When you delete a personality, any messages 
associated with that personality are reassigned to your Dominant personality. You can use the Del key 
(Delete) as a shortcut for this command (you will still get the confirmation requests).

You can also display the context menu and create a new personality by right-clicking in a blank area of the 
Personalities window, off all personality items, when none of the items are selected. When creating a new 
personality this way, you are walked through the New Account Wizard as in the description of the New 
command above.

If you drag one or more received messages to a personality item in the Personalities window, Eudora will Reply 
As that personality to the messages (hold down the Ctrl key to Reply to All As).



Query
Enter the name of the person you are searching for. 

If one or more of your selected databases use a protocol other than Ph, your entry in this field will always 
be interpreted as a name. If you only have Ph servers selected as your databases, you can enter any 
commands that Ph will interpret.



Start

After you’ve typed the text, start the query by pressing Enter or clicking the Start button. The query begins, and 
the Start button changes to Stop. To stop the query before it is completed, click the Stop button.

When the query is completed, or if you click Stop to cancel the query, the Stop button changes back to Start.



Status

This field displays the status of your query (such as Ready, Connecting, Getting Data, etc.) and the number 
of items found as shown in your summary list. This number is updated dynamically until the query is complete 
or you stop it.



To

Click the To button to create a new message with the To header field appropriately addressed with the selected 
query results.



Cc

Click the Cc button to create a new message with the Cc header field appropriately addressed with the selected
query results.



Bcc

Click the Bcc button to create a new message with the Bcc header field appropriately addressed with the 
selected query results.



Keep on top

When the Directory Services window is in the normal state (either alone or as part of a tabbed window group), 
check the Keep on top button to keep the Directory Services window on top of the other opened windows.



Results List

Your query results are listed in the left half of the Directory Services window, in the results list (top view) and the
details pane (bottom view). You can resize the two views relative to each other using the separator between 
them; drag the separator up or down.

The results list consists of one-line summaries of the successful targets of your query. These are listed by four 
columns: Name, Email, Phone, and Database. Name indicates the username (or other name) of the target. 
Email is the e-mail address of the target. Phone is the target’s telephone number. Database tells you in which 
of your selected databases the target was found.



Details List

Your query results are listed in the left half of the Directory Services window, in the results list (top view) and the
details pane (bottom view). You can resize the two views relative to each other using the separator between 
them; drag the separator up or down.

To view the details of a result in the details pane, select the result in the results list by clicking once on it. The 
full data appears in the details pane. If nothing is selected in the results list, the details pane is blank. If multiple 
summaries are selected in the results list, the details pane lists the details for each item, with each item 
separated by a divider line.



Protocols

The Protocols section of the Directory Services window lists the directory service protocols available to you 
that you can use when creating and modifying databases for looking up individuals via these services.

Eudora comes with four protocols installed by default: 
Ph, Finger, LDAP (Lightweight Directory Access Protocol), and Eudora Address Book.

Note: The Eudora Address Book protocol does not appear in the list until you have created an Address 
Book in Eudora.

To sort the protocols alphabetically, click the column heading (Registered Drivers). Shift-click the column 
heading to sort in reverse order.



Databases

The Databases section of the Directory Services window lists the databases that are available to you for 
searching for individuals over the Internet, within your company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

• ldap.bigfoot.com

• ldap.switchboard.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com

• Eudora Nicknames [or the name of your nicknames file; this last item appears only if you have a Eudora 
Address Book set up]

You can modify or delete these databases, and you can also create new databases and modify and delete 
them. 

You use the databases in this list to perform your lookup queries. To perform a query, you must first select one 
or more databases in the list. To select a database, click the checkbox to the left of the database name, until a 
checkmark appears in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list by that column, alphabetically. Shift-click the column heading to sort in 
reverse order.



TOC/Preview Pane

The top half of this window is the TOC (Table of Contents), and the bottom half is the Preview Pane. When you
check for mail, messages are delivered to your mailboxes with the In mailbox opened in the TOC (If you have 
no filters set up, all new messages are delivered to your In mailbox).The messages are listed in the order they 
are received, with the most recent message listed last. Unread messages are designated by a bullet in the 
Status column of the message summary.

Double-click anywhere on a message summary to open the message. You can also view messages using the 
message preview pane (see below for details) at the bottom of the mailbox window while the message 
summary is highlighted. 

Incoming messages are saved indefinitely in the In mailbox (or the mailbox they are filtered into) until they are 
deleted or transferred to another mailbox.

Also, you can select a message in the TOC and transfer it to another mailbox or to the Trash.

Once you select another mailbox, its messages and summaries are displayed in the TOC.

The Preview Pane shows you the full or partial content of a message without opening the message. It is 
located to the bottom of the list of messages in a mailbox. You can adjust the size of the preview window by 
placing the cursor on the window frame. Once the cursor changes to a double arrow, you can resize the 
preview window.

To activate the preview pane, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Viewing Mail . The Viewing Mail options window is displayed.

3. Click the Show message preview pane box.

4. Click OK.

The preview pane shows the key headers and the message body of the currently selected message in the 
message summary list. If the full message body is not visible in the preview window, scroll bars are displayed, 
allowing you to view the rest of the message. Only one message can be previewed at a time.

Press Tab or F6 to move the keyboard focus from the message summary list to the preview window (and back 
again). Or simply click in the preview window to put the focus there.

Once keyboard focus is in the preview window, you can do any of the following, as you can in an open incoming
message window:

• Press Space to page down through the message.

• Use the arrow keys, as set in the Miscellaneous options window (unmodified or with Ctrl or Alt), to switch to 
the next or previous message in the mailbox.

• Use standard keyboard shortcuts such as Ctrl+R for Reply, Ctrl+D for Delete, etc.

• Right-click anywhere in the preview window to display a pop-up menu with commands appropriate for the 
previewed message.



• Click an attachment icon or name to open the attachment.

• Click a URL (hot link) to launch the application for that URL.

If the Show message preview pane option is turned on in the Viewing Mail options window , you can press F7 
to show and hide the preview window within the current mailbox only (this does not control the visibility of the 
preview window in other mailboxes).

If the Show message preview pane option is off in the Viewing Mail options window , only the message 
summaries are shown in any mailbox window.

If the preview window option is on and the Mark previewed messages as read after ? second(s) option is 
turned on in the Viewing Mail options window, then the currently previewed message is marked as read (blank 
in the Status column) after the specified number of seconds. You can always change the message’s status 
back to Unread (•) by pressing Shift+Space while the message is selected or open (press again to change 
back to Read). If the Mark previewed option is off, previewed messages are never automatically marked as 
read.

Note: Eudora only performs the auto-marking behavior when you manually switch messages, not when it 
performs actions such as automatic mail checks or filtering.



Technical Support
Displays technical support information for this version of Eudora.



Tip of the Day
Displays the Tip of the Day. The Tip of the Day displays information about Eudora’s functionality.



Configuring Eudora

To configure Eudora, do the following:

1. Install Eudora and restart your computer.

2. Double-click the Eudora icon to open it. If you are installing Eudora for the first time, the New Account 
Wizard opens, showing the welcome screen. 

3. Click Next to begin setting up your new e-mail account.

4. Select an appropriate method of setting up your account: 

a. Import settings from an existing e-mail account (go to step 5) or

b. Instruct Eudora to get your settings from an ACAP server (go to step 6) (To get your settings 
from an ACAP server, make sure you are connected to the Internet.) or

c. Create a brand new e-mail account (go to step 7).

5. If you choose to import settings from an existing e-mail account, and you select the account and click Next,
Eudora asks you to confirm the settings and optionally change them. If you choose No and click Next, your
account is set up when you click Finish in the final window. If you choose Yes and click Next, the wizard 
walks you through the fields to be changed, as described further below. When you click Finish in the final 
window, your new account is set up.

6. If you choose the ACAP option and click Next, the Auto Configure window is displayed. Click Next again to
instruct Eudora to try to get your account settings from the ACAP server. If the attempt fails, click Back and
try one of the other options. 

7. If in the Account Setup window you choose to create a brand new e-mail account and click Next, the New 
Account Wizard begins guiding you through the fields for which you need to enter setup information.

8. In the windows of the New Account Wizard, enter the following field information (click Next after filling out 
each window):

• Your Name — Enter your name as you would like it to appear in the From field of all of your outgoing 
messages from this e-mail account, indicating to your recipients whom the mail is from.

• Return Address — Enter the e-mail address that has been assigned to you by your Internet Service 
Provider or your organization’s e-mail administrator. This is the address that other people will use to 
send you e-mail. Return addresses are generally of the form loginname@domainname, and 
beatrixp@qualcomm.com is an example.

• Login Name — Enter the name that you will use to log in to this e-mail account, if the account requires 
a user login. This name is provided by your Internet Service Provider or your organization’s e-mail 
administrator, and it usually consists of the text that appears before the at sign (@) in your return e-mail 
address. In the example beatrixp@qualcomm.com, the login name is beatrixp.

• Incoming E-mail Server — All of your incoming e-mail messages are delivered to your incoming e-mail
account, which resides on a computer that runs your incoming e-mail server. Once your messages 
arrive at your mail account, Eudora picks them up and transfers them to your PC. Your incoming e-mail 



server must use one of the two Internet-mail communications protocols POP (Post Office Protocol) or 
IMAP (Internet Message Access Protocol). If you are not sure which protocol it uses, select POP; you 
can always change this later. In the edit box, type the full name of the computer that runs your incoming 
e-mail server; bunnies.qualcomm.com is an example.

• If you chose IMAP in the previous setup window, an IMAP Mailbox Location Prefix may be required to
indicate the location of your personal mailboxes on the IMAP server. If so, enter the name of that 
location prefix as given to you by your Internet Service Provider (ISP) or e-mail administrator. If the 
information is not required, leave the field blank. Click Next, then in the last window, click Finish. Your 
new IMAP e-mail account is set up.

If you chose POP in the previous setup window, click Finish in the final window and your new POP e-
mail account is set up.

Once you have completed setting up your account via the New Account Wizard, you are now ready to receive 
messages. However, you may need to take an additional step in order to send messages.

To send messages in Eudora, you must have access to a computer running an SMTP (Simple Mail Transfer 
Protocol) server. Your outgoing messages are sent to the SMTP server, which delivers them to your recipients.

If the computer that runs your POP or IMAP server (incoming e-mail account) also runs an SMTP server, then 
no additional setup action is required. You are now ready to send and receive messages in Eudora.

If, however, your SMTP server runs on a different computer from the one running your POP or IMAP server, 
then take the following final setup action (you may want to consult your Internet Service Provider or e-mail 
administrator to help you set up the SMTP server).

To set up your SMTP server, do the following:

1. From the Tools menu, choose Options.

2.  Scroll through the Category icons, and choose Sending Mail. 

3. In the SMTP server field, enter the full name of the computer that runs your SMTP (outgoing) server 
(example: mysmtp.qualcomm.com). 

4. To save your setting and close the Options dialog , click OK. You are now ready to send and receive mail in
Eudora.

If you ever wish to change the settings of your e-mail account, you can do so from the Options dialog. See the 
section “The Options Dialog” in the Eudora Reference Manual.

You can also change these settings in the Account Settings dialog, which is accessed from the Personalities 
window. This window also lets you create alternate e-mail accounts and edit the settings in those accounts. For 
more details, see the sections Using an Alternate E-mail Account , Personalities Window , and Account Settings
Dialog .



Registering Your Copy of Eudora

Depending on the type of software license you have for Eudora, you may be eligible for technical support 
directly from the Eudora Technical Support group. To receive technical support, you must register your copy of 
Eudora Pro in accordance with the terms defined in your license Agreement. If you have a previous version of 
Eudora Pro, you need to register this new version.

Note: If you are part of a site license, you do not need to register. Contact your organization’s e-mail 
administrator for support.

If you are eligible for technical support, you are prompted to register after you send the first message with your 
new version of Eudora Pro. Complete the registration form and click Register. The registration is placed in your
Out mailbox and is sent the next time you send queued messages.

If you don’t want to register at that particular time, you can choose Not Now, but you will be prompted again 7 
days later. Or you can choose Never Register to never be prompted again. At any time, you can choose 
Register Eudora from the Help menu to display the registration form. 



Tip of the Day

Each time you open Eudora (including the first time after install), the Eudora Tip of the Day dialog is displayed 
showing you the Tip of the Day. You can display next and previous tips by clicking the Next Tip and Previous 
Tip buttons. To prevent the Tip of the Day dialog from being displayed on startup, uncheck the checkbox. You 
can always display the Tip of the Day from the Help menu.

Click the Close button to close the Tip of the Day dialog.



Online Help

There are several ways to get online Help with Eudora:

• To find out what something in the user interface does, open the Help menu or click the    Help button on the 
main toolbar (question-mark-and-arrow icon), and then click the item you want to know about. A brief 
description of the item is displayed. Click anywhere to close the description window.

• The F1 key also displays context-sensitive Help. Select the item you want to know about, or use the Tab and
arrow keys to move keyboard focus to that item, then press F1. (Keyboard focus is indicated by a dashed 
highlight box, a highlighted entry or item, or a flashing insertion cursor.)

• For instructions on how to do certain tasks, select from the Help menu. The Help Contents are displayed, 
and you either browse the contents or use the Find and Index options.

• The Eudora Tip of the Day provides snapshot information about an assortment of Eudora features. The Tip 
of the Day dialog is displayed each time you start up Eudora, and can also be displayed from the Help 
menu. See Tip of the Day .



Technical Support

If, after reviewing all of the available Help materials, you are still in need of assistance, contact your e-mail 
administrator (your Internet Service Provider or your company’s Eudora support coordinator) or the Eudora 
Technical Support group. If you are eligible for technical support, choose Technical Support from the Help 
menu, or check the inside cover of the manual for contact information.

You must register your copy of Eudora Pro to receive technical support. See Registering Your Copy of Eudora    
for details.



Quitting Eudora

To quit Eudora, do the following:

1. From the File menu , choose Exit, or press Ctrl+Q. 

If you have queued messages, or timed messages due to be sent in the next 12 hours, you are given the option
to send them. 

The Trash mailbox is emptied if the Empty Trash when exiting option is on in the Miscellaneous options. The 
Miscellaneous options are found under the Tools menu, then Options.



Uninstalling Eudora

You can uninstall Eudora by using the tools provided with your Windows 95 or Windows NT 4.0 (or later) 
operating system. To uninstall Eudora, do the following:

1. From the Start menu, choose Settings, then Control Panel. Open the Control Panel, double-click 
Add/Remove Programs, select Eudora Pro, and click Remove. Eudora will uninstall.



Create an Outgoing Message

An outgoing message is a message you send to someone else. The simplest way to create an outgoing 
message to do the following:

1. From the Message menu, choose New Message. A new message window is displayed, called the 
composition window. 



Use the Composition Window

The composition window consists of the title bar, the Toolbar, the message header, and the message body.

Title Bar

The title bar provides information about the message, including the name of the addressee, the time and date 
the message was sent, and the message subject.

Toolbar

The toolbar consists of a series of buttons and pop-ups that are displayed just under the title bar. It allows you 
to control the priority of your message, override some of your default options for the current message, send or 
queue the message, and apply text styles. Each button can be turned on or off for the current message by 
clicking on it (a button is on when it is depressed, and off when it is raised). You can set some of the defaults for
the toolbar in the Sending Mail Options Window.

The pop-up menus and buttons on the top row are described below.

Priority Popup ¾ This lets you indicate that your message is of higher or lower priority than a normal message.
For most messages, this is just an empty box (normal priority). For details, see Setting the Message Priority .

Signature Popup ¾ This lets you automatically append one of your signatures to the end of a message. For 
details, see Using a Signature .

Attachment Type Popup ¾ This lets you select the encoding format for attachments. For details, see 
Attaching a File to a Message .

Quoted-Printable Encoding ¾ If this is on, quoted-printable encoding is used when sending messages that 
contain special characters or long lines of text. It is used for all plain-text attachments. We recommend that you 
always keep this on.

Text As Attachment ¾ If this is on, plain text files are attached to messages, not incorporated into the 
message as part of the message body.

Word Wrap ¾ If this is on, a carriage return is not required at the end of each line. When the message is sent, 
the text is automatically “wrapped,” meaning that carriage returns are inserted at the end of each line of text, 
with roughly 76 characters per line.

Tabs in Body ¾ If this button is on, pressing the Tab key within the message body inserts a tab. If this button is
off, pressing the Tab key within the message body returns the cursor to the To field of the message header.

Keep Copy ¾ If this is on, a copy of each sent message is kept in the Out mailbox. These messages are saved
there until they are deleted or transferred.

Return Receipt ¾ If this is on, the message to your recipients includes a Notify Sender button that when 
clicked creates a message notifying you that the original message was viewed. This function does not work in 
all cases. For details, see Requesting a Return Receipt .

Send or Queue ¾ These let you send a message immediately or put it in the queue to send later. If the 
Immediate Send option in the Sending Mail Options Window is on, the button is labeled Send. If the option is 
off, the button is labeled Queue. For details, see Sending a Message Immediately or Queueing a Message to 
Send Later .



Following are descriptions of the pop-up menus and buttons on the bottom row. Note that this bottom row of the
toolbar, which controls text styles and other attributes, also appears in text file windows and signature windows.

Font Popup ¾ Make the selected text the selected font (typeface).

Size ¾ Make the selected text the selected size.

Bold ¾ Make the selected text bold.

Italics ¾ Make the selected text italic.

Underline ¾ Make the selected text underlined.

Color ¾ Make the selected text the selected color.

Typewriter ¾ Make the selected text the fixed-width width (typewriter-style) message font set in the Fonts 
options window .

Align Left ¾ Make the selected paragraph aligned to the left of the indent.

Align Center ¾ Make the selected paragraph aligned to the center of the indent.

Align Right ¾ Make the selected paragraph aligned to the right of the indent.

Indent In ¾ Make the selected paragraph indented once to the left.

Indent Out ¾ Remove one left indent for the selected paragraph.

Bulleted List ¾ Make the selected text a bulleted list.

Make Hyperlink ¾ Make the selected text or graphic a clickable hyperlink to a URL, so that when the recipient 
clicks the item, he or she is immediately taken to the URL.

Clear Formatting ¾ Removes all the formatting from the selected text or paragraph.

Insert Object ¾ Insert a specified picture (JPEG graphic file) or a horizontal line at the current cursor position 
in body text. For details, see Inserting Objects in Message Text .

For more information on text styles, see Formatting Text .

Message Header

Outgoing mail headers consist of six fields: To, From, Subject, Cc, Bcc, and Attached. Each field is described
below. The To, Subject, Cc, and Bcc fields can be directly edited. To move the cursor from field to field, press 
the Tab key or click in the desired field with the mouse.

To resize the Header region of the outgoing message window, drag the separator up or down. This applies to 
the current message only.

To: The intended recipients’ e-mail addresses, or nicknames you have defined (see Using the Address Book 
and Using the Quick Recipient List ). Multiple addresses and nicknames must be separated by commas.

From: The sender’s e-mail address. This is usually your incoming e-mail account plus your real name. You can
use a return address other than your incoming mail account by entering the address in the Return address 
field of the Getting Started Options Window.

The From field also reflects changes made with the Change Personality menu under the Message menu, if 



you have alternate personalities set up. See Using an Alternate E-mail Account .

Subject: Some brief text indicating the contents of the message. This field can be left blank, although it is 
considered a point of e-mail etiquette to include a Subject with each message.

Cc: The e-mail addresses or nicknames of people to whom a copy of the message is to be sent. These 
recipients are displayed in the message header for all recipients to see. Multiple addresses must be separated 
by commas. This field can be left blank. Cc stands for “carbon copy.”

Bcc: The e-mail addresses or nicknames of people to whom a blind copy of the message is to be sent. These 
recipients are not displayed in the message header, and the recipients in the To or Cc fields will not know that a
copy went to these addresses. This is useful when you want to send a copy of a message to someone without 
everyone else knowing you did so. Multiple addresses must be separated by commas. This field can be left 
blank. Bcc stands for “blind carbon copy.”

This field can also be used to put a copy of the message in one or more of your mailboxes. To do this, right-
click in the body of the message and select the mailbox from the Fcc menu (equivalent to the Transfer menu). 
The name of the mailbox is inserted into the Bcc field preceded by the expression “I\.” Repeat the procedure to
Fcc to multiple mailboxes; Eudora automatically separates the entries with commas. When the message is 
sent, a copy is put in each specified mailbox. Fcc stands for “folder carbon copy.”

Attached: A list of documents being attached to and sent along with the message. See Attaching a File to a 
Message for instructions on how to add attachments. To delete an attachment from an outgoing message, 
select it and press the backspace or delete key. This field can be left blank.

Message Body

After filling in the header fields, move the insertion point to the space below the message header. Type the body
of the message here. For information about formatting your message text, see Formatting Text.

You can insert pictures (JPEG graphic files) and horizontal lines into message text. For details, see Inserting 
Objects in Message Text .



Use an Alternate E-Mail Account

You can set up “multiple personalities” in Eudora for each e-mail account you have. For example, if you have 
Work, Home, and School e-mail accounts, you can set up Eudora to send and receive e-mail from each of 
these accounts, all without having to quit and restart Eudora. That is, you can check mail for all your accounts 
at once, or for selected accounts at once, and you can do the same for sending mail.

In earlier versions of Eudora, you specified the setup information for these different e-mail accounts, or 
“personalities,” in the Personalities options window. In Eudora 4.0, you use the Personalities window and the 
Account Settings dialog. Your “dominant” personality, or principal e-mail account, is set up via the New Account
Wizard when you install Eudora and can also be modified via the Account Settings dialog.

For detailed information on the Personalities window, its columns, the commands on its context menu, and the 
options in the Account Settings dialog, see Personalities Window. Below is the basic procedure for setting up 
alternate accounts, followed by additional information on using personalities to send and receive mail.

To create a new personality, or alternate e-mail account, perform the following procedure:

1. From the Tools menu, choose Personalities. The Personalities window opens.

Or click the Personalities window’s tab if it is the inactive window in a tabbed group.

2. Right-click anywhere inside the Personalities window and choose New from the context menu. The first 
window of the New Account Wizard displays.

3. Follow the setup instructions in each window of the New Account Wizard to create the new personality. 
See Personalities Window for more information.

4. When you have completed the new account setup, click Finish and the new personality is created.

During new account setup you specify the personality name and the following items associated with the 
account: the real name, the return e-mail address, the login name, and the incoming e-mail server (POP or 
IMAP).

To modify an existing personality, do the following:

1. Open the Personalities window.

2. Right-click the desired personality to display the context menu.

3. Choose Modify and then make your changes in the Account Settings dialog. For more information, see 
Account Settings Dialog .

All options other than those specified in the New Account Wizard or the Account Settings dialog cannot be 
changed for alternate personalities; they are effective for all. If you want to change other options for an alternate
personality or use a separate set of mailboxes for an account, see the section “Putting Multiple Users on One 
PC” in the Eudora Reference Manual for additional information.

To create an outgoing message from an alternate account, that is, as an alternate personality, do the following:

1. Open the Personalities window. 

2. Right-click the desired personality to display the context menu.

3. From the Message submenu, choose New Message As. 

Or, select the desired personality and press Enter. 

Or, simply double-click the desired personality. A new message opens from that personality.



A fourth way to create an outgoing message as an alternate personality is this: Hold down the shift key and 
select one of the message creation commands from the Message menu (New Message, New Message To, 
etc.). The Message Options dialog is displayed.

Note: The New Message With and Reply With commands will not display the Message Options dialog. If 
you want to open a stationery message with an alternate personality, use one of the other message 
creation commands to display the Message Options dialog.

Select the personality you want to use (and stationery if you want to), then click OK. A composition window is 
displayed, with the alternate personality as the sender (and any stationery text if applicable).

When the composition window opens in response to any of the four message-creation methods above, the 
default signature for the selected personality is used. But if a stationery file was selected or a default stationery 
file specified in the account’s options, then the signature stored with the stationery file is used. However, you 
can always change the signature pop-up in the composition window (for details, see Using a Signature ).

Once you open a new composition message from a particular personality, you can also change the message’s 
personality, that is, the sender,    by selecting the new personality from the Change Personality submenu under
the Message menu. The From field of the message header changes to the information associated with the new
personality.

When you respond to a message, Eudora assigns your response the same personality under which it received 
the message. For example, if you receive a message sent to your Home account, your replies to that message 
are sent from your Home account.

There are two ways to change the personality of a response:

1. The first is to initiate the response and then change the personality, using the Message menu Change 
Personality submenu.

2. The second way is to change the personality associated with the original message to which you are 
responding. Open that message and change its personality using the Change Personality submenu. From 
then on, all of your replies to that message will be sent from the newly assigned personality.

Note: You can also set up a filter to automatically assign a desired personality to incoming or outgoing 
messages that satisfy the filter criteria. See the Make Personality action in Filter Actions .



Use Stationery

Stationery files are templates for outgoing messages. If you find yourself repeatedly sending the same 
message, save the message as a stationery file and send it whenever you need to with the New Message With
or Reply With commands. This way you don’t have to copy and paste text into a message; you can just open a
pre-written message and edit it as necessary.

Stationery files are created and managed from the Stationery window. For more information, see Stationery 
Window . You can also open a new stationery message from the Stationery window.

For more information, see Creating a Stationery File and Sending a Stationery Message .



Create a Stationery File

To create a new stationery file, do the following:

1. From the Tools menu, choose Stationery. The Stationery window is displayed. 

Or click the Stationery window’s tab if it is the inactive window in a tabbed group.

2. Right-click anywhere inside the Stationery window and choose New from the context menu. Eudora 
opens a composition window to be used for stationery. The Send/Queue button is inactive in the 
window; thus the message cannot be sent or queued.

3. Enter the text you want to see into the message body, fill in the headers as appropriate (subject, copies,
etc.), and set the Toolbar.

4. Choose Save As Stationery from the File menu to display the Save as Stationery dialog.

5. Enter a file name and click Save to save the stationery file. The file is saved to your Stationery folder.

6. Close the stationery message.



Change a Stationery File

To change a stationery file, do the following:

1. In the Stationery window , right-click the stationery item you want to change.

2. Choose Edit from the context menu, then make your changes and save them with the Save As Stationery
command from the File menu.



Delete a Stationery File

To delete a stationery file, do the following:

1. Select the desired item in the Stationery window and press the delete key; or right-click the stationery item 
and choose Delete from the context menu. In either case you are prompted to confirm the delete.



Send a Stationery Message

To send a stationery message,    do the following: 

1. From the Message menu ,select a stationery file from the New Message With or Reply With submenus. A
composition window is displayed containing the header and body from the stationery file. If you are replying
to a message, the stationery information is added to the reply. You can edit and send this new message 
just as you would any other message.

2. Or you can send a new stationery message by double-clicking on a stationery item in the Stationery 
window, or by selecting the stationery item and pressing Enter. In either case, a new composition window 
opens containing the selected stationery.

To use a particular stationery file for all of your outgoing messages, do the following:

1. Open the Tools menu, choose Options, scroll and choose Sending Mail.

2. From the Stationery pop-up in the Sending Mail Options Window (for your dominant account only), select a
stationery, or in the Account Settings dialog (for any of your personalities). Most new messages use this 
file, unless you create the message using the Redirect, Send Again, New Message With, or Reply With 
command.

You can also set up a filter to reply with a stationery message. See Filtering Messages for more information.



Create a Message with Stationery

To send a stationery message, do the following:

1. From the Message menu, select the stationery you want from the New Message With or Reply With 
submenus. A Composition Window is displayed containing the toolbar, header, and body from the 
stationery file. 

If you are replying to a message, the stationery is incorporated into the reply. You can edit and send this 
new message just as you would any other message.

The stationery message toolbar overrides any of the Sending Mail or Personality options, such as the default 
signature, but you can change them once you open the message. Filter Actions .



Use a Stationery File for all Outgoing Messages

To use a particular stationery file for all of your outgoing messages, do the following:

1. Open the Tools menu, choose Options, scroll and choose Sending Mail.

2. From the Stationery pop-up in the Sending Mail Options Window (for your dominant account only), select a
stationery, or in the Account Settings dialog (for any of your personalities). Most new messages use this 
file, unless you create the message using the Redirect, Send Again, New Message With, or Reply With 
command.

You can also set up a filter to reply with a stationery message. See Filtering Messages for more information.



Use a Signature

A signature is a few lines of text that is added automatically to the end of an outgoing message when it is sent. 
A signature can be whatever you want, but it is mostly used to give contact information (telephone, address, 
etc.). You use only one signature at a time in a message, but you can create as many different signatures as 
you want.

Note: Your signature is not displayed in the Eudora message window, but is added to the end of the 
message when it is sent.

For more information, see Creating a Signature and Including a Signature in Messages .



Create a Signature

Eudora comes with a default signature called Standard. This is an empty signature file that you fill with 
signature text. Instructions for editing signature files appear after the procedure below.

To create a new signature, do the following:

1. From the Tools menu, choose Signatures. The Signature window is displayed.

Or click the Signature window’s tab if it is the inactive window in a tabbed group.

2. Right-click anywhere inside the Signature window and choose New from the context menu. Eudora 
displays the Create New Signature dialog, asking you for a name.

3. In the dialog, enter a signature name and click OK. A signature window is displayed.

4. Enter your signature text in the signature window. You can format the text with styles: see Formatting 
Text .

5. Save the signature file using the File menu Save command.

6. Close the signature window.



Change a Signature

To change a signature file, do the following:

1. In the Signature window, right-click the signature and choose Edit from the context menu. The signature 
window is displayed for that signature. 

2. Make any changes you want, save the file with the File menu Save command, and close the window.



Delete a Signature

To delete a signature file, do the following:

1. In the Signature window, select the desired signature and press the delete key.

Or right-click the signature item and choose Delete from the context menu. In either case you are 
prompted to confirm the delete.



Include a Signature in Messages

To include a particular signature in an outgoing message, select the signature you want from the Signature pop-
up on the message toolbar.

To include a particular signature in all of your outgoing messages—unless you are using stationery—select a 
signature from the Signature pop-up in the Sending Mail Options Window (for your dominant account only), or 
in the Account Settings dialog (for any of your personalities). You can change this for a particular message by 
selecting a different signature or None from the Signature pop-up on the message toolbar.

Note that if you open a new composition message with stationery, or if you have default stationery set for all 
new messages, then the signature stored with that stationery file is the one used with the new message, 
overriding any default signature. However, you can always make the final decision about what signature to send
with a new message by choosing it from the Signature pop-up on the message toolbar.



Set the Message Priority

You can assign a priority to incoming and outgoing messages. The priority is only for you and your recipients—it
does not affect the way mail transport systems handle the messages.

There are five priority levels available, 1 being the highest, 5 being the lowest. Each is represented by a small 
symbol in the Toolbar of a message window and the Priority column of a message summary. Priority 3 (Normal)
is used for messages that have no assigned priorities, and it is not displayed. The Highest priority symbol, a 
double-caret, is red; the Lowest priority symbol, an inverted double-caret, is blue.

New messages are created with a Normal priority. To change the priority of the current message, use the 
Priority pop-up.

Note: To set up Eudora to always use the sender’s priority on your replies, turn on the Copy original’s 
priority to reply option in the Replying Options Window. You can always change the priority in the 
message window.



Request a Return Receipt

You can request that your recipients notify you when they have seen your message. To do this, click the Return
Receipt button (RR) in the message toolbar.

When your recipients open the message and then close it, a dialog is displayed asking them to create a 
notification message now, later, or never (if you sent yourself a copy of the message, you will see the 
notification request). If a recipient chooses to create a notification message, it is sent to you and tells you when 
the recipient displayed your message.

If you receive a request for notification, click Now to queue the notification message in your Out mailbox: it will 
be sent the next time queued messages are sent. Click Later to close the message without sending a 
notification; however, each time you open the message and then close it (or if you try to delete it), the 
notification request will appear until you click either Now or Never. Click Never to cancel the notification 
request without ever sending a notification message. Click Cancel to dismiss the notification request from the 
screen while the return receipt message is open; however, if you close the message, the notification dialog is 
displayed again.

The Return Receipt options may or may not work as described, depending on your recipients’ e-mail software.



Format Text

You can use standard text-editing options to format the text of your outgoing messages, your text files, and your
signatures. The formatting is delivered to your recipients using text-editing standards in common use today, 
which means that the formatting your recipient sees depends on how well their e-mail package supports these 
standards.

It’s important to remember that you cannot completely control what happens on your recipient’s computer. 
Depending on the type of computer they are using, their installed fonts, their options or preferences, etc., they 
could end up viewing something different from what you had intended. Also, the formatting changes you make 
are sent to your recipient, but your default text settings are not. Any text that you did not make changes to is 
displayed using your recipient’s default text, which may be different from yours.

Two Eudora options let you specify how you want to send and receive styled text. If the Discard style 
information with mail option is on in the Styled Text Options Window , you will not be able to format your text 
at all (this option is off by default). You can find the Styled Text options dialog by opening    the Tools menu, and 
choose Options. Scroll through the icons until you find Styled Text.

If you want to send styled text, then turn off the Discard style information with mail option, and if you also 
want to be alerted before sending the message, then turn on the But warn me first option in the Styled Text 
Options Window .

Text in outgoing messages, text files, and signature files can be formatted using the commands on the Edit 
menu Text submenu and using the formatting toolbar.

· To format text, use the text styles buttons on the message window’s Icon bar or from the Text submenu 
from the Edit menu. You can change the font, size, style, color, and the margins.



Text Editing Menu Commands

To format text, do the following:

1. Highlight the text you want to format.

2. From the Edit menu, choose Text. The Text submenu is displayed. 

3. Select the desired text format you wish to apply to the highlighted text. If no text is selected but the cursor 
is in the message body, then the font-related commands apply the formatting to the next text you type, and 
the margin-related commands apply the formatting to the current paragraph—the paragraph containing the 
cursor.

The formatting options are as follows:

Plain, Bold, Italic, Underline ¾ Make the text plain (the default), bold, italic, or underlined.

Typewriter ¾ Set the text to the fixed-width (typewriter-style) message font selected in the Fonts options 
window .

Size ¾    Make the text the selected size: Very Small, Small (the default), Medium, Large, Larger, Very Large, 
and Humongous. The increase or decrease is based on the next or previous standard point size.
Remember that you are viewing the text based on your default settings in the Fonts options window, but your 
recipient’s settings and fonts will be different. For example, if your recipient’s default font size is larger than 
yours and you send a message with text set to “Humongous,” your recipient will see text even more 
humongous than yours.

Color ¾    Make the text black (the default) or the selected color.

Font ¾ Make the text a certain font by choosing from the fonts available on your system. Remember that your 
recipient may not have the same fonts.

Margins—Normal ¾ Make the selected or current paragraph’s left margin normal—i.e., flush left (the default).

Margins—Indent In, Indent Out ¾ Indent the selected or current paragraph’s left margin in one level, or 
“outdent” the left margin: remove one level of indent.

Left, Right, Center ¾ Align the selected or current paragraph to the left, the right, or the center of the current 
indent.

Bulleted List ¾ Convert the selected text to a bulleted list, or begin a bulleted list at the insertion point.

Make Hyperlink ¾ Convert the selected piece of text, or the selected graphic, to a clickable, underlined 
hyperlink to a URL you specify: when your recipient clicks the hyperlink, he or she is immediately taken to the 
URL.

Clear Formatting ¾ Clear all formatting and go back to the default settings.



Word Wrap

If you turn on the Word Wrap button in the message toolbar, when a message is sent, carriage returns are 
automatically inserted at the end of each line of text, with roughly 76 characters per line. This makes the 
message legible on your recipient’s computer.

It is a good idea not to include your own carriage returns within paragraphs if you have the Word Wrap option 
turned on. Only use carriage returns to create new paragraphs in the message.

To manually wrap text, do the following:

1. Select the desired text.

2. From the Edit menu, choose Wrap Selection. 

To unwrap text, do the following:

1. Select the desired text.

2. Hold down the Shift key and from the Edit menu, choose Wrap Selection.

To copy wrapped text without taking the carriage returns (i.e., to copy and unwrap), do the following:

1. Select the desired text.

2. Hold down the Shift key and from the Edit menu , choose Copy.



Inserting Objects in Message Text

Use the Insert submenu under the Edit menu to insert pictures (JPEG graphic files) and horizontal lines into 
the body of a message. You can also do this using the Insert Object button on the message toolbar.

You can insert an object in the middle of a line of text or between lines of text in the message body.

To insert a picture in message text, do the following:

1. Move the cursor to where you want the picture

2. From the Edit menu, choose Insert Picture. 

3. In the dialog that displays, select an image file and click Open. (The selected file must be a JPEG file.) 

The picture is inserted into the message body at the cursor position. You can continue typing text. Once the 
picture is inserted in your message, you can drag it to where you want it in the message. When your recipient 
opens your message, he or she will see the picture right in the message body. Note, however, that what your 
recipient sees may depend on whether or not the receiving computer and e-mail package supports the display 
of inline images embedded in message text.

To insert a horizontal line in message text, put the cursor in the message body, then choose Insert Horizontal 
Line from the Edit menu. A horizontal rule is inserted immediately above the line on which the cursor resides.



Attaching a File to a Message

Any file can be attached to and sent with a Eudora message. Most of the time, an attached document functions 
like a “rider” to the e-mail message, and does not appear within the message text. Instead, the name of the 
document is displayed automatically in the Attached field of the message header.

To attach a file to an outgoing message, do the following:

1. From the Message menu, choose Attach File [to New Message]. The Attach File dialog is displayed. 

2. Locate the file you want, select it, and click the Open button to attach the document to the current 
message, or to open a new message with the file attached. You can add as many attachments as you want
to a message.

You can also drag one or more files from either the Desktop or the File Browser window onto the message 
window to attach them. (See File Browser Window .)

To detach an attached document before the message is sent, do the following:

1. Select the document in the Attached field.

2. Press either the Backspace key or the Delete key.

When the message is sent, if the chosen document is not a plain text (ASCII) file, it is encoded in the selected 
attachment type. This allows you to send any kind of document through the mail, even applications. Encoding 
options for attachments are MIME , BinHex and Uuencode .

If the document is an ASCII file, you can put it in the body of the message by turning off the Text as 
Attachment button in the message toolbar, or by turning on the Put text attachments in body of message 
option in the Attachments options window. The toolbar button applies to the current outgoing message; the 
Attachments option applies to all outgoing messages.



MIME

This is best for recipients with MIME-compliant e-mail readers, regardless of what operating system they are 
using. For more information on MIME, see the section “MIME and Mapping” in the Eudora Reference Manual.



BinHex

This is best for recipients on a Macintosh with an e-mail reader that is not MIME-compliant.



Uuencode

This is best for recipients using PC or UNIX systems that are not MIME-compliant.



Manually Decoding Attachments

If you send an attachment and your recipient’s e-mail program does not automatically decode it, it will probably 
be included in the body of the message in the chosen attachment format (MIME, BinHex, or Uuencode).

If you receive a large message consisting largely of indecipherable text, it is probably an attachment that was 
not automatically decoded. Usually this is because the attachment headers are formatted incorrectly.

To decode an attachment that was not automatically decoded, do the following:

1. Open the message.

2. From the File menu, choose Save As to save the message as a text file. 

3. Run the decoding utility appropriate for the encoding method that the sender used. Decoding utilities can 
be found at various shareware sites on the Internet.



Including a URL in a Message

To include a hot link in a message—also known as a URL, for Uniform Resource Locator—enclose it with less 
than and greater than signs (angle brackets) to ensure that your recipient’s e-mail application can identify it as 
a URL. For example, <http://www.eudora.com>.



Creating a Hyperlink in a Message

Eudora lets you create a hyperlink in an outgoing message; that is, convert a piece of text or a graphic into a 
link to a URL, so when your recipients click the text or graphic, their browser opens and takes them to that URL.

To create a hyperlink, do the following:

1. Type the text you want to link in your outgoing message.

2. Select the text to highlight it. Or, insert a JPEG graphic file using the Insert Picture command under the 
Edit menu, and select the inserted graphic. 

3. From the Text submenu under the Edit menu, choose Make Hyperlink, or click the Make Hyperlink 
button on the message toolbar. 

4. In the URL field of the Hyperlink dialog, enter the full address of the URL, for example, 
http://www.eudora.com

5.  Click OK. 

The text or graphic is now linked and is highlighted and underlined in the message. When your recipient 
receives the message, opens it, and clicks on the hyperlink, their browser or other application will open and go 
directly to the URL you specified.



Checking Your Spelling

Eudora includes a built-in spelling checker. It can be used to check for misspellings in the body of current 
message composition windows, text files, and signature files. It includes a built-in dictionary and also allows for 
the creation of a custom user dictionary. Additionally, it can be configured to ignore capitalized words, words 
with all capitals, words with numbers, and mixed-case words; to report doubled (repeated) words; and to 
suggest alternative spellings.

Note: Changes to the spelling options can be made in the Spell Checking Options Window found in Options
under the Tools Menu or by selecting Options from the Check Spelling dialog.

See the “Sources” section of the Eudora Reference Manual for information on how to get dictionaries for 
languages other than U.S. English.

To automatically check spelling when you send or queue a message, turn on the Check when message 
queued/sent option in the Spell Checking options window . If this is on, then when you send or queue a 
message, the message is checked for spelling errors. If you complete the spell-checking process, the message 
is automatically sent or queued. If you instead click Cancel, or leave spelling errors in the message, a dialog is 
displayed asking you if you still want to send or queue the message. If you don’t want that dialog to be 
displayed, turn on the Don’t warn me anymore option (this can also be set in the Spell Checking options 
window ).

Note: For an alternate way to check your spelling using the Shift+Check Spelling option, which lets you 
see all misspelled words at once and change only those you want to, see Inline Spell Checking .

To check the spelling of a current composition window, text file, or signature file, click the Check Spelling 
button in the main window toolbar or choose Check Spelling from the Edit menu (Ctrl+6). If there are no 
misspellings, the “No misspellings found” alert is displayed.

Note: If text is selected, Eudora checks the spelling only of the selected text. Otherwise, it starts the spelling
check from the beginning of the message body or text file, and checks the entire text.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog is displayed with the word listed 
in the Unknown field.

To correct the misspelled word, either (1) type the correct spelling of the word in the Change To field (if it is not 
already there) and click the Change button, (2) select the correct word from the Suggestions list and click the 
Change button, or (3) double-click the correct word in the Suggestions list. The spelling checker then proceeds 
with the check. 



Inline Spell Checking

Inline spell checking is an alternate way to check your spelling: it lets you see all the misspelled words in your 
message at once and then change only those you want to.

To perform inline spell checking on the current composition window, text file, or signature file, do the following:

1. Hold down the Shift key and either click the Check Spelling button in the main window toolbar or from the 
Edit menu , choose Check Spelling. Or, press Shift+Ctrl+6. Eudora scans your entire message or the 
selected text and highlights all the misspelled words with a red double-underline. 

2. Right-click a highlighted word and a pop-up menu displays, letting you choose from Eudora’s suggestions 
for the correct spelling of the word. Or, choose Ignore All to ignore the current and all subsequent 
occurrences of the word. Or, choose Add to add the word to Eudora’s dictionary.

If Eudora has no suggestions in its dictionary for the correct spelling of the misspelled word, suggestions are 
not listed in the pop-up menu.

Go through the message or selection and correct each highlighted word, as desired, until you are finished the 
spelling check.

The red double-underline is not a style: it is a visual cue for you only, and is not sent as a style when Eudora 
sends the message.



Check Spelling Dialog

The Check Spelling dialog allows you to ignore an unknown word, change it, suggest the correct spelling, add 
the word to your user dictionary, edit your dictionary, or change the spelling options via the Options button. 
Each of the fields and buttons is described below.

Unknown Field ¾ An unknown word is one that is not found in Eudora’s built-in dictionary or your own custom 
dictionary. You can act on an unknown word using the Ignore, Ignore all, Change, Change all, or Add buttons, 
as described below.

Change To Field ¾ This field works in conjunction with the Change and Change all buttons. It allows you to 
modify the unknown word by typing its correct spelling in this field, or selecting a suggested alternative spelling 
from the Suggestions field, and then clicking the Change or Change all buttons, as described below.

Suggestions Field ¾ This field lists Eudora’s suggestions for the correct spelling of the unknown word. If the 
Suggest words option is turned on, all suggestions are listed here by default. If the option is turned off, click the 
Suggest button to display Eudora’s suggestions.

Ignore Button ¾ This button causes the spelling checker to ignore this occurrence of the unknown word.

Ignore all Button ¾ This button causes the spelling checker to ignore this occurrence and all subsequent 
occurrences of the unknown word.

Change Button ¾ This button substitutes the contents of the Change To field for the unknown word.

Change all Button ¾ This button substitutes the contents of the Change To field for this occurrence and all 
subsequent occurrences of the unknown word.

Suggest Button ¾ This button causes the Suggestions field to display a list of Eudora’s suggestions for the 
correct spelling of the unknown word.

Note: If Eudora doesn’t have suggestions in its dictionary, then it doesn’t list any suggestions.

Add Button ¾ This button adds the unknown word to your custom user dictionary.

Edit Dictionary Button ¾ This button displays the Edit User Dictionary dialog. The Edit User Dictionary dialog 
lists all of the words in your user dictionary in the Dictionary field. It also allows you to add words to or delete 
words from your personal user dictionary, or even clear the entire dictionary.

Note: Words in the user dictionary are saved in all lower case.

To add a word to the dictionary using this dialog, type the correct spelling of the word in the Word field and click 
the Add button. The word is then added to the dictionary and displayed in the Dictionary field.

Note: The Add button in this dialog works the same as the Add button in the Check Spelling dialog.

To remove a word from the user dictionary, first type it in the Word field, or locate it in the Dictionary field and 
single-click it to display it in the Word field, then click the Delete button.

To delete the entire user dictionary, click the Clear button. You will then be prompted to confirm the deletions. If 
you click Yes, all of the words are deleted from the user dictionary.

Options Button ¾ This button displays the Spelling Options dialog.

The Spelling options window lists the spell-checking options. A checkmark in the box next to the option name 
indicates that the option is turned on.

Note: The spelling options can also be modified in the Options dialog (Spell Checking category).



The options are as follows:

Ignore capitalized words ¾ The spelling checker ignores words that start with a capital letter, such as proper 
nouns.

Ignore words with all capitals ¾ The spelling checker ignores words that contain all capital letters, such as 
acronyms.

Ignore words with numbers ¾ The spelling checker ignores words that contain numbers.

Ignore words with mixed case ¾ The spelling checker ignores words that contain a mixture of uppercase and 
lowercase characters.

Report doubled words ¾ The spelling checker reports words that appear twice in sequence in text and 
identifies them as Doubled words.

Suggest words ¾ The spelling checker displays Eudora’s suggestions for the correct spelling of an unknown 
word. You can select any combination of the suggestion options: Phonetic words, Split words, Typographic 
words.

Note: If Eudora doesn’t have suggestions in its dictionary, then it doesn’t list any suggestions.



Saving a Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard when typing long messages, or 
so you can return to it later to make changes.

To save the current message, do the following:

1. From the File menu ,choose Save. Saved messages are put in the Out mailbox, and if at least one 
recipient is entered in either the To: or the Bcc: field, the saved message is shown with a bullet (•) in the 
Status column. If both the To: and the Bcc: fields are empty, the Status column is blank. The bullet 
indicates that the message not only has been saved, but is also ready to be sent or queued.

You can continue making changes to the message or close it. If you try to close an outgoing message window 
without saving that version of the message, an alert is displayed asking if the message should be saved or the 
changes discarded. If you select Discard and the message has never been saved, the message is deleted. 



Sending a Message Immediately

If you want to send your messages immediately instead of putting them in a queue to send later, then be sure 
the Immediate send option is on in the Sending Mail Options Window. The Sending Mail options are found on 
the Sending Mail window in Options under the Tools menu.

To send the current message, do the following:

1. Click the Send button or from the Message menu, choose Send Immediately. A progress window is 
displayed to show the progress of the transmission.

If you have the Immediate send option on, but want to put the current message in the queue, hold down the 
Shift key and click the Send button. The Change Queueing dialog is displayed and you can set detailed 
instructions. For more details, see Queueing a Message to Send at a Certain Time . 



Queueing a Message to Send Later

If you want to put your messages in a queue (in the Out mailbox) to send all together at a later time, be sure the
Immediate send option is off in the Sending Mail Options Window. The Sending Mail options are found on the 
Sending Mail window in Options under the Tools menu.

You can set up Eudora to warn you if you try to delete a queued message, or try to quit Eudora with queued 
messages. To do this, turn those options on in the Extra Warnings options. The Extra Warnings options are 
found on the Sending Mail window in Options under the Tools menu.

To put the current message in the queue, do the following:

1. Click the Queue button or from the Message menu, choose Queue For Delivery. The message window is
closed (if it was open), the message is saved in the Out mailbox marked Q (meaning it’s ready to be sent), 
and the date and time are placed in the Date column.

To send all of your queued messages, do the following:

1. From the File menu, choose Send Queued Messages. A progress window is displayed momentarily at the
top of the screen indicating the progress of the transmission.

If you have the Immediate send option off, but want to send a message immediately, hold down the Shift key 
and click the Queue button. The Change Queueing dialog is displayed and you can choose the Send 
Message Right now option. 



Queueing a Message to Send at a Certain Time

You can specify that a message be sent at a certain time in the future. To do this for the current outgoing 
message, choose Queueing from the Change submenu under the Message menu. The Change Queueing 
dialog is displayed.

If you choose Right now, the message is sent immediately when you click OK. If you choose Next time 
queued messages are sent, the message is sent the next time queued messages are sent.

If you choose On or after, you can use the Time and Date fields to fill in the time and date at which the 
message should be sent. The message is saved in the Out mailbox with a clock icon in the Status column, and
the specified date and time in the Date column. The message is sent when the specified time arrives.

Important: For the message to be sent at the correct time, Eudora must be running at that time. If Eudora 
is not running, the message is sent the first time Eudora is run after the specified time has 
passed.

If you choose Don’t send for a message that has never been queued, nothing happens. The message is held 
in the Out mailbox until it is either deleted or re-queued and sent. 



Editing a Queued Message

To edit a queued message, do the following:

1. Open the Out mailbox.

2. Select the desired message summary. 

3. Make the necessary edits and save them. The message is kept in the Out mailbox. If you close the 
changed message without saving it, an alert is displayed asking you to verify the changes.



Taking a Message Out of the Queue

A message that is queued but is not yet sent can be unqueued using the Change Queueing command. To take
a message out of the queue, do the following:

1. Open the Out mailbox. 

2. Select the desired message summary. 

3. From the Message menu, choose Change Queueing and click Don’t send. This changes the message 
status from queued (Q) to sendable (•). The message is held in the Out mailbox until it is either deleted, re-
queued, or sent.



Sending Queued Messages When Checking Mail

If the Send on check option in the Sending Mail Options Window is on, then every time Eudora checks for mail
(automatically or manually), all queued messages are automatically sent.



Sending Messages with Special Server Instructions

To send your queued messages with special instructions for the server (POP server only), do the following:

1. Hold down the Shift key and from the File menu choose Send Queued Messages. The Mail Transfer 
Options dialog is displayed.    

2. Set the options you want and click OK. All the actions you have requested are completed. For details, see 
Managing your Mail on a POP Server.



Replying to a Message

To reply to the current message, do the following:

1. From the Message menu, choose Reply. 

A new message window is displayed, with the original sender’s address automatically placed in the To field of 
the header. All of the sender’s original text is quoted in the message body. This text can be edited as needed. 
Additional text can be added to the reply just as to any outgoing message, and the reply can then be sent or 
saved for further changes.

If the sender’s text did not include style information, each line is prefixed by a greater-than symbol (>).

If the sender’s text did include style information, for example, bold text, it is quoted with greater-than and less-
than symbols above it and below it, and a left sidebar, also called an “excerpt bar.”

Messages that have been replied to are identified with a left arrow in the Status column of their message 
summary.



Using the Reply Functions

There are several options that you can use when replying to messages.

To include everyone who received the original message, do the following:

1. From the Message menu, choose Reply to All.

To include yourself as a recipient, do the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog is displayed.

3. Check the Include yourself box and click OK. This only works if you are using Reply to All.

Note: To determine who you are for the Include yourself option, Eudora uses the “me” nickname. If you 
do not have a “me” nickname set up in your Address Book, Eudora uses the contents of the Mail 
Server (Incoming), Login Name, and Return address fields from the Getting Started Getting 
Started Options Window options window. (Incoming mail accounts are usually of the form 
loginname@mailservername.) The “me” nickname is particularly useful if you have multiple 
addresses and don’t want replies to go to any of those addresses.

To put the addresses of the other recipients of the original message in the Cc field (instead of the To field), do 
the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog is displayed.

3. Check the Put original To: recipients in Cc: field box and click OK. Only the original sender’s address is 
put in the To field. This works only if you are using Reply to All.

To copy the original message’s priority to your replies, do the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog is displayed.

3. Check the Copy original’s priority to reply box in the Replying Options Window.

To change the keyboard shortcut Ctrl+R from its normal function of Reply to Reply to All, do the following:

1. Open the Tools menu and choose Options.

2. Scroll and select Replying. The Replying dialog is displayed.

3. Check the Map Ctrl+R to “Reply to All” box in the Replying dialog. The change is reflected on the 
Message menu.



Replying with a Stationery File

To reply to a message with a stationery file, do the following:

1. From the Message menu, choose Reply With.

2. From the Reply With submenu, select a stationery file. The stationery file is opened as a message and is 
addressed as appropriate (your Replying options are used). For information on stationery files, see Using 
Stationery .

Other ways to reply with stationery:

• With the desired message open or selected in a mailbox window: Open the Stationery window, right-click a 
stationery item, and choose Reply With from the pop-up menu.

• With the desired message open or selected in a mailbox window: Open the Personalities window, right-click 
a personality, and choose Reply As from the Message submenu of the pop-up menu. The default stationery
assigned to that personality is used in the reply.

• With the Personalities window open: Drag an open message by its Tow Truck, or drag selected message 
summaries in a mailbox window, onto a personality in the Personalities window: a reply is initiated from that 
personality, and the stationery stored with that personality is used in the reply.

• Set up a filter that uses the Reply with filter action. See Filtering Messages and Filter Actions .



Forwarding a Message

Any message can be forwarded to someone else. To forward the current message, do the following:

1. From the Message menu, choose Forward.    

A new message window is displayed with your address in the From field, the original subject preceded by 
“Fwd:” and a space in the Subject field, the original sender’s text quoted in the message body, and the original
attachments in the Attached field. For details on how text is quoted, see Replying to a Message . Make any 
changes you want, and enter the recipient’s address in the To field. The message can then be sent or saved for
further changes.

Note: If you forward an outgoing message (a message you sent), the attachments are not automatically 
included.

Messages that have been forwarded are identified with a right arrow in the Status column of their message 
summary.

Other ways to forward a message:

• With the desired message open or selected in a mailbox window: Open the Personalities window, right-click 
a personality, and choose Forward As from the Message submenu of the pop-up menu.

• Set up a filter that uses the Forward To filter action. See Filtering Messages and Filter Actions .



Redirecting a Message

Incoming messages can be sent to a new recipient “by way of” you, maintaining the original sender’s address 
in the From field. This is called redirecting.

To redirect the current message, do the following:

1. From the Message menu, choose Redirect. 

A new message window is displayed with the original sender’s address in the From field with the statement “by
way of” followed by your real name and/or return address, the original sender’s text in the message body, and 
the original attachments in the Attached field. Make any changes you want, and enter the recipient’s address 
in the To field. The message can then be sent or saved for further changes.

Note: You may want to enclose any changes in brackets ([]) so that you don’t confuse the recipient about 
who wrote what.

Messages that have been redirected are identified with a diagonal arrow pointing up and right in the Status 
column of their message summary.

Other ways to redirect a message:

• With the desired message open or selected in a mailbox window: Open the Personalities window, right-click 
a personality, and choose Redirect As from the Message submenu of the pop-up menu.

• Set up a filter that uses the Redirect To filter action. See the sections Filtering Messages and Filter Actions .



Turbo Redirecting

You can redirect a message to someone on your recipient list, queue the new message (without displaying it), 
and delete the original message, all with one command. To turbo redirect a message, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select the Miscellaneous icon. The Miscellaneous options window is displayed.

3. Check the Turbo redirect by default box and click OK. 

When you select a recipient from the Redirect To submenu under the Message menu, a turbo redirect is 
automatically performed.



Redirect and Signatures

When you use Redirect or Redirect To, your signature is not added to the message when it is sent, unless you
originally created the message. Eudora considers the message to be originally from you if the address in the 
From field exactly matches either your return address or one of the addresses belonging to your nickname 
called “me,” if you have one.



Keeping Copies of Outgoing Messages

There are three ways to keep copies of your outgoing messages.

• To put a copy of every outgoing message in the Out mailbox, turn on the Keep copies option in the Sending 
Mail Options Window.

• To put a copy of the current outgoing message in the Out mailbox, turn on the Keep Copy button in the 
message toolbar.

• To put a copy of the current outgoing message in a particular mailbox, right-click in the body of the message 
and select the mailbox from the Fcc menu.

In all these cases, when the messages are sent they are put in the specified mailbox with a checkmark in the 
Status column, indicating that the message has been sent.

If none of these options are used, outgoing messages are put into the Trash mailbox after they have been sent.

Note: You can also set up a filter to save outgoing messages in particular mailboxes based on information 
contained in the message. See Filtering Messages for more information.



Sending Rejected Messages Again

If for some reason an e-mail message can’t be delivered to a recipient, mail transport agents return the 
message to the original sender (you). A message is typically rejected because of an error in the recipient’s 
address, although other reasons are possible.

The return message usually includes cryptic information that may let you determine the reason the message 
was rejected. It also includes the text of the original message.

You can easily recover the original message, make any corrections, and resend it.    To send a rejected 
message again, do the following:

1. From the Message menu, choose Send Again. This eliminates the inserted extra text and reformats the 
message as it originally appeared. You can then make changes or additions and send the message again.

The Send Again command is also useful for resending saved messages—from your Out box, for example—
and messages you’ve copied to yourself, in order to save yourself some retyping. You can send the same 
message to another recipient to avoid having to retype the whole message, or you can send a different 
message to the same recipients to avoid having to retype their addresses in the header.

Another way to send a message again: 

1. In a mailbox window, open or select the desired message. 

2. From the Tools menu, choose Personalities, or select the Personalities tab. The Personalities window 
opens.

3. Right-click a personality, and from the Message submenu of the pop-up menu, choose Send Again As. 

The message is sent again but from the selected personality (which may or may not be the same as the 
personality under which it was originally sent).



Checking for Incoming Mail

The incoming mail server is where your mail is received and stored until it is transferred by Eudora to your PC. 
You can use several different mail accounts with Eudora: Your main account, or “dominant personality,” is 
specified in Configuring Eudora , and additional mail accounts, or “multiple personalities,” are described in 
Personalities Window and Account Settings Dialog .

Note: To best understand the functioning of the incoming mail server with respect to Eudora, see the 
section “Mail Transport” in the Eudora Reference Manual.

There are two ways to check your incoming mail server and transfer mail to your PC: automatically or manually.

You can also control how your mail is transferred from the server, and what happens to it on the server. For 
details, see Managing your mail on a POP Server and Managing Your Mail on the IMAP Server . 



Checking for Mail Automatically

To set up Eudora to automatically check your incoming mail account and transfer new mail, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Checking Mail.

3. In the Check for mail every ? minutes field, enter the number of minutes that you want between mail 
checks. 

4. Open the Personalities window and for each personality that you want to be automatically checked. 

5. Right-click the personality, choose Modify from the context menu, and when the Account Settings dialog is 
displayed, turn on the Check Mail option for that personality.

Note: 15 minutes is a good minimum interval because checking mail more frequently puts an unnecessary 
load on your incoming mail server. If the field is empty, or is set to 0, mail is not automatically 
checked.

If automatic checking is set, the Check Mail command under the File menu displays the next time that
an automatic check is scheduled to occur.

The Check Mail option also specifies that an account should be checked for new mail when a manual mail 
check is done.



Checking for Mail Manually

You can manually check for new mail at any time by selecting Check Mail from the File menu. Any account that
has the Check Mail option turned on (in the Account Settings dialog) is checked. If you haven’t successfully 
entered your password since opening the Eudora program, you are prompted for it (for each account being 
checked). A progress window is momentarily displayed at the top of the screen indicating that an attempt to 
reach your incoming mail account is being made. 



Stopping a Mail Check

If you want to stop a mail check in the middle, click the Stop button in the progress window.



Using Your Password

Each time you open Eudora and check mail for the first time, you need to enter a password for each incoming 
mail account that you have. This password is required by the incoming mail server before it will transfer your 
mail, so that no one else can get your mail from the server.

Note: This does not protect your mail once it is on your PC. Unless a message has been sent with some 
type of security, it is just plain text, which many applications can read. If you are interested in securing
the messages on your PC, you may want to consider a disk driver that can encrypt hard disk data.

If you need to enter a password, the Eudora Password dialog is displayed. Enter your password and click OK. If
you make a mistake before clicking OK, simply backspace and re-enter the password correctly.

Note: Your incoming mail account password is case-sensitive, so the uppercase and lowercase characters 
must be typed in exactly. Be sure that Caps Lock is off.

If your password is rejected, an error message is displayed indicating that you have entered the wrong 
password. Choose Check Mail from the File menu to redisplay the password dialog.

As long as Eudora is running, it remembers all of your passwords. If you don’t want it to remember (if, for 
example, you are away from your PC), choose Forget Password(s) from the Special menu. The next time you
check mail for any account, you are prompted for your password again.

You can also make Eudora remember all of your passwords from one session to the next, which means you 
never have to enter passwords again, even if you quit and restart Eudora. You want to do this only if your PC is 
in a secure location, where there is no possible chance of someone else having access to it. To use this option, 
turn on Save password in the Checking Mail Options Window.



Changing Your Password

To change the password for one of your personalities, choose Change Password from the Special menu, and 
select the personality whose password you want to change. You are prompted to enter your old password once,
and your new password twice. Depending on the server you are using, the password can be up to 30 
characters, but normally it is only 7 or 8.

Note: This only works if the incoming mail server is running a compatible password-change server. For 
information about these servers, see the “Sources” section of the Eudora Reference Manual.

When you choose a new password, try not to use real words, names, dates, familiar acronyms, etc. Some 
systems require at least one number or symbol in your password, and you may want to do that even if it is not 
required.



Receiving New Mail

When Eudora does a mail check, you can be notified of new mail in one or all of the following ways: 

· alert dialog

· the opening of the mailboxes to which new mail is delivered

· special “New Mail” sound. 

These options are turned on or off in the Getting Attention window. To display the Getting Attention window, 
open the Tools menu, choose Options. Scroll through the icons and select Getting Attention.

When you receive notice that new mail has arrived, select Eudora from the Windows task bar. Mail usually 
arrives in the In mailbox (unless you are using filters to transfer messages). If the In mailbox is not already 
open, from the Mailbox menu, choose In. The messages are listed in the order they are received, with the most
recent message listed last. Unread messages are designated by a bullet in the Status column of the message 
summary.

Double-click anywhere on a message summary to open the message. You can also view messages using the 
message preview window at the bottom of the mailbox window while the message summary is highlighted.

Incoming messages are saved indefinitely in the In mailbox (or the mailbox they are filtered into) until they are 
deleted or transferred to another mailbox.



The Incoming Message Window

To open an incoming message, double-click its message summary in a mailbox window, or, if the message 
summary is current (highlighted), press the Spacebar or Enter key.

Note: You can also view the message in the message preview window. See The Message Preview Pane for
more details.

The incoming message window consists of the title bar, the Toolbar, and the message body.

Title Bar ¾ The title bar provides information about the message, including the name of the sender, the time 
and date the message was delivered, and the message subject.

Toolbar ¾ The toolbar consists of buttons and pop-ups displayed just under the title bar.

Tow Truck ¾ This can be used to drag any current message into a different mailbox. Just hold the mouse 
button down on the icon and drag it to an open mailbox or a mailbox in the Mailboxes window.

Fixed Width ¾ Click this button to convert the message text to the fixed-width (typewriter style) message font 
set in your Fonts options window . This lets you view aligned text, such as columns and tables, more easily.

BLAH BLAH BLAH ¾ If this is on, all the message headers (and any formatting codes) are displayed.

Pencil ¾ If this is on, you can edit the message.

Delete From Server ¾ If this is on, the message is deleted from the server the next time mail is checked.

Retrieve From Server (Fetch) ¾ If this is on, the message is retrieved (fetched) from the server the next time 
mail is checked.

Priority Popup ¾ This lets you indicate that the message is of higher or lower priority than a normal message. 
For most messages, this is just an empty box (normal priority). For details, see Setting the Message Priority .

Subject ¾ This is the subject that was assigned by the sender, and is shown in the message summary. For 
instructions on changing this subject, see Editing Incoming Messages .

Message Body ¾ The message body contains the message header and text information, as well as the name 
of each attachment and, if the Show attachment icons option is turned on in the Viewing Mail options 
window , each attachment’s icon as well. Attachments can be opened from within the message window by 
clicking on the attachment icon or name.

Eudora lets you view incoming mail with advanced formatting, graphics, multimedia, and the like. Additionally, if 
you have the Use Microsoft’s viewer option turned on in the Viewing Mail Options Window , and you have 
Microsoft Internet Explorer 3.0 or later installed and available on your system, then Eudora lets you take full 
advantage of the viewing capabilities of a Web browser right in the e-mail message itself, or linked to the 
Internet, without having to open your Web browser.



Receiving Attachments

Unless you have specified a particular directory for your incoming attachments (see Specifying an Attachment 
Directory ), they are automatically decoded and saved in the Attach Directory in your Eudora Directory. If you 
receive multiple attachments with the same name, a number is added to the end of each duplicate name, in the 
order they are received.

Attachment names are displayed at the bottom of incoming messages and the message preview window. If the 
Show attachment icons is turned on in the Viewing Mail options window , attachment icons are also 
displayed. 

To open an attachment from the open message window or the message preview window, click the attachment 
name or its icon. If you have the application that the attachment was created in, that application launches and 
the attachment opens.

If you receive a large message consisting largely of indecipherable text, it is probably an attachment that was 
not automatically decoded. Usually this is because the attachment headers are formatted incorrectly. To decode
an attachment that was not automatically decoded, open the message and choose Save As from the File menu
to save the message as a text file. Then run the decoding utility appropriate for the encoding method that the 
sender used. Decoding utilities can be found at various shareware sites on the Internet. Also see Attaching a 
File to a Message .



Specifying an Attachment Directory

If you do not want to use the default Attach Directory to receive your attachments, do the following:

1. From the Tools menu, choose Options and scroll and select    Attachments. 

2. Beneath the Attachment directory prompt, click the large button. A standard file dialog is displayed.

3. Double-click the name of the directory you want to use (its name should be displayed above the list).

4. Click    Use Directory. The dialog closes, leaving the Options dialog displayed. The name of the folder you 
just selected is now displayed in the Attachment directory button.

Note: If at any time Eudora cannot find your selected directory, Eudora will use the Attach Directory in the 
Eudora Directory for attachments until you designate a new directory.



Editing Incoming Messages

You can edit the message body in an incoming message if you turn on the Pencil button in the Toolbar. You can 
also edit the Subject in the Toolbar (this is the subject shown in the message summary), and you do not need to
turn on the Pencil button to do this.

To edit an incoming message, do the following:

1. Click the Pencil button to turn it on.

2. Edit the text in the message body. (See Formatting Text for details on how you can edit the message text.) 

3. When you are done, save your changes and close the message.

To edit the subject of an incoming message, open it and edit the subject in the Toolbar (not the subject in the 
message body). When you are done, click somewhere else in the message, or close it. The new subject is 
displayed in the message summary. The contents of the Subject field of the message header remain 
unchanged.

Note: If you reply to the message, the original subject is used for the reply, not your changed subject.



Using Active URLs

Any string of text that Eudora recognizes as a hot link or URL (Uniform Resource Locator: http, ftp, gopher, ph, 
finger, etc.) is active. Click a URL to open a World Wide Web location, transfer a file, do a gopher search, use 
the finger tool, etc. URLs are highlighted and underlined to show that they are active.

To set up Eudora to automatically open a new message when you use a mailto link within a Netscape Web 
browser, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Miscellaneous. The Miscellaneous options window is displayed.

3. Check the Intercept Netscape mailto URLs box and click OK.

Note: If you enter a mailto in your e-mail message, for example: mailto:sjones@eudora.com, the mailto 
becomes an active URL link. Your recipient can just click on the mailto URL and send an immediate message to
the e-mail address contained in the mailto.



Managing your Mail on a POP Server.

During a mail check, your incoming messages are normally transferred from your account on the POP server to
your PC, and then deleted from the POP server. But this can be awkward if you want to read mail from two or 
more computers, and keep your mail organized at the same time.

There are several options that you can use to control your mail transfers and the storage on the server. Some 
of these options are available in the Incoming Mail Options Window, for your dominant account only, and the 
Account Settings window, for any of your personalities; some of the options are available in the Mail Transfer 
options window. Access these windows by opening the Tools menu and choose Options. Scroll to find the 
windows you need.



Managing your Mail on the IMAP Server

If your incoming mail server uses IMAP, then when you check mail, all incoming messages are delivered to your
IMAP server and are kept there until you actively delete them.

Also during mail checks, partial messages or full messages are transferred to your PC, with or without 
attachments, depending on the options you specify in the Incoming Mail Options Window for your main 
account, or the Account Settings dialog, accessed from the Personalities window, for any of your personalities.

When a message is transferred, either in part or in full, from the IMAP server to your PC during a mail check, a 
copy of the message remains on the server until you actively delete it. Also, your PC remains connected to the 
IMAP server until you close the mailbox containing the message (assuming the mailbox opens when the 
message is delivered).



Downloading Minimal Headers vs. the Full Message

By default, the Minimal Headers Only option is turned on in the Incoming Mail Options Window for your 
dominant account, and in the Account Settings dialog for your alternate personalities.

As a result, when you check mail for an account and the incoming mail is delivered to your IMAP server, only a 
minimal amount of information about each message is transferred to your PC. This consists of the information 
you would see in the message summary of a mailbox window: the sender, the date and time of the message, 
the subject, etc. However, when you open or preview the message, the full set of message headers and the 
entire message body is transferred to your PC. Whether or not any attachments to the message are also 
transferred depends on your setting for the Skip attachments over ? K option which is found under the Tools 
menu, Options, then Incoming Mail .

If you always want the full message to be transferred to your PC during mail checks (with or without 
attachments, as specified separately), rather than just the minimal headers, then turn off the Minimal Headers 
Only option.



Skipping Attachments Over a Certain Size

To prevent Eudora from transferring large attachments for your main account to your PC during mail checks 
(IMAP), do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Incoming Mail.

3. Check the Skip attachments over ? K box, and specify a size. 

4. Click OK.

To prevent Eudora from transferring large attachments for your alternate accounts to your PC during mail 
checks (IMAP), do the following:

1. From the Tools menu, choose Personalities. The Personalities window is displayed.

2. Select the desired alternate personality, and right-click.

3. From the pop-up menu, choose Modify. The Account Settings dialog is displayed.

4. Click the Incoming Mail tab.

5. Check the Skip attachments over ? K box, and specify a size.

6. Click OK.

Each time mail is then checked for the account, any attachments larger than the specified size are not 
transferred to your PC with the message. However, the rest of the message is transferred, either minimal 
headers only or the full set of message headers and the complete message body, depending on your setting for
the Minimal Headers Only option. Any attachments within the specified size are also transferred.

Attachments not transferred during mail checks can still be downloaded. When you open or preview the 
message associated with the attachment, an icon for the attachment is displayed in the incoming message 
window or the message preview window. (The Show attachment icons option must be turned on in the 
Viewing Mail options window in order for this icon to appear. The Viewing Mail window can be displayed by 
opening the Tools menu and choosing Options.) Click the icon to retrieve the attachment from the IMAP server.

If the Skip attachments over ? K option is turned off, then all attachments are transferred to your PC during 
mail checks, regardless of their size.



Deleting a Message from the IMAP Server

To delete a message from the IMAP server, you must take two steps: 

1. Mark the message for deletion, 

2. Remove all messages so marked.

To mark a message for deletion and remove it, do the following:

1. Open the IMAP mailbox or folder containing the message.

2. Select or open the message. 

3. From the Message menu ,choose Delete. (To unmark a marked message so that it won’t be deleted from 
the IMAP server, select or open the message and then choose UnDelete from the Message menu.)

4. From the Message menu, choose Remove Deleted Messages. The messages are completely removed 
both from the IMAP server and from your PC.

Once you remove marked messages using the Remove Deleted Messages command, these messages are 
completely gone and cannot be restored. Therefore, use this command with caution.



Resynchronizing an IMAP Mailbox or Folder

General mailbox and folder management for POP and IMAP servers is performed from the Mailboxes window. 
See Using the Mailboxes Window for more information. This section discusses resynchronization.

Keeping your mailboxes and folders remotely, on an IMAP server, lets you perform operations on them from 
different computers. For a particular IMAP mailbox, you may delete some messages from the mailbox from one 
PC, check mail from another PC (resulting in new messages being transferred to the mailbox), and change the 
status of some of the messages from a third PC.

Each PC has no idea what has been done to the mailbox from the other PC until you resynchronize the 
mailbox, which updates all operations performed on the mailbox from all computers that have access to the 
mailbox. (In some situations, other users may have access to these same mailboxes.)

To resynchronize an IMAP mailbox or folder, do the following:

1. Open the Mailboxes window, right-click the IMAP mailbox or folder. 

2. From the pop-up menu, choose Resynchronize Mailbox. The content of the mailbox or folder is 
completely updated according to all operations that have been performed on the mailbox from all 
computers that have access to it.



Refreshing Your List of IMAP Mailboxes and Folders

General mailbox and folder management for POP and IMAP servers is performed from the Mailboxes window. 
See Using the Mailboxes Window for more information. This section discusses how to update the list of IMAP 
mailboxes and folders in the Mailboxes window.

Mailboxes and folders you keep stored remotely, on an IMAP server, may be changed by other users, or may 
be changed by you from other computers. The Mailboxes window does not reflect the “real-time” status of the 
IMAP mailbox list, and between mail checks, a disparity can grow between what appears in the list and what is 
actually on the IMAP server, as new mailboxes are added and existing ones are changed or removed.

To refresh your list of mailboxes and folders on the IMAP server, as it appears in the Mailboxes window, do the 
following:

1. Open the Mailboxes window, right-click the top folder in the IMAP tree.

2. From the pop-up menu , choose Refresh Mailbox List. The mailbox list is updated according to what 
actually appears on the IMAP server at that time. The Mailbox and Transfer menus are also updated with 
the current IMAP mailbox configuration.



Leaving Mail on the Server

To transfer all of your new messages from the POP server to the PC you are on, and also leave copies of those
messages on the server, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Incoming Mail. The Incoming Mail options window is displayed.

3. Check the Leave mail on server box. You can use the Delete from server after ? days option to set the 
maximum number of days the copies should be kept.

Note: The Leave mail on server option can also be set for each alternate personality you have. To do this, 
use the Account Settings dialog, accessed from the Personalities window (select personality, right-
click, choose Modify) .

At the next mail check from that PC, Eudora ignores the copies of those previously read messages and looks 
for new ones. However, if you check mail from another computer, those messages are treated as new and are 
transferred to that computer.

Note: The Leave mail on server option should be used with care, since it can result in a buildup of 
messages on the POP server.



Deleting a Message from the POP Server

To delete a message that has been left on the server (without retrieving it again), do the following:

1. Turn on the Trash button in the message Toolbar or set the message summary’s server status to Delete.

2. Check mail again. Or, use the Delete all messages that have been retrieved option in the Mail Transfer 
options    (described in the section Checking for Mail with Special Server Instructions ).



Skipping Messages Over a Certain Size

To stop Eudora from transferring incoming messages that are too large, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Incoming mail. The Incoming mail window is displayed.

3. Check the Skip messages over ? K in size box and specify a size. Only the first few lines of the 
messages that exceed that size are transferred, with a note at the bottom stating that the whole message 
has not been transferred.

4. Click OK.

Note: The Skip messages over ? K in size option can also be set for each alternate personality you have. 
To do this, use the Account Settings dialog, accessed from the Personalities window (choose the 
personality, right-click, choose Modify).

If you decide you want to transfer the whole message, click the Fetch button in the incoming message window, 
or select the Fetch server status in the message summary, then check mail again. You can also use the Trash 
button or the Fetch then Delete server status so that the message is deleted from the server after it is 
transferred.

If you decide you don’t want the message and want to delete it from the server, click the Trash button in the 
incoming message window, or select the Delete server status in the message summary, then check mail again.



Checking for Mail with Special Server Instructions

To check your mail and give special transfer and storage instructions to the POP server, do the following:

1. Hold down the Shift key and from the File menu, choose Check Mail. The Mail Transfer Options dialog is
displayed. 

2. Set the options you want and click the OK button to continue checking for mail.

The mail transfer options are described below.

Retrieve new mail

Transfer your new mail from the POP server to your PC.

Send queued messages

Send all the queued messages (marked “Q”) in your Out mailbox.

Delete messages marked for deletion

Delete from the POP server the messages that are marked Delete in Eudora. This is for messages that were 
retrieved only in part, either with the Leave mail on server or Skip messages over ? K in size options (in the 
Incoming Mail Options Window for your main account or the Account Settings dialog for your alternate 
personalities), or with the Fetch all message headers to In mailbox option (in the Mail Transfer options 
window).

Retrieve messages marked for retrieval

Retrieve from the POP server the messages that are marked Fetch or Fetch then Delete in Eudora. This is for 
messages that were retrieved only in part, either with the Leave mail on server or Skip messages over ? K in
size options (in the Incoming Mail options window for your main account or the Account Settings dialog for your 
alternate personalities), or with the Fetch all message headers to In mailbox option (in the Mail Transfer 
options window).

Note: To mark a message Fetch, Delete, or Fetch then Delete, either click the buttons in the incoming 
message window, or select an option from the Server Status pop-up of the message summary.

Delete all messages that have been retrieved

Delete from the POP server all of the messages that have already been transferred to the PC you are on.

Delete all messages on server

Delete all of your messages from the POP server. Note: Be absolutely sure this is what you want to do, 
because there is no way to undo it!

Fetch all message headers to In mailbox

Retrieve from the POP server the header and the first few lines of every new message. If you select this option,
the messages are not filtered. Set the Server Status in the message summaries to specify what you want to do
with the messages the next time you check mail.

Important: If you delete the message header, and you have the Delete from server when emptied from 
Trash option on in either the Incoming Mail Options Window for your main account, or the 
Account Settings dialog for an alternate account, the message is gone completely from Eudora
and the POP server.

How should checking/sending be performed



If you have multiple personalities, you can check or send mail based on the options on the left of the Mail 
Transfer options window (turn on Using options at left), or as specified in the Incoming Mail options window, 
for your dominant account only, or in the Account Settings dialog (accessed from the Personalities window), for 
any of your personalities (turn on Normally). You can also specify the personalities that you want to check or 
send with this mail transfer. Hold down the Shift key to select multiple personalities in sequence, or the Ctrl key 
to select them out of sequence.

Note: Another way to check mail for multiple personalities, regardless of your settings elsewhere, is to open 
the Personalities window, select your desired personalities, right-click the selection, and choose 
Check Mail from the pop-up menu.



Opening a Mailbox

To open a mailbox, do the following:

1. Select it from the Mailbox menu, or double-click it in the Mailboxes window.

Note: The unread message icon is displayed in the Mailbox menu whenever a mailbox or folder contains 
unread messages that are less than five days old, and any mailboxes or folders in the Mailboxes 
window that contain unread messages are displayed as bold.



Message Summaries in Mailboxes

Each line in the list portion of a mailbox window represents a message and is called a message summary. 
Outgoing messages that are in any mailbox other than Out are shown with italicized message summaries.

To select one or more message summaries, use one of the following options: 

• To select one summary, click it.

• To select two summaries and all the summaries between them, select a summary, hold down the Shift key, 
and select another summary. Or, drag the mouse over the summaries to select them (as long as you begin 
on an unselected summary).

• To select all of the summaries that have the same information in a particular column, hold down the Alt key 
and click one column in the summary. For example, if you click the Status column for one summary, all of 
the summaries with that status are selected.

• To make “disjointed” selections, hold down the Ctrl key and select summaries.

Each message summary is divided into columns: Status, Priority, Attachments, Label, Sender/Recipient (Who), 
Date, Size (in K), Server Status, and Subject. You can show or hide these columns using the Display options 
window.

A message’s Status, Priority, Label, and Server Status can be changed directly in the mailbox window. To do 
this, select the messages you want to change and click the right mouse button inside the selection. Select an 
option from the pop-up menu to make your change.

To turn on the display of lines in the message summaries portion of mailbox windows—horizontal lines to 
separate summaries, and vertical lines to separate columns—turn on the Show Mailbox Lines option in the 
Display options window .

The Status Column

This column displays the message status, which is one of the following:

• The message has not been read (all mailboxes except Out), or is queueable or 
sendable but has not been queued or sent (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not yet able to be 
queued or sent because it has no recipients in the To or Bcc fields (Out mailbox only).

left arrow Reply has been chosen for the message.
right arrow Forward has been chosen for the message.
diagonal arrow Redirect has been chosen for the message.
checkmark The message has been sent (outgoing messages only).
Q The message is queued to be sent (outgoing messages only).
clock icon The message is queued to be sent at a specified time (outgoing messages only).
- The message was transferred from the Out mailbox before being sent.

You can change the status of one or more selected messages, or an open message, from Read (blank) to 
Unread (•) or from Unread to Read by pressing Shift+Space (all mailboxes except Out).

The Priority Column

This column displays the message priority. You can use the pop-up to set a particular priority.

The Attachments Column



This column displays the attachment icon (a paper clip) if a message has attached documents.

Note: This attachment icon is not affected by the Show attachment icons option in the Viewing Mail 
options window . This attachment icon appears whether Show attachment icons is turned on or off. 
The Show attachment icons option refers to attachment icons in the open incoming message and 
the message preview window.

The Label Column

This column displays the message label. Labels are assigned to incoming messages by the recipient, either 
manually or automatically using filters (see Filtering Messages ). When a message summary is assigned a 
label, the entire summary changes color to match the label color.

Note: Label colors and titles are assigned using the Labels options window.

The Sender/Recipient Column (Who)

This column shows the sender of the message (for incoming messages) or the intended recipients (for outgoing
messages).

Note: Bugs in some POP servers/mail transport systems cause Eudora to display the sender of incoming 
messages as ???@???. This is because the required From: header is missing.

The Date Column

This column displays the date and time the message was composed, or, for timed messages, the date and time
the message is scheduled to be sent. Date formats, including age-sensitive indications such as the day of the 
week or “Today,” are set in the Date Display options window . 

The Size Column (K)

This column displays the size of the message in kilobytes, K (1 K = 1,024 bytes).

The Server Status Column (V)

This column displays the action that is done to the corresponding incoming message on the POP server (these 
actions do not apply on an IMAP server). The next time you check mail, the server status you requested is 
automatically completed.

Note: To control the mail transfer, you can also use the Mail Transfer options window. For details, see 
Checking for Mail with Special Server Instructions .

The Subject Column

This column displays the subject of the message. The sender originally typed this information into the message 
header, but you can modify it (see Editing Incoming Messages ).



Displaying and Resizing Columns

To specify which columns you want to be displayed in your mailboxes, do the following:

1. From the Tools menu, choose Options. 

2. Scroll and select Display. The Display options window is displayed.

3. Check the boxes of the columns you want to see are on in the Show Mailbox Columns block.

4. Click OK.

To resize a column in a mailbox window, move the mouse pointer until it is over the column heading divider to 
the right of the column you want to resize, then drag the divider to the position you want. The column divider 
moves to the new location, and the mailbox is redrawn.

You can only shrink a column as far as its left divider. If you do that, a double divider line is displayed in place of
the column, and its contents are hidden. To redisplay the column, drag the right divider line to the right.



Using the Mailbox Size Display

In the lower left corner of the message summary part of each mailbox window, three numbers show the size 
information for that mailbox. The first is the number of messages in the mailbox; the second is the total amount 
of space those messages require; the third is the amount of disk space that is wasted with the mailbox.

Wasted space is created when messages are deleted from a mailbox. This wasted space is automatically 
removed when the amount of wasted space in the mailbox is greater than the amount of space the messages in
the mailbox use, or if the amount of space wasted in the mailbox is greater than 5% of the free space on the 
disk drive that contains it.

To manually clean up the wasted space in a mailbox, click the mailbox’s size display. Or, to clean up all your 
mailboxes, choose Compact Mailboxes from the Special menu.



Preview Pane

The Preview Pane shows you the full or partial content of a message without opening the message. It is located
to the bottom of the list of messages in a mailbox. You can adjust the size of the preview window by placing the 
cursor on the window frame. Once the cursor changes to a double arrow, you can resize the preview window.

To activate the preview pane, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Viewing Mail . The Viewing Mail options window is displayed.

3. Click the Show message preview pane box.

4. Click OK.

The preview pane shows the key headers and the message body of the currently selected message in the 
message summary list. If the full message body is not visible in the preview window, scroll bars are displayed, 
allowing you to view the rest of the message. Only one message can be previewed at a time.

Press Tab or F6 to move the keyboard focus from the message summary list to the preview window (and back 
again). Or simply click in the preview window to put the focus there.

Once keyboard focus is in the preview window, you can do any of the following, as you can in an open incoming
message window:

• Press Space to page down through the message.

• Use the arrow keys, as set in the Miscellaneous options window (unmodified or with Ctrl or Alt), to switch to 
the next or previous message in the mailbox.

• Use standard keyboard shortcuts such as Ctrl+R for Reply, Ctrl+D for Delete, etc.

• Right-click anywhere in the preview window to display a pop-up menu with commands appropriate for the 
previewed message.

• Click an attachment icon or name to open the attachment.

• Click a URL (hot link) to launch the application for that URL.

If the Show message preview pane option is turned on in the Viewing Mail options window , you can press F7 
to show and hide the preview window within the current mailbox only (this does not control the visibility of the 
preview window in other mailboxes).

If the Show message preview pane option is off in the Viewing Mail options window , only the message 
summaries are shown in any mailbox window.

If the preview window option is on and the Mark previewed messages as read after ? second(s) option is 
turned on in the Viewing Mail options window, then the currently previewed message is marked as read (blank 
in the Status column) after the specified number of seconds. You can always change the message’s status 
back to Unread (•) by pressing Shift+Space while the message is selected or open (press again to change 
back to Read). If the Mark previewed option is off, previewed messages are never automatically marked as 
read.



Note: Eudora only performs the auto-marking behavior when you manually switch messages, not when it 
performs actions such as automatic mail checks or filtering.



Creating Mailboxes and Folders

Eudora lets you create mailboxes to put messages in, and folders to put mailboxes (or more folders) in.

There are three ways to create mailboxes and folders:

• Using the New command from the Mailbox menu and folder submenus.

• Using the New command from the pop-up menu in the Mailboxes window (see Using the Mailboxes 
Window ).

• Using the New command from the Transfer menu (see Creating a Mailbox or Folder During Transfer ).

Note that depending on whether your incoming mail server uses the POP or IMAP protocol, there are some 
differences in the way mailboxes and mail folders are created, stored, and managed. For more information, see
Mailbox and Folder Management: POP vs. IMAP Server .



Creating a Mailbox or Folder Using the Mailbox Menu

To create a new mailbox or mail folder, do the following:

1. From the Mailbox menu , choose New, or from a mail folder submenu (to put the mailbox in that folder). 
The New Mailbox dialog is displayed.

2. To create a mailbox, type in the new mailbox name and click OK. The mailbox is created and added to the 
Mailbox and Transfer menus and to the Mailboxes window.

3. To create a mail folder, type the name of the new mail folder and check the Make it a folder option. Click 
OK to create the folder. The New Mailbox dialog is displayed again. Type the name of a mailbox to create 
within the new folder, then click OK. The new folder and its mailbox are displayed in the Mailbox and 
Transfer menus and in the Mailboxes window.



Using the Mailboxes Window

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, and move 
mailboxes among folders. Mailboxes or folders that are bolded have unread messages.

By default, the Mailboxes window is provided as the first window in a five-window tool group docked vertically to
the left side of the main Eudora window.

To open the Mailboxes window, choose Mailboxes from the Tools menu, or click the Mailboxes window’s tab if 
it is part of a visible tabbed window group. For more information on how to manipulate the Mailboxes window 
alone and as part of a tabbed window group, see Window States and Tabbed Windows .

To open a mailbox or folder within the window, double-click it, or click it once and press Enter. You can move 
among the folders and mailboxes using the up and down arrow keys, or close or open folders using the left and 
right arrow keys. You can also start typing the name of the mailbox or folder you want, and it is highlighted 
when you have typed enough unique characters to identify it (the item must be displayed, so a mailbox that is in
a closed folder cannot be selected).

Right-click any item in the Mailboxes window and a pop-up menu is displayed whose commands let you, 
depending on the item, create, remove, and rename mailboxes and folders, open existing mailboxes and 
folders, and empty the trash from the Trash mailbox.

The folder trees displayed in the Mailboxes window, and some of the operations available from the pop-up 
menu, depend on whether your incoming mail server for one or more mail accounts uses the POP or the IMAP 
protocol. For more information on these differences, see Mailbox and Folder Management: POP vs. IMAP 
Server .



Creating a New Mailbox or Folder

To create a new mailbox or folder in the Mailboxes window, do the following:

1. From    the Tools menu, choose Mailboxes.

2. Right-click on the folder. A pop-up menu is displayed.

3. From the pop-up menu, choose New. A dialog is displayed requesting the name of the new mailbox or 
folder.

4. Type in the new name, check the Make it a folder option if you want to, and click OK. If you chose to make
it a folder, enter the name of the mailbox when the dialog appears again, and click OK. The new mailbox or
folder is displayed in the lists, and is added to the Mailbox and Transfer menus.



Renaming a Mailbox or Folder

To rename a mailbox or folder, do the following:

1. Click the mailbox or folder name once, pause, then click again to highlight just the name. 

2. Type in the new name. Or, right-click the item and choose Rename, or click once on the item and press F2,
then type in the new name. 

3. Press Enter to accept your change, or Esc to cancel it.



Moving a Mailbox from One Folder to Another

To move a mailbox from one folder to another, in the Mailboxes window select the one you want to move and 
drag it to where you want it.



Removing a Mailbox or Folder

To remove a mailbox or folder, either right-click it and choose Delete from the pop-up menu, or click once on it 
to highlight it and then press the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other mailboxes or 
folders are stored, you are prompted to confirm the deletion for each such item selected. Click Remove it to 
delete the current item for which you are being prompted, or click Remove all to remove all items selected for 
deletion—no further prompts will appear. Or click Cancel to cancel the deletion. If you delete a non-empty 
mailbox or folder, all messages, mailboxes, and folders contained within the mailbox or folder are also deleted.



Mailbox and Folder Management: POP vs. IMAP Server

The location of your mailboxes and mail folders depends on whether your incoming mail server for your account
uses the POP or IMAP protocol.

If your incoming mail server uses POP, then all of your mailboxes and mail folders are created and stored on 
your PC. If your incoming mail server uses IMAP, then all of your mailboxes and mail folders are created and 
stored on the IMAP server.

The parallel situation holds true if you have multiple e-mail accounts: mailboxes and folders for all of your POP 
accounts are stored on your PC; mailboxes and folders for all of your IMAP accounts are stored on the 
respective IMAP servers.

You create an IMAP server account using the New Account Setup wizard for your dominant personality (see 
Configuring Eudora ), or using the Account Settings dialog, accessed from the Personalities window, for an 
alternate personality (see Personalities Window and Account Settings Dialog ).

The Mailboxes window is the main tool for managing your IMAP mailboxes and mail folders. In the Mailboxes 
window, right-click one of the folders or mailboxes in an IMAP hierarchy and select an item from the pop-up 
menu. See “Using the Mailboxes Window” for more information. (The additional commands for IMAP are 
Refresh Mailbox Command and Resynchronize Mailbox.)

Mail folders stored on an IMAP server can contain not only mailboxes but also messages. Mail folders stored 
on a POP server can only contain mailboxes, not messages.

Some mailboxes stored on your IMAP server may have been created by others and made accessible to you. 
For some of these mailboxes you may have both “read and write” permission: that is, you can not only read the
messages stored in them but also change or delete the messages. Other mailboxes may give you only “read” 
permission: you can only read the messages, not change or delete them.

If you have multiple e-mail accounts and the incoming mail servers for all of them use POP, then you will have 
only one top-level mail folder, named Eudora by default. If the incoming mail server for at least one of your 
personalities uses IMAP, then you can have multiple top-level mail folders: one to hold mail from all of your 
POP accounts, and one top-level folder for each of your IMAP accounts. The name of a top-level IMAP folder is
the personality name for that IMAP account.

For more information on managing your mail on POP and IMAP servers, see Managing your Mail on a POP 
Server. and Managing your Mail on the IMAP Server.



Deleting a Message

As a safeguard against inadvertent deletions, two steps are used to delete a message from your PC: first you 
put the message in the Trash, then you empty the Trash. (If your incoming mail server uses IMAP, the 
procedure is slightly different, as described below.)

To put a message in the Trash, do the following:

1. Select the message 

2. From the Message menu, choose Delete, or choose Trash from the Transfer menu, or press the Delete 
key, or click the Delete toolbar button. The message is transferred to the Trash mailbox.

To delete the messages in the Trash mailbox (removing them permanently from your PC), do the following:

1. From the Special menu, choose Empty Trash. Or, if the Mailboxes window is open on your desktop, right-
click the Trash mailbox in the window and choose Empty Trash from the pop-up menu.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent messages. To do this, use the
Extra Warnings options window found in Options on the Tools menu to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty Trash when exiting option in the 
Miscellaneous options window found in Options on the Tools menu is turned on.

Finally, if you want to delete just a few messages from the Trash mailbox, open the Trash mailbox, select the 
desired messages, then choose Delete from the Message menu, or press the Delete key. Deleting a message 
from the Trash removes it completely.

If your incoming mail server uses IMAP, the two steps required to delete a message from your PC are to first 
mark it for deletion, then remove marked messages.

To mark a message stored in an IMAP mailbox or folder for deletion, do the following:

1. Select the message. 

2. From the Message menu, choose Delete. To unmark the message for deletion, select it and then choose 
UnDelete from the Message menu. To remove all messages marked for deletion, choose Remove 
Deleted Messages from the Message menu. The messages are completely removed not only from your 
PC but also from the IMAP server.

Note: Once you remove marked messages using the Remove Deleted Messages command, these 
messages are gone and cannot be restored; so use this command with caution.



Automatically Deleting Attachments

When you delete messages, you can have their attachments automatically deleted by doing the following, 

1. From the Tools menu, choose Options.

2. Scroll and select Attachments. The Attachments options window is displayed.

3. Check the Delete attachments when emptying Trash box. Be sure the attachments are still in the Attach
Directory (or the directory you have specified for attachments). If you have this option on and want to 
delete a message but save its attachment, move the attachment into another directory before deleting the 
message.

4. Click OK.



Transferring Messages

You can transfer messages to any of your mailboxes. There are several ways to do this:

• Select the message(s) you want to transfer, then select a mailbox from the Transfer menu.

• Select the message(s) you want to transfer, then right-click the selection and choose a mailbox from the 
transfer submenu.

• Drag a message summary to an open mailbox window or to a mailbox icon in the Mailboxes window.

To put a copy of a message in another mailbox (instead of transferring the message), hold down the Shift key 
and use one of the transfer options above. This is useful if you want to file a message in more than one 
mailbox.

If you try to transfer a message to the Out mailbox an alert is displayed informing you that some header 
information may be removed from the message during transfer. Click Yes to transfer the message.

Note: You can undo mailbox transfers using the Undo command under the Edit menu.



Using the Transfer menu

The Transfer menu is one way to transfer messages among your mailboxes. With a current message open, or 
message summaries selected, select a mailbox from the Transfer menu. The messages are transferred from 
their previous mailbox to the mailbox you selected.



Dragging Messages

You can drag messages from one mailbox to another using the message summaries or the Tow Truck icon in 
an open message window.

· To drag a message summary to another mailbox, select the message summary (or summaries) and drag 
the summary into any open or minimized mailbox window, or any mailbox in the Mailboxes window. When 
you release the mouse button, the message is transferred.

· To drag an open message to another mailbox, hold down the mouse over the Tow Truck icon and drag the 
message into any open mailbox or any mailbox in the Mailboxes window. When you release the mouse 
button, the message is transferred.

When dragging to the Mailboxes window, pause over a closed folder and the folder temporarily opens, making 
its mailboxes visible so that you can complete the drop operation. The folder closes again when you complete 
or cancel the drop.

Note: You can only drag messages around if the Allow drag and drop transfers box is checked in the 
Miscellaneous options window found in Options on the Tools menu.



Creating a Mailbox or Folder During Transfer

To create a mailbox and transfer the current message into it at the same time, choose New from the Transfer 
menu instead of the name of a mailbox. The New Mailbox dialog is displayed.

You can create a new mailbox or mail folder (for details, see Creating Mailboxes and Folders ). When you are 
done, the current message is transferred into the new mailbox.

To create the new mailbox without transferring the message into it, check the Don’t transfer, just create 
mailbox option.



Filtering Messages

Many of the e-mail management functions in Eudora can be done automatically using filters. For example, you 
can automatically reply to a request for information, transfer all the messages from your children into a Personal
mailbox, and label all the messages from your customers as “Important.”

A filter can be thought of as a personal “valet” or “butler” that takes your mail and does certain things to it that 
you specify. One kind of valet might watch for particular mail from a mailing list and move it into a mailbox, open
the message, and play a sound. Another might look for other kinds of mail and give it a label color, a high 
priority, and a new Subject line. You can create as many of these “valets” or “butlers” as you like and give each
of them from one to five instructions on what to do with your mail that fits a certain set of criteria, based on 
information in the header of the message and the message body.

For examples, see Quick and Simple Filters with the Make Filter Dialog and Detailed Filters with the Filters 
Window .



Quick and Simple Filters with the Make Filter Dialog

The simplest filters are those that transfer incoming messages to a particular mailbox based on the sender of 
the message or one or more of the recipients. For example, each time you check your mail, you may want to 
have Eudora take all of the incoming messages it receives from your friend Joe and automatically transfer them
into a mailbox you’ve called “Mail from Joe.” To get Eudora to do this, you set up a simple filter.

For new users, the Make Filter dialog provides an easy way to learn how to use filters. Once you get 
comfortable with the simple filters created this way, you can go on to make more complex, powerful filters using
the Filters window. Experienced users will find that the Make Filter dialog provides a rapid, convenient method 
for making a simple transfer filter.

To open the Make Filter dialog and create a simple filter, do the following:

1. Open an incoming or outgoing message containing the information you want in your filter, or select one or 
more message summaries in a mailbox.

2. From the Special menu, choose Make Filter. Or, right-click in the body of the open message, or in the 
selection of message summaries, or in the preview window for a single-selected message, and choose 
Make Filter from the pop-up menu. The Make Filter dialog is displayed with the selected message criteria 
already entered.

Match Conditions

The Match Conditions area of the dialog helps you set up the criteria that will determine whether or not a 
particular message will get acted on by this filter. The two match conditions reflect type and content.

You can specify that the type of messages you are interested in should be Incoming and/or Outgoing. You can
also specify that this should be a Manual filter (described below). You can check and uncheck any combination 
of the three boxes Incoming, Outgoing, and Manual.

Note: If the messages you selected when you chose Make Filter were in any mailbox other than your Out 
mailbox, the Incoming and Manual checkboxes are checked automatically. If the messages you 
selected were in your Out mailbox, the Outgoing and Manual checkboxes are checked automatically.

• Incoming ¾ If this box is checked, then any incoming message that satisfies the content match condition 
you specify will be acted on according to the action you’ve specified in this filter.

• Outgoing ¾ If this box is checked, then any outgoing message that satisfies the content match condition 
you specify will be acted on according to the action you’ve specified in this filter.

• Manual ¾ If this box is checked, then, when you select one or more message summaries in a mailbox 
window and choose Filter Messages from the Special menu, the incoming and/or outgoing messages 
selected that satisfy the content match condition you specify will be acted on according to the action you’ve 
specified in this filter. Whether the messages that are manually filtered by this filter are incoming and/or 
outgoing messages depends on which other box or boxes are checked: Incoming or Outgoing or both.

Note: If Incoming or Outgoing is checked (or both), the filter is automatic; that is, Eudora performs the filter
operation behind the scenes, automatically, when you send or check mail. If you now also check 
Manual, the filter becomes both automatic and manual; that is, you can now manually perform the 
filter operation, by selecting Filter Messages from the Special menu while message summaries are 



selected in a mailbox window—but Eudora will still automatically filter the messages during mail sends
and checks. In short, checking Manual does not “turn off” Eudora’s automatic filtering for that filter.

Note: Making a filter Manual also gives you a good way to test the filter to your needs as soon as you set it 
up, rather than having to wait until the next time you send or check mail. After creating a manual filter 
with the Make Filter dialog, check to see that it does what you want by selecting Filter Messages 
from the Special menu; your open message or selected message summaries are immediately filtered
according to the new filter.

You can choose one of three content matches: From, Any Recipient, or Subject.

Click the From radio button (turned on by default) to match the message against the From field—the sender—
of the messages you selected. You can then edit the field. The From field of a target message must contain the 
information in this box but does not have to exactly equal it. Note that if you selected multiple messages and 
they do not have a common sender, the From field is unselectable and is left blank.

Click the Any Recipient radio button to match the message against any of the recipients in the messages you 
selected (recipients are contained in the To and Cc fields and, in an outgoing message, the Bcc field). Choose 
one recipient from the pulldown menu (accessed from the menu button next to the field), or edit the text in the 
field. Note that the information you enter in the field must be contained in any of the recipient fields of the target 
message but does not have to exactly equal any recipient field.

Click the Subject radio button to match the message against the Subject field of the messages you selected. If 
you have selected multiple messages and they do not have a common Subject, this field is left blank. In either 
case you can edit the field. The Subject line of a target message must contain the information in this box but 
does not have to exactly equal it.

Action Area

The Action Area lets you determine the one action that will be performed on messages that satisfy the Match 
Conditions you’ve specified for this filter. The three action choices are all message-transfer actions; they 
transfer the filtered message to a mailbox. For messages that satisfy your match conditions, your simple filter 
will transfer the messages to either a new mailbox, an existing mailbox, or your Trash mailbox.

Click the Transfer to New Mailbox button to transfer the filtered message to a new mailbox that you will 
specify. The text field is filled in with a suggested new-mailbox name based on your selected content match 
condition (From, Any Recipient, or Subject). You can change this name if you like. The In Folder field is a label 
showing you the folder in which your new mailbox will be created. By default, this is the same folder that holds 
the mailbox containing the messages you’ve selected. The new mailbox is created as soon as you create this 
filter.

Note: You can set the value of the In Folder field to your own desired default folders based on the chosen 
match condition—From, Any Recipient, or Subject—using the three Eudora.ini file entries 
FilterFromFolder, FilterRecipFolder, and FilterSubjectFolder, respectively. Enter the path as it 
appears on the mailbox window. For example: FilterFromFolder=mail-lists\entertainment.

Click the Transfer to Existing Mailbox button to transfer the filtered message into one of your existing 
mailboxes. Select the mailbox from the button next to the field. The default mailbox is the In box. When you 
click the button, a version of the Transfer menu appears, letting you choose the mailbox from the Transfer 



menu.

Click the Delete Message (Transfer to Trash) button to delete the message that satisfies the filter match 
conditions, transferring it to your Trash mailbox. This feature is useful for deleting junk e-mail, or “spam” as it is 
called in the Internet world.

Buttons

• Create Filter ¾  When you have set up your match conditions and filter action, click Create Filter to create 
the filter. The filter is added to the bottom of your filters list in the Filters window (discussed below). The filter
is available immediately and will act on messages that satisfy the conditions at the next mail check, mail 
send, or selection of the Filter Messages command, as appropriate.

• Add Details ¾ Alternately, after setting up the filter information, click Add Details to both create your filter 
and also open the Filters window so that you can add additional information to your new filter and make it 
more powerful or just change it. The filter is added to the bottom of your filters list and is immediately 
available in the form in which it was set up in the Make Filter dialog. Any changes you make in the Filters 
window must be saved before they become effective. See below for more information on the Filters window.

• Cancel ¾ Click Cancel to cancel the filter if you change your mind. The filter is canceled and your changes 
are not saved.



Detailed Filters with the Filters Window

The Make Filter dialog, discussed in Quick and Simple Filters with the Make Filter Dialog , lets you create quick,
simple filters that perform one operation—a mail transfer based on one match condition—a piece of header 
information. The Filters window lets you create more complex, powerful filters that use multiple match 
conditions and perform multiple filter actions. (You can also use the Filters window to create simple filters such 
as those created by the Make Filter dialog.)

To create or modify a detailed filter, do the following:

1. To open the Filters window, from the Tools menu, choose Filters, or click the Filters window’s tab if it is 
part of a visible tabbed window group. The Filters window is displayed, and any filters you have created are
listed on the left. (For more information on how to manipulate the Filters window alone and as part of a 
tabbed window, see Window States and Tabbed Windows .)

2. Click the New button or select an existing filter.

3. Choose the options for how you want the filter to be used, as an automatic filter to be invoked on any 
Incoming and/or Outgoing mail, and as a Manual filter that can be invoked when you choose Filter 
Messages from the Special menu. Any combination of these options works.

4. Define the criteria for the filter; use the header item pop-ups and the text fields to specify which header 
items should include a particular string of text. You can define two related terms for the criteria so that your 
filter is as specific as possible. See Filter Criteria (The Match Area)

5. Define the action or actions to be taken on messages that fit the criteria (see Filter Actions ) and save the 
filters.

Note: Eudora places a small icon next to the filter, in the filters list on the left, for each action you have 
selected for that filter—up to five icons/actions per filter.

Note: Filters are automatically named based on the criteria for the filter. You can re-order them by dragging 
a filter up or down in the list.

When the filters are invoked (automatically or manually), each message is matched against each filter in order 
from top to bottom. If the message meets a filter’s criteria, the actions are done as specified until there are no 
more actions, then the message is matched against the next filter. If at any point a Skip Rest action is done, 
nothing else is done with that message, and the next message is filtered.

You can change the width of the filters list to create more or less space for your list. To do this, put the arrow 
over the bar to the right of the list and drag the line to the left or right.

For information on the match conditions and filter actions in the Make Filter dialog, see Quick and Simple Filters
with the Make Filter Dialog . 



Filter Criteria (The Match Area)

Each filter in the Filters window can use one or two “terms” as its criteria, connecting them as appropriate with 
the conjunction pop-up.

Use the Header field to specify which message header items you want the filter to search. You can select an 
option from the pop-up menu or enter one yourself (this is helpful if you want to use a header item that does not
appear on the menu, such as X-Priority). The selections are as follows:

• To:

• From:

• Subject:

• Cc:

• Reply-To:

• <Any Header>

• <Body>

• <Any Recipient>

• <Personality>

The <Any Header> option searches all message headers (including hidden headers that are shown with the 
BLAH BLAH BLAH option). The <Body> option searches the message body. The <Any Recipient> option 
searches all possible recipient items (To, Cc, Bcc). The <Personality> option searches the name of the 
personality (e-mail account) associated with the message.

Use the Match Type pop-up to control how the header item is matched with the text string in the text field. The 
match options are as follows:

contains or doesn’t contain ¾ If the specified header item contains or does not contain the text string, filter 
the message.

Is or is not ¾ If the specified header item is or is not an exact match of the text string, filter the message.

starts with or ends with ¾    If the specified header item starts with or ends with the text string, filter the 
message. The starts with item refers to the first non-whitespace character after the colon, so any spaces after 
the colon are ignored.

appears or doesn’t appear ¾  If the header item appears or does not appear in the message, filter the 
message (the text field is ignored). This is useful for filtering messages based only on the types of fields they 
contain. Example: Some messages contain a Reply-To header, some don’t.

intersects nickname ¾ If the text string is included in a nickname (whether it is a full address or a nickname 
within the nickname), filter the message.

Use the Text fields to specify the text strings that the filter is searching for.

Note: It is recommended that the contents of this field be kept as specific and brief as possible. The greater 
the complexity, the less the likelihood of a match.

Note: Be sure not to enter a header label in the Text field as part of the text string (e.g., To:, From:, Bcc:). 
For example, to filter all messages from Justine, do not enter From: Justine in the Text field. Rather,



select From: in the Header field, and enter simply Justine in the Text field (choosing, for example, 
contains from the Match Type pop-up).

Use the Conjunction pop-up to link the two terms. The conjunction options are as follows:

ignore ¾    Ignore the second term; if the message matches the first term, filter the message.

And ¾ If the message matches both the first and second terms (but not just one alone), filter it.

Or ¾    If the message matches either term (or both), filter it.

Unless ¾  If the message matches the first term, filter it unless the message also matches the second term, in 
which case do not filter it. (This lets you exclude certain variations of the first term.) 



Filter Actions

For a filter you’re creating or modifying in the Filters window, all messages that match the filter criteria are acted
on as specified with the Actions pop-ups. Each filter can do up to five things to a message that matches the 
criteria. You can use the same action twice if it does not directly affect the original message (for example, Copy
To can be used twice, but not Transfer To).

Some filter actions have an associated icon. For these actions, Eudora places the action icon next to the filter in
the filters list. Up to five icons can appear per filter.

The Actions options are as follows:

None ¾ No action.

Make Status ¾ Assigns the selected status to message summaries.

Make Priority ¾ Assigns the selected priority level to messages. If you select a set level, messages are set to 
that priority. If you select Raise or Lower, messages are raised or lowered one priority level based on their pre-
filter level.

Make Label ¾ Assigns the selected label to messages. Label colors and names are set in the Labels options 
window.

Make Personality ¾ Assigns the selected personality to messages. For outgoing messages, the message is 
sent from the assigned personality. For incoming messages, all your responses to the message will be from the
assigned personality until you change the personality associated with the incoming message or your response. 
For more information, see Using an Alternate E-mail Account .

Make Subject ¾ Assigns the new subject to message summaries (does not affect the subject in the message 
itself). If you choose this option, the entire subject of the message is replaced with the new subject. Use the “&”
symbol to stand for the old subject if you want to add the new subject to the old subject. For example, entering 
New Subject [was &] results in New Subject [was Old Subject].

Play Sound ¾ Plays the selected sound when messages are filtered.

Open ¾ Opens the Mailbox and/or Message when a message is received. If you set a previous action to filter 
messages into a mailbox, then that mailbox is opened.

Print ¾ Prints one copy of each message.

Notify User ¾ Notifies you As Normal and/or In Report when messages are received. The As Normal option 
notifies you based on the options you have selected in the Getting Attention options window. The In Report 
option notifies you by opening the Filter Report window and displaying in that window a filter report that details 
what filter actions have been done. See Filter Report     Window   .

Notify Application ¾ Notifies the selected application when messages are received, and provides information 
from the message. Specify the application to use and the part of the message to be included.
Use the Browse button to select an application, or enter the command line yourself. The command line should 
include the path to the executable, any options, and the following substitution variables, all separated by blank 
spaces:

%1 Date
%2 To
%3 From
%4 Subject
%5 Cc
%6 The entire message



For example, the command line to send the subject of a message to a pager might look like this:

C:\apps\pager.exe -c %4
Forward To ¾ Forwards messages to the e-mail address given. Forwarded messages are placed in the queue 
in the Out mailbox, and sent the next time you send queued messages.

Redirect To ¾    Redirects messages to the e-mail address given. Redirected messages are placed in the 
queue in the Out mailbox, and sent the next time you send queued messages.

Reply with ¾ Replies to messages with the selected stationery message. Replies are placed in the queue in 
the Out mailbox and sent the next time you send queued messages. One typical use of this action is to reply to 
specific senders with stationery telling them that you’re on vacation: “I’m out till the 10th. I’ll reply to your 
message when I get back.” For more details, see Using Stationery .

Server Options ¾ Sets the message’s server status to Fetch and/or Delete (POP server only: see Managing 
your Mail on a POP Server. ). Sets the message’s server status to Fetch and/or Delete (incoming server only). 
The Fetch option specifies that the entire message be transferred from the server the next time mail is checked,
and the Delete option specifies that the message be deleted from the server the next time mail is checked. If 
you select both, the message will be transferred and deleted.

Copy To ¾ Copies messages to the selected mailbox.

Transfer To ¾ Transfers messages to the selected mailbox.

Skip Rest ¾ Stops filtering for the message (the message is not matched to the rest of the filters in the filter 
list).



Sorting Messages Within Mailboxes

The message summaries in mailboxes are automatically sorted by date, in ascending order (the newest 
messages at the bottom of the mailbox). To change this, select the appropriate command from the Sort 
submenu under the Edit menu. Or, click any of the column headings to sort by that column. To sort in 
descending order, hold down the Shift key and either select a command from the Sort submenu or click one of 
the column headings.

Mailboxes are sorted based on the previous state of the mailbox. For example, if a mailbox is sorted by Date, 
and then you sort by Sender, the messages are grouped by sender and each group is in order by date.

Note: Sometimes sorting by Date can be incorrect. This usually happens if the messages have incorrectly 
formatted date fields, or unknown or incorrect time zones.

See the Date Display options window for information on age-sensitive indications that might appear in the Date 
column, such as the day of the week or “Today.”



Finding Text Within One Message

To search for text within a single message, do the following:

1. Open the message and make sure it is current (active).

2. From the Edit menu, choose Find. 

3. From the submenu, select the Find command or press Ctrl+F. The Find dialog is displayed with the 
blinking insertion point located in the text field.

4. In the text field, type the text you want to find. When finished entering the desired text, click the Find 
button.

Starting at the cursor’s current position in the message, Eudora searches the current message for the specified
text. If no match is found, the not found alert is displayed.

If the search is successful, the message is scrolled to the first point where the match is found and the matching 
text is highlighted.

To continue searching in the same message for the next occurrence of the text, click the Find button in the Find
dialog, or select the Find Again command from the Find submenu (or press F3). These commands are 
equivalent and limit the search to the same message. Repeating these commands cycles through the matches 
in the open message only.



Finding Text Among Multiple Messages and Mailboxes

The Find command starts searching at the selected message in an open mailbox window. If there is no open 
mailbox window, Find starts in your In box.

The Next, Next Message, and Next Mailbox commands are located on the Find submenu (under the Edit 
menu) or as buttons in the Find dialog.

Next

The Next button (or Next command, shortcut Ctrl+;) allows you to search for the next match of the specified 
text until it is found either in the same message or in one of the following messages in the current mailbox.

Next Message

The Next message button (or Next Message command) begins the search at the message after the current 
message. Eudora continues to search until it finds a matching character string, even if it has to open more than 
one message or a new mailbox.

Next Mailbox

The Next mailbox button (or Next Mailbox command) begins the search for the specified text in the mailbox 
following the current mailbox. The search is conducted among all messages in that mailbox and any 
subsequent mailboxes, including the In, Out, and Trash mailboxes.

Note: Mailboxes are searched in the order they are listed under the Mailbox menu until the current mailbox 
is reached.

When the character string is found in a message, the message is displayed. Ctrl+ double-click the 
message title bar to open the mailbox that contains the message.



Match Case

Normally, Eudora ignores capitalization when searching. If you want Eudora to consider capitalization when 
searching, check the Match case option in the Find dialog. When this option is checked, Eudora searches for 
exact matches of character strings, including any capitalization.



Summaries Only

If you know that the text you are searching for is included in a message summary, check the Summaries only 
option in the Find dialog. When you click the Find button, Eudora searches for the text only in the Sender and 
Subject fields of message summaries as they appear in mailbox windows. Eudora searches much faster when 
this option is checked.



Enter Selection Command

If you don’t want to actually type the text in the Find dialog (for example, the text is very long or complex), 
highlight it in an existing message, and then either choose Enter Selection from the Find submenu, or press 
Alt+F3. This automatically inserts the selected text at the insertion point in the Find dialog. Then, click the Find 
button in the Find dialog, or select the Find command from the Find submenu, to start the search.



Stopping a Find

If you want to stop Eudora from continuing a search, click the Stop button in the progress window or press the 
Esc key. 



Saving a Message to a File

You can save a message to a separate text file on your PC by doing the following: 

1. Open or select the messages you want to save. 

2. From the File menu, choose Save As. The Save As dialog is displayed.

3. Enter the name you want to give the text file, and select the appropriate options.

Important: Be sure to change the Save as type option to Text Files.

Include Headers retains the first message’s header information in the saved document. If this is not checked, 
only the body of the messages is saved.

Guess Paragraphs removes extraneous carriage returns from the message, leaving returns only at the ends of
paragraphs, and converts multiple spaces into tabs.

4.            Once you’ve made all of your choices, click the Save button in the dialog.

If you select multiple messages from a mailbox window and choose Save As, all of the messages are saved to 
a single file.



Window States and Tabbed Windows

There are three types of windows in Eudora: as Normal Windows , Docked Windows or Floating Windows .

A tabbed window is a collection of windows combined into a single window in which each window has its own 
tab, for activating and dragging. A tabbed window can exist in any of the three window states, normal, docked, 
or floating. Tabbed windows are discussed separately below.

Note that only tool windows — those windows accessible from the Tools menu (excluding the Options dialog)    
can exist as docked windows, floating windows, and tabbed windows. All other windows in Eudora, particularly 
mailbox windows and message windows, exist only in the normal state and cannot be combined into tabbed 
windows.

The tool windows that can be docked, floating, or tabbed are as follows, in order down the Tools menu:

• Filters Window

• Filter Report Window

• Mailboxes Window

• File Browser Window

• Stationery Window

• Signatures Window

• Personalities Window

• Address Book

• Directory Services Window

Note: If you minimize and then restore the main Eudora window, then all normal, docked, and floating 
Eudora windows — including tabbed windows — are also minimized and restored with it.

Note: Unlike in previous versions of Eudora, closing a tool window does not erase its contents, unless the 
contents can be saved, and you choose to discard changes. When you close a tool window or a 
tabbed window, the content, state, and position of the window or of all windows in the tabbed window 
are preserved. The preservation of content is useful for “persistent data” such as filter reports and 
directory service queries. If you try to close or de-activate a tool or tabbed window with unsaved 
changes, Eudora asks you if you want to save the changes.



Normal Windows

A window is said to be in the normal state if it is restricted to the window work area of the main Eudora window 
and cannot be dragged out of the main window.

Normal windows can be moved around within the window work area. They can also be minimized, and 
maximized to completely fill the visible window work area. When a normal window is maximized, its title bar 
partially blends with the main window title bar.

Normal windows can overlap other normal windows and are obscured by both docked and floating windows.

The title bar of a normal window contains the window-menu icon (far left) and three window buttons: 
minimize/restore, maximize/restore, and close.

A tool window in the normal state, whether alone or in a tabbed group, can be dragged out of the confines of 
the main Eudora window, but it must first be converted to a dockable or floating window. To perform this 
conversion, right-click the window’s border or tab, uncheck (turn off) Float In Main Window on the context 
menu, then select (turn on) Allow Docking on the menu.

A non-tool window in the normal state, such as a mailbox window or a message window, can never be dragged 
out of the confines of the main Eudora window.

To convert a docked or floating window to a normal window, right-click the docked or floating window’s border 
or tab, and choose Float In Main Window from the context menu.



Docked Windows

A window is said to be dockable if it is capable of being attached to one of the four edges of the main Eudora 
window. A window is said to be in the docked state if it is currently attached to one such edge.

Note: Some application programs identify the docking feature by words such as “gravity,” “snap,” 
“magnetism,” “glue,” “sticky,” “join,” and the like.

Only tool windows as described in Window States and Tabbed Windows , whether alone or tabbed, are 
dockable. All other windows in Eudora, particularly message windows and mailbox windows, are not dockable.

Note: The main toolbar, although not a window, is also dockable, to any edge of the main Eudora window or
to another dockable window.

Dockable windows can be docked to any edge of the main Eudora window and to each other. You can also 
dock multiple windows along a single edge of the main window.

When you dock a window to the main window, the visible window work area is reduced. Docked windows 
cannot be obscured by normal windows, but they can be obscured by floating windows.

To make a window dockable, do the following:

1. Right-click the window’s border or tab, make sure the Float In Main Window command is unchecked (off) 
on the context menu.

2. Select (check) the Allow Docking command on the menu.

3. To dock the window, drag the window to an edge of the main Eudora window or to another docked window,
and when the ghosted docking rectangle appears, indicating that the window will be docked, release the 
mouse button. The window attaches to the main window edge or the other window.

Some windows are more convenient to use when docked vertically (tall-and-skinny), while others are more 
convenient to use when docked horizontally (short-and-wide). Examples of windows that work better as tall-
and-skinny windows are the Mailboxes window and the File Browser window. Examples of windows that work 
better as short-and-wide windows are the Personalities window and the Filter Report window.

Following are descriptions of the controls in docked windows. 

The Gripper Bar

The gripper bar, also called the grab handle, is the double line at one edge of the docked window. Drag the 
window by the gripper bar to undock it from the main window frame. The window now floats; you can leave it as
a floating window, or you can dock it to any edge of the main window or to another docked window. 

Note: The toolbar has a gripper bar.

The Zoom Bar

When two or more windows are docked on the same edge of the main window, Eudora activates each 
window’s zoom button. This button appears next to the “x” close button and contains a small triangle. Click the 
zoom button to minimize, maximize, or restore the width or height of that docked window relative to the other 
docked windows adjacent to it. 



The Close Button

The close button contains an “x” and appears next to the zoom button. Click the close button to close the 
docked window. 

The Resize Bar

When two windows are docked side by side along one edge of the main window, a bar appears between them, 
called the resize bar. Drag this bar up or down, or to the left or right, as appropriate, to enlarge one of the 
docked windows and reduce the other. 



Floating Windows

A window is said to be in the floating state if it floats above the main Eudora window and can be placed 
anywhere on the desktop, including outside the main Eudora window. In this way a floating window is a 
standard Windows “Always on Top” window, like tool palettes in paint programs.

Only tool windows as described in Window States and Tabbed Windows, whether alone or tabbed, can be 
made to float. All other windows in Eudora, particularly message windows and mailbox windows, cannot be 
made to float.

All windows in Eudora can be thought of as “living” in one of three layers or areas:

• Normal windows live in the window work area, at the bottom layer

• Docked windows live at the level of the main Eudora window’s border, the middle layer

• Floating windows live at the level above the main Eudora window, the top layer.

Therefore, a floating Eudora window floats above all other Eudora windows except other floating windows.

The title bar of a floating window contains, in addition to the title, only the close button. This distinguishes the 
window from a normal window when both appear to be in the window work area; a normal window’s title bar 
contains the window-menu icon (left) and three buttons. But also note that a floating window can be dragged 
outside of the main Eudora window, whereas a normal window cannot.

You can diagonally resize any floating window in Eudora. Simply position the pointer over any window corner, 
click and drag to enlarge or reduce.

To convert a window to a floating window, either undock it from the main window, if it is docked, or do the 
following; right-click the window’s border or tab, make sure the Float In Main Window command is unchecked 
(turned off) on the context menu, then turn off (uncheck) the Allow Docking command on the menu. For a 
docked window, you can also temporarily override the Allow Docking command and suspend docking by 
holding down the Ctrl key while dragging the window. The window drags as a floating window. 



Tabbed Windows

A tabbed window is a collection of tool windows combined into one window. Each tool window in the tabbed 
window has its own window tab.

A window tab has two purposes: 

· It lets you bring the window to the front of the group to display it (by clicking on the tab). 

· It serves as a “drag handle” that lets you drag the tool window from one tabbed window to another, so that 
you can reorganize your tabbed windows and create new tabbed windows.

Only tool windows, as described above, are accessible from the Tools menu except the Options dialog, and are
capable of being combined into a tabbed window. All other windows in Eudora,    particularly mailbox windows 
and message windows,    are not capable of being combined into a tabbed window.

A tabbed window can be in any of the three window states, normal, docked, or floating, and you can convert a 
tabbed window from any state to any other state.

If a tabbed window shows a title bar, the title in the bar is the name of the active window in the group. 



Default Tabbed Windows

Eudora comes with two default tabbed windows, shown in the figure above, which together include all nine tool 
windows.

The first default is a vertically oriented tabbed window that is docked to the left side of the main window and 
contains the following five tool windows, with tabs in left-to-right order:

• Mailboxes Window

• File Browser Window

• Stationery Window

• Signatures Window

• Personalities Window

The second default tabbed window is a normal window that contains these four tool windows, with tabs in left-
to-right order (to display this window, display one of the member windows from the Tools menu):

• Directory Services Window

• Address Book

• Filters Window

• Filter Report Window

You can reorganize these default tabbed windows any way you like. Your new organization will be preserved 
when you quit and restart Eudora.

Note: Due to EUDORA.INI file-format incompatibilities, if you upgrade from a pre-4.0 version of Eudora you 
will lose the previous docking state of your Mailboxes window and toolbar. Eudora will reset the 
toolbar and docking states to the default configuration noted above. However, customized toolbar 
information is preserved; only the size and location of your toolbar may change.



Opening and Activating Tabbed Windows

To open a tabbed window that’s hidden, open any of its member windows by selecting the appropriate 
command from the Tools menu. The tabbed window opens with the selected window as the active (frontmost) 
window.

If the tabbed window is already visible, and you wish to display one of its member windows that is currently not 
active, simply click the member window’s tab. You can also select the appropriate item from the Tools menu. 
The desired window comes to the front of the tabbed group.

You can also use the tool window’s keyboard shortcut, if it has one, to open or activate the tool window in its 
tabbed window. 



Reorganizing Tabbed Windows

You are not restricted to the default tabbed window arrangements supplied with Eudora. You can mix and 
match tabbed windows any way you like.

At one extreme, you can have each of the nine tool windows in its own container with its own tab. At the other 
extreme, you can have all nine tool windows combined into one tabbed window. In between, you can have 
multiple tabbed windows open at once, mixed and matched to suit your purposes.

To move a window from one tabbed group to another, drag the window tab from the first group and drop it onto 
the second.

While the drag operation is in progress, the cursor changes and Eudora displays a small ghosted rectangle 
when you are over a valid drop location.

If you drop the window tab onto another tab in the second group, the new window tab is inserted at that position
and the other tabs are displaced to accommodate it. If you don’t drop the tab onto an existing tab, Eudora adds 
the new tab at the “end” of the group of existing tabs, where that end depends on the location of the tabs in the
tabbed window: top, bottom (the default), left, or right. For example, with tabs along the bottom, the “end” is the
far right.

Note that the relocated window takes on the window state — normal, docked, or floating — of the destination 
tabbed window.

To reorganize the left-to-right or top-to-bottom order of tabs within a tabbed window, just drag the tabs left and 
right or top and bottom. The drop scheme is the same as that described above. 



Creating a New Tabbed Window

To create a new tabbed window, do the following:

1. Drag one of the tabs from an existing tabbed window.

2. Drop it onto an exposed portion of the window work area. If the window work area is completely obscured, 
for example,    a normal window is maximized, then drop the tab onto the status bar.

The dropped window converts into a normal tabbed window with a single tab. 

To convert the window to docked or floating, do the following: 

1. Right-click the tab or the window border.

2. On the context menu, uncheck Float In Main Window. 

3. Check the Allow Docking command on the menu to make the window dockable. 

4. While dragging the floating or docked window, hold down the Ctrl key to temporarily suspend docking 
behavior. When you release the key, docking behavior resumes. 



Tab Display in Single-Tabbed Windows

If a tool window is in a tabbed window by itself, with one tab, you can hide or show the tab by doing the 
following:

1. Right-click on the tab or the window border to display the context menu.

2. From the Tab Location submenu, select    Show Single Tab. 

Note: You cannot hide the tabs in a tabbed window with two or more tabs.



Tab Contents, Location, Auto-Activation

• Tab Contents — A window tab contains both the icon and the text label associated with that window. If there
is room enough in the tabbed window, both the icon and the label are displayed on each tab. If there is not 
enough room, only the icon is displayed for each tab. If only the icon is visible, pause the mouse pointer 
over the tab icon, and Eudora will display the tab text in a tool tip.

• Tab Location — By default, Eudora arranges window tabs along the bottom edge of a tabbed window. 
Sometimes it is more convenient to have the tabs displayed along a different edge. For example, in a short-
and-wide tabbed window (one that is docked horizontally), you can improve the visibility of the window’s 
contents by moving the tabs to the right edge. To change the location of the tabs in a tabbed window, right-
click one of the tabs or on the window border, and select a new location from the Tab Location submenu of 
the context menu.

• Tab Auto-Activation — During a drag and drop operation, if you pause the mouse pointer over the tab of an
inactive window in a tabbed window, that window becomes active (is brought to the front), and you can 
complete the drop. For example, if you drag received messages to the Mailboxes window when it is inactive 
in a tabbed window, pause the pointer over the Mailboxes window’s tab; the window is made active and you
can drop the messages in a mailbox. Note that tab auto-activation is disabled when you are dragging a tool 
window tab. 



Closing Tabbed Windows

To close a tabbed window, click the “x” close button in the corner of the window.

Alternately, right-click any tab in the window, or on the window border, and choose Hide from the context menu.

Note that when you close or hide a tabbed window, the contents of all member windows, and the state and 
position of the tabbed window, are all preserved. When you redisplay the tabbed window, the active window 
shows its prior contents and the tabbed window appears in its prior state and position.

However, if you attempt to close or hide a tabbed window in which the active window contains unsaved 
changes, or you attempt to deactivate that active window by making another window active in the group, 
Eudora asks you if you want to save your changes. 



The Window Context Menu

If you right-click the tab or border of a single tool window, or on any tab or the border of a tabbed window, 
Eudora displays a context menu containing window-management commands.

The commands on the context menu are described below.

Note that if you right-click in the interior of some tool windows, and sometimes on an item in the window itself, 
these window-management commands appear at the bottom of the context menu specific to that tool window. 

Tab Location

This submenu is always available on the window context menu. It lets you change the location of the tabs in a 
tabbed window, and lets you show and hide the tab in a single-tabbed window.

By default, Eudora places window tabs at the bottom of a tabbed window. Choose Top, Bottom, Left, or Right 
from this submenu to move the tabs to the top of the tabbed window, the bottom, or the left or right side. Eudora
places a bullet (radio button) next to the current tab location selection.

Changing tab locations can sometimes increase the visible space within a tabbed window. For example, a 
short-and-wide tabbed window (one docked horizontally) might show more content if you move the tabs to the 
right side.

Show Single Tab is available in a single-tabbed window, and lets you show or hide the tab. A checkmark next 
to the command indicates that the tab is shown (the default). This command is not available in a tabbed window
containing two or more tabs; you cannot hide the tabs in such a window. 

Allow Docking

This command controls the ability to dock of floating and docked windows. It is available only when the Float In
Main Window command is turned off (unchecked). It is not available for normal windows (that is, when Float In
Main Window is turned on).

A checkmark next to the command indicates that it is on.

When this command is on for a docked or floating window, the window can be docked to any edge of the main 
Eudora window.

When Allow Docking is turned off for a docked window, the window is converted to a floating window and 
cannot be re-docked. When the command is turned off for a floating window, the window cannot be docked.

Even with Allow Docking on, you can hold down the Ctrl key while dragging a docked or floating window to 
suspend its ability to dock until you release the key. 

Hide

This command is always available on the context menu.

Choose Hide to hide (close) the tool window or tabbed window. Hide performs the same function as the Close 
command (Ctrl+F4) on the standard MS Windows window context menu.

Note, however, that when you hide or close a tool window, its content, state, and position are all preserved. And
when you hide or close a tabbed window, the content, state, and position of all member windows are preserved.
Thus, if you hide and redisplay a floating tabbed window, the window floats in its same position.

If you attempt to hide or close a tool window that contains unsaved changes, or a tabbed window in which the 



active window contains unsaved changes, Eudora asks you if you want to save your changes.

To redisplay a tool window after you’ve hidden it, select it from the Tools menu. To redisplay a tabbed window 
after you’ve hidden it, select one of its member windows from the Tools menu. The tabbed window redisplays 
with the selected window active. You can use keyboard shortcuts to redisplay hidden tool or tabbed windows 
where appropriate. 

Float In Main Window

This command is always available on the context menu.

Turning this command on (indicated by a checkmark next to the command) converts a docked or floating 
window to a normal window. Turning this command off converts a normal window to a docked or floating 
window.

Note that the availability of the Allow Docking command depends on the state of this command. When Float 
In Main Window is turned on (checked), Allow Docking is unavailable (the window is normal). When Float In 
Main Window is turned off, Allow Docking is available. 



Filter Report Window

If the Generate Filter Report option is turned on in the Getting Attention options window found in Options 
under the Tools menu. So when filters are used, Eudora generates a filter report. This report can be viewed in 
the Filter Report window found under the Tools menu.

To open the Filter Report window, do the following:

1. From the Tools menu, choose Filter Report. Or, if the Filter Report window is in a visible tabbed window, 
click its tab.

If filter report generation is enabled via the option mentioned above, then each time a filter operation is 
performed, Eudora adds the entry or entries to the Filter Report window and activates the window.

The Filter Report window displays three columns of data:

• Mailbox — Lists the names of the mailboxes into which messages have been filtered during the current 
Eudora session. Each listing represents one filter operation for that mailbox.

• Messages — For each mailbox listed in the Mailbox column, lists the number of messages filtered into that 
mailbox during the filter operation.

• Time — For each mailbox listed in the Mailbox column, lists the time that the messages were filtered into 
that mailbox during the filter operation.

By default, the entries in the window are sorted by time. However, you can click the column headings and sort 
the display by mailbox names (Mailbox) or by the number of messages filtered (Messages).

Note: Whenever new entries are added to the list, Eudora always appends them to the bottom of the list in 
order of arrival, ignoring the current sort order. Simply click a column heading to re-sort.

Select one or more entries in the list and double-click the selection, or press Enter, and Eudora opens the 
mailbox windows associated with those selections.

The Filter Report listing is a cumulative log of the filter actions for the current Eudora session. Eudora 
automatically clears the log when you quit the program.

Closing the Filter Report window does not erase the contents of the filter report, as it did in previous versions of 
Eudora. Only quitting Eudora erases this information.



File Browser Window

Use this window to browse the Windows desktop. You can use this window to find files to attach to new 
outgoing messages, for example.

To open the File Browser window, do the following:

1. From the Tools menu, choose File Browser. Or, if the File Browser window is in a visible tabbed window, 
click its tab.

The File Browser window performs some, but not all, of the functions of the standard Windows 95 and Windows
NT 4.0 Explorer programs.

The File Browser window contains three controls:

• Drive Selector (top box) — A pop-up menu in this field contains a fixed set of high-level folders on your 
system, just like the corresponding control in Windows Explorer. The Drive Selector field determines what 
gets displayed in the Folder Browser (middle section). When you first launch Eudora, the Drive Selector 
automatically sets itself to the drive containing your Windows folder. Note that the first entry in the pop-up 
menu is a shortcut called “My Attachments” that points to your Eudora attachments folder.

• Folder Browser (middle section) — This is a tree control that displays the folder hierarchy whose root is the 
selection entered in the Drive Selector field. For example, if in the Drive Selector box you choose the C: 
drive, then the Folder Browser displays the folder tree-hierarchy branching down from the C: drive folder. 
Right-click a folder item in the Folder Browser to display the standard Windows context menu for that folder.

• File List (bottom section) — This is a list control that displays the files contained in the folder selected in the 
Folder Browser. You can select one or more file items in the list, then right-click the selection to display the 
standard Windows context menu for those files. (Note: Eudora does not fill in the Send To submenu on the 
context menu.) When selecting multiple items, use the Shift key to select a range of items, and use the Ctrl 
key for disjoint selections.

The File List control shows these four columns:

• Name — Displays the name of the file and the icon associated with the file.

• Type — Based on the file name extension, displays the file type as set in the Options dialog of Windows 
Explorer.

• Size — Displays the size of the file in kilobytes (K), where 1K = 1,024 bytes.

• Modified — Displays the date and time that the file was last modified.

As in Windows Explorer, you can click any of the four column headings to sort the listing by the data in that 
column.

You can also resize the widths of the columns by dragging the separator line between the column heading 
labels. Position the pointer over the separator until you see a splitter cursor, then drag the line to left or right.

In the File List control, double-click an item in the Name column, or select one or more items in the column and 
press Enter, to open the selected items. For program files, this action launches the program. For document 
files, this action generally launches the registered viewing or editing application for that document. Eudora 



displays an error dialog if it is unable to open a file in this way.

To adjust the relative heights of the Folder Browser and File List controls, position the pointer over the separator
bar between the Folder Browser and File List controls until the splitter cursor appears, then click and drag the 
separator up or down. Note that the File Browser window maintains a minimum height for the Folder Browser 
and File List controls, so you cannot close them all the way.

To manually refresh the File Browser window display, right-click anywhere in the File Browser window but not 
on a Folder Browser item or File List item, then choose Refresh from the context menu. (Tip: A good place to 
right-click is in the Drive Selector box.) Alternately, press the F5 key while keyboard focus is in the File Browser 
window.

You can select one or more files in the File List control and drag them to a message composition window to 
attach those files to that outgoing message. This is especially handy if you keep the File Browser window 
docked and open. (For multiple file selections, use the Shift key to select a range, and use the Ctrl key to make
disjoint selections.)

You can also select one or more items in the File List control and drag them to another application that can 
receive such files.

In general, the File Browser window lets you drag items out of the window (copying them rather than moving 
them), but the window is not a proper drop target; you cannot drop items into the window that you’ve dragged 
from elsewhere on your desktop. In particular, you cannot move files by dragging them to a target folder in the 
Folder Browser control. You also cannot drag and drop items within the File Browser window (from one control 
to another, for example). You can, however, manage the files and folders in the window using the commands on
the window’s context menu, such as Cut, Copy, Paste, and Delete. 



Stationery Window

Use this window to manage and apply stationery.

To open the Stationery window, do the following:

1. From the Tools menu, choose Stationery. Or, if the Stationery window is in a visible tabbed window, click 
its tab. 

The Stationery window displays a single-column list of your stationery files.

Note: You can only select one item at a time in the list; you cannot select multiple items.

If you right-click a stationery item in the list, a context menu is displayed with the following commands (the 
standard Eudora window-management commands appear at the bottom):

• New — Create a new piece of stationery (a new stationery file). An untitled stationery window opens; enter 
the stationery name and from the File menu, choose Save As Stationery.

• Edit — Open an editing window for the selected stationery item. Make your changes and from the File 
menu, choose Save As Stationery, or close without saving to discard your changes.

• Delete — Delete the selected stationery item. Eudora asks you to confirm the deletion. Use the Del key 
(Delete) as a shortcut for this command.

• Rename — Rename the selected stationery file. Use the F2 key as a shortcut for this command, or click the 
stationery file’s name box, then edit the name right in the box.

• New Message With — Create a new message with the selected stationery. As a shortcut for this command, 
either select the stationery item and press Enter, or just double-click the stationery item.

• Reply With — Reply with the selected stationery to the sender(s) of the received messages that are 
currently selected.

• Reply to All With — Reply with the selected stationery to the sender(s) and all recipients of the received 
messages that are currently selected.

You can also display the context menu and create new stationery by right-clicking anywhere in an empty 
Stationery window or by right-clicking anywhere off a stationery item in a non-empty Stationery window. 



Personalities Window

Use this window to manage, access, and apply your e-mail accounts —    “multiple personalities” — when you 
use more than one account.

To open the Personalities window, do the following:

1. From the Tools menu, choose Personalities. Or, if the Personalities window is in a visible tabbed window, 
click its tab.

Note: The Personalities window replaces the Personalities window of the Options dialog that appeared in 
previous versions of Eudora.

The Personalities window displays two columns of data:

• Persona — The identifying name assigned to the personality. <Dominant> indicates your principal e-mail 
account, which is the account Eudora uses whenever you don’t specify otherwise, and is the account 
associated with all mail stored before you began using alternate personalities.

• Account — The incoming mail account assigned to the personality. This is generally in the form 
loginname@incomingmailserver. (See Account Settings Dialog .)

To resize the column widths, position the pointer over the divider line between the column headings, until a 
splitter cursor appears. Then just drag the divider to left or right. Note that it is possible to completely collapse 
the Persona column.

Note: You cannot manually sort the information in the Personalities window. Clicking on a column heading 
does not do a sort 

Note: You can select multiple items in the Persona column to perform some of the operations listed below. 
Use the Shift key to select a range of items, and use the Ctrl key to make disjoint selections.

If you select one or more personalities in the Persona column and right-click the selection, a context menu is 
displayed with the following commands (the standard Eudora window-management commands appear at the 
bottom):

• Check Mail — Check mail now for all selected personalities.

• Send Queued Messages — Send messages queued by all selected personalities now.

• Message — This submenu lets you perform message-creation functions using only one selected 
personality. The submenu is unavailable if multiple personalities are selected in the Persona column. 

- New Message As — Create a new message as the selected personality. As a shortcut for this command,
double-click a personality in the Persona column, or select the personality and press Enter.

- Reply As — Reply as the selected personality to the sender(s) of the one or more received messages 
that are currently selected.

- Reply to All As — Reply as the selected personality to the sender(s) and all recipients of the one or 
more received messages that are currently selected.

- Forward As — Forward as the selected personality the one or more received messages that are 
currently selected.

- Redirect As — Redirect as the selected personality the one or more received messages that are 



currently selected.

- Send Again As — Resend as the selected personality the one or more received or composition 
messages that are currently selected.

• New — Create a new personality. When you select this command, Eudora walks you through the New 
Account Wizard. Enter a Personality Name (e.g., My Laptop Account) and click Next. You then have the 
choice to create a new e-mail account or import the settings from an existing e-mail account — that is, 
“clone” an existing personality. If you choose a new e-mail account, Eudora prompts you for your name, 
your return e-mail address, your login name, and your incoming e-mail server (POP or IMAP). Fill in each 
item as instructed. If you choose to import the settings from an existing e-mail account (clone a personality), 
Eudora asks you to choose the account to clone, then asks you to confirm the settings and optionally 
change them. If you leave them unchanged, the cloned account is created when you click Finish. If you 
choose to change them, Eudora walks you through the settings as above: name, return address, login 
name, and incoming e-mail server. Change these settings as desired, and when you are complete, the new 
account is created.

• Modify — Modify the selected personality. You can only modify one personality at a time. When you select 
this command, the Account Settings dialog displays, with its fields filled in with the information associated 
with that personality. See the description of this dialog below.

• Delete — Delete all selected personalities. Note, however, that you cannot delete the <Dominant> 
personality. You are prompted to confirm the deletion for each personality you have selected to delete. Note 
that these deletions are permanent and cannot be undone! When you delete a personality, any messages 
associated with that personality are reassigned to your Dominant personality. You can use the Del key 
(Delete) as a shortcut for this command (you will still get the confirmation requests).

You can also display the context menu and create a new personality by right-clicking in a blank area of the 
Personalities window, off all personality items, when none of the items are selected. When creating a new 
personality this way, you are walked through the New Account Wizard as in the description of the New 
command above.

If you drag one or more received messages to a personality item in the Personalities window, Eudora will Reply
As that personality to the messages (hold down the Ctrl key to Reply to All As).



Account Settings Dialog

The Account Settings dialog replaces the Personalities window of the Options dialog that appeared in previous 
versions of Eudora.

To display the Account Settings Options dialog, do the following:

1. Select a personality for which you wish to enter account settings information.

2. Right-click on the personality. The context menu is displayed.

3. From the context menu, choose Modify. The Account Settings Options dialog is displayed. 

This tabbed dialog appears in the Personalities window . When you display the dialog, its fields are filled in with 
the information associated with the personality you have selected to modify.

The fields of the Account Settings dialog are described below. Where appropriate, the default value of the 
setting for newly created accounts is shown in brackets after the name of the setting.

After you make your changes in the dialog, click OK to save them, Cancel to discard them, or Help for more 
help.

Note: Any changes you make to your Dominant personality in this dialog are also changed where they are 
mirrored in relevant options of the Options dialog. The same is true in reverse; changes you make in 
the Options dialog are carried over here, when you next open this dialog.

Generic Properties ¾ This window contains the general characteristics associated with this personality.

Personality Name ¾ This is a label that shows the name assigned to the personality being modified (e.g., 
Beatrix at Work, or My PC Account). <Dominant> indicates your dominant personality.

Note: Your Dominant personality is your principal e-mail account; it’s the personality Eudora uses 
whenever you don’t specify otherwise, and it’s also the personality that’s associated with all mail 
stored before you began using alternate personalities.

Note that the name shown here may be different from the Real Name associated with the personality (see 
below).

Traits:

Real Name ¾ This is the real name assigned to this personality—generally a first and last name. The text you 
enter here is included in the From field of all your outgoing messages from this personality, and identifies to 
your recipients who the mail is from.

Return Address ¾ This is the return e-mail address used in outgoing messages and recipients’ replies for this 
personality, if this address is different from the personality’s incoming mail account. The address you enter here
is included in the From field of all your outgoing messages from this personality, and when a recipient replies to
a message from this personality, the reply is sent to this address. If you do not enter an address in this field, 
Eudora uses the personality’s incoming mail account as the return address. Incoming mail accounts are usually
of the form loginname@incomingmailserver. For example, suppose your incoming mail account is 
beatrixp@wabbits.qualcomm.com but your return address is beatrixp@qualcomm.com — slightly different. 
You would then enter beatrixp@qualcomm.com in this field.

Note: If you do enter an address in this field, first test the address to be sure that mail sent to it is indeed 
delivered to you. If you use an invalid return address, no one will be able to reply to your mail sent 
from this personality.

Login Name ¾ This is the name you use to login to this e-mail account, for accounts that require a user login. 



For example, in the incoming mail account beatrixp@wabbits.qualcomm.com, the login name is beatrixp. 
(The part after the “@” sign is the name of the incoming mail server — see the Incoming Mail window below.)

SMTP Server ¾ This is the name of the outgoing-mail server for this personality. SMTP stands for Simple Mail 
Transfer Protocol. Outgoing messages you send are routed through this server. If the computer that this 
personality’s incoming mail account is on also runs an SMTP server, you can leave this field blank.

Default Domain ¾ This is the domain name that Eudora automatically adds to an unqualified name addressed 
in messages sent from this personality. An unqualified name is a name that doesn’t have an “@” sign followed 
by a domain name. This can be used to save time when addressing large numbers of messages to users in the 
same domain. Also, different personalities can be used to send messages to different domains. For example, 
you can use one personality to send work-related messages to the domain qualcomm.com, and another 
personality to send personal messages to the domain in your home e-mail address, or to your school account, 
e.g., myschool.edu.

Default Stationery ¾ The default stationery to use for all outgoing messages sent from this personality. Select 
a stationery file from the pop-up, or select <No Default> for no default stationery. For more details about using 
stationery with alternate personalities, see Using Stationery and Stationery Window.

Default Signature ¾ This sets the default signature to use for all outgoing messages sent from this personality,
but only when you are not using stationery; that is, only when the Default Stationery pop-up (above) is set to 
<No Default>. If you have chosen a stationery file in the above pop-up, then the signature used when that 
stationery file was saved overrides your setting here.
Select a signature from this pop-up, or select <No Default> for no default signature. If you select a signature, 
Eudora automatically attaches that signature to the end of all outgoing messages sent from this personality. You
can always change the signature in a particular outgoing message using the Signature pop-up in the 
composition window. For more details about using signatures with alternate personalities, see Using a 
Signature and Signatures Window.

Check Mail ¾ If this is on, mail checking is activated for this personality in the following ways:

• If you have specified a number in the Check for mail every ? minutes option in the Checking Mail Options 
Window, then when automatic mail-checks are performed at these intervals, mail for this personality is 
checked too.

• Each time you do a manual check for mail, by selecting the Check Mail command from the File menu or via 
another method, mail is checked for this personality too.

If this option is off, mail for this personality is not checked during manual or automatic mail-checks, except that 
you can override the setting and still check for the personality’s mail using the Mail Transfer options window or 
using the Check Mail command from the Personalities window’s context menu.

Incoming Mail ¾ This window contains settings that identify and configure the incoming mail server to be used 
in receiving mail for this account.

Server ¾ This is the name of the incoming-mail server for this personality. All incoming messages to this 
personality are routed through this server.

Configuration ¾ This indicates which e-mail protocol the incoming mail server uses: POP (Post Office 
Protocol) or IMAP (Internet Message Access Protocol). Ask your e-mail administrator which one to use, if you 
are not sure.
The settings in the rest of this window depend on whether you’ve chosen POP or IMAP in this field. Settings for
both configurations are described below.

When Configuration = POP:

Leave mail on server ¾ If this is on, then during mail checks, incoming mail for this personality is left on the 



incoming mail server and a copy is transferred to your PC. If this is off, then when mail is checked, incoming 
mail for this personality is deleted from the incoming mail server after it is transferred to your PC. For more 
details, see Managing your Mail on a POP Server. 
Delete from server after ? days ¾ This option has a check box for turning it on and off and an edit box for 
specifying the number of days mail that was left on the POP server should be saved before being deleted. It is 
a good idea not to leave copies of your messages on the POP server indefinitely, as this will create mail storage
problems on the server.

Delete from server when emptied from Trash ¾ If this is on, any messages that are deleted from your Trash 
mailbox are also deleted from the POP server.

Skip messages over ? K in size ¾ If this is on, messages over the specified size are downloaded only in part. 
These messages include the first few lines, and a statement that says the message is not complete. This can 
be useful on slow connections. For details, see Managing your Mail on a POP Server

Authentication style ¾ This specifies which POP account authentication technology to use for this personality:
Passwords, Kerberos , APOP, or RPA. Ask your e-mail administrator which one to use.

When Configuration = IMAP:

IMAP Mailbox Location Prefix ¾ This specifies the mailbox location prefix that IMAP will use when locating 
your mailboxes on the incoming mail server. An example prefix is /usr/mail. Ask your e-mail administrator what 
to enter here, if you are not sure.

For new mail, download ¾ These two settings let you control the way incoming mail is downloaded from the 
IMAP server.

Minimal headers only [on] ¾ If this setting is on, only a limited set of message headers is downloaded for 
each incoming message. If this setting is off, the full set of message headers is downloaded for each incoming 
message.

Full message except attachments over ? K [off, blank] ¾ If this setting is on and a number is entered in the 
edit box, then any messages including attachments larger than the specified size will not be delivered. If this 
setting is off, all messages with attachments are downloaded, regardless of size.

Authentication style [Passwords] ¾ This specifies which IMAP account authentication technology to use for 
this personality: Passwords or CRAM-MD5. Ask your e-mail administrator which one to use. 



Using the Address Book

The Address Book is where you keep information about individuals or groups that you correspond with. Each 
entry in the Address Book includes a nickname for a person or group, their full e-mail addresses, a real name, 
any contact information, and any notes. You can also use the Address Book to put nicknames on the Quick 
Recipient List, and to address a new message.

To open your Address Book, do the following:

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address Book is an inactive 
window in an open tabbed window group, click its tab. (See Window States and Tabbed Windows for more 
details on tabbed windows.)

All of the Address Book entries are kept in files. The example above shows files for Business, Family, and 
Friends (Eudora Nicknames is the default file). You can show or hide the entries in a file by double-clicking on 
the file. The icon shows an open or closed book, depending on whether the file is open or closed.

You can use the View By option to display the entries using any of the fields except the Notes field. For 
example, if you want to view the entries by nicknames, choose View By Nickname. If you view by a field that 
doesn’t contain any data, the entry is displayed with <>.

Note: Eudora remembers your selection in the View By field when you quit and restart the program.

You can also start typing in the list of entries, and the appropriate entry will be selected when you enter enough 
unique characters to identify it.

To page up and down in the list of entries, use the arrow keys. To resize the list, drag the divider.

To close and open the right-hand side of the Address Book, use the close (<) and open (>) buttons.

To move the keyboard focus back and forth between the left and right sides of the Address Book, press the F6 
key.

To move quickly through the tabbed windows on the right side of the Address Book, use the Ctrl+Tab, 
Ctrl+PgUp, Ctrl+PgDn, Ctrl+Home, and Ctrl+End keys.



Creating New Entries

To create a new file of Address Book entries, do the following:

1. From the Tools menu, select Address Book. 

2. Click New, or right-click anywhere in the entry list and from the pop-up menu, choose New. A dialog is 
displayed asking what you want to call it.

3. Enter a name for the file and choose Make it an Address Book, then click OK to create it. The file is 
displayed in the list, and you can now add entries to the file.

To create a new entry to be included in an existing file, do the following: 

1. From the Tools menu, select Address Book. 

2. Click New or right-click anywhere in the entry list and from the pop-up menu, choose New. 

3. Select an address from anywhere in Eudora and drag it to the Address Book, or drag a message summary 
to the Address Book. A dialog is displayed. 

4. Enter a Nickname for the entry. A Nickname (sometimes called an alias) is an easily remembered, shorter 
substitute for the e-mail addresses in the entry. Nicknames can be used in place of proper e-mail 
addresses in the To, Cc, and Bcc fields of outgoing messages. For example, “buddies” may be a 
nickname that stands for a list of five complicated e-mail messages for five friends of yours. You’ll be 
sending mail addressed to “buddies” rather than having to enter those five complicated e-mail addresses 
in the recipient fields.

5. Specify which file this entry belongs in (if you have multiple files). 

6. If you want the nickname on your recipient list, select the Put it on the recipient list option. You cannot 
create a file within a file, so do not use the Make it an Address Book option. 

7. To create the entry, click OK. Then you can enter the information for that entry.

8. In the Address(es) tab, enter the complete e-mail addresses of the people (or person) to be included in 
the nickname, separating the addresses with commas or returns (this is the only place you can use a 
return to separate addresses). You can also use nicknames in this field, but be sure that any nicknames 
you use are defined in their own entry. You can use a mix of nicknames and complete e-mail addresses.

Note: Be sure there is no other information in this field except addresses or nicknames, or your messages 
will be addressed incorrectly.

9.            In the Name field (in the Info tab), enter the real name of the person or group. If there is just one address
for the entry, the real name and the address are included in the To field for your recipient to see. If there is 
more than one address for the entry, the real name is the only thing included in the To field for your 
recipients—they do not see the whole list of recipients. If there is nothing in the Name field, the recipients 
do see the whole list.

In the other fields provided in the Info (Postal Address, Phone, and Fax) and Notes tabs, you can enter 
contact information for the person or group, and any notes to yourself. This information is not included in 
outgoing messages.



We recommend that you have at most 2,500 entries per file. If you have a large number of entries, you may 
want to consider using a Ph server (for information, see the “Sources” section of the Eudora Reference 
Manual).

10.        To save your changes to the Address Book, from the File menu, choose Save.



Changing, Moving, Copying, and Deleting Entries

To change the nickname for an entry, see Renaming a Nickname .

To make other changes to an entry, that is, to change any information in the Address(es), Notes, or Info tabs, 
select the entry from the list and edit the fields as appropriate.

To move or copy an entry to a file, right-click it and select the Move To or Copy To command. The Choose a 
Nickname File dialog is displayed so that you can select the file you want to move or copy the entry to.

You can move an entry (or entries) to a different file by dragging it, or copy it by holding down the Shift or Ctrl 
key and then dragging it.

Note: You cannot move an entry into the file it is already in, but you can copy an entry into its file (a “Copy 
of [Entry]” is created).

To delete an entry or an address file, select it from the list and click the Del button or press the Delete key. Or, 
right-click it and choose Delete from the pop-up menu. You cannot remove the Eudora Nicknames file.

Note: If a nickname file is set to read-only (you do not have permission to write to it), you cannot move or 
copy entries into it, or delete an entry from it.

To save your changes, choose Save from the File menu. (Tip: Add a button for the File menu Save command 
to your main toolbar as a handy way to save Address Book changes.)



Renaming a Nickname

To change the nickname for an Address Book entry, do the following:

1. Make sure the View By field is set to Nicknames, and that the entry is displayed in the list.

2. Click the nickname for the entry, pause, and click it again. 

3. Edit the nickname in the edit box.

Alternately, click the nickname once to highlight it, then press F2 and edit the nickname. Or, click the nickname 
to highlight it, right-click the selection to display the pop-up menu, choose Rename from the menu and edit the 
nickname in the edit box.

Important: If you change a nickname, but sure to correct any entries that reference that nickname.



Including Nicknames on the Quick Recipient List

To include a nickname in the Quick Recipient List, do the following:

1. Right-click the appropriate Address Book entry in the list and from the pop-up menu, choose Add to 
Recipient List. The nickname for the selected entry is included on the Quick Recipient List, and the entry 
is bolded in the Address Book list.

To remove a nickname from the Quick Recipient List, do the following:

1. Right-click the item in the Address Book list and List from the pop-up menu, choose Remove From 
Recipient. The nickname for the selected entry is removed from the Quick Recipient List, and the entry is 
unbolded in the Address Book list.

If you change a nickname, the Quick Recipient List is updated as appropriate. For details about using the Quick
Recipient List, see Using the Quick Recipient List .

Note: You can add or remove multiple nicknames to or from the Quick Recipient List by selecting multiple 
entries before right-clicking. Hold down the Shift key to select multiple entries in sequence, or the Ctrl 
key to make disjoint selections.



Addressing a Message from the Address Book

You can open and address a new message from the Address Book using the To, Cc, and Bcc buttons.

To create a new message from the Address Book, do the following:

1. Select the entry you want to address the mail to (hold down the Shift key to select multiple entries in 
sequence, or the Ctrl key to make disjoint selections). 

2. Click To, Cc, or Bcc. A new composition window is displayed with the selected nickname(s) inserted in the 
appropriate field.

Note: You can also double-click an entry to enter that nickname in a header field. If no composition window 
is open, a new composition window is opened and the nickname is entered in the To field. If a 
composition window is open when you double-click, the nickname is entered in the header field that 
last had keyboard focus.

To address the message with the completely expanded address or addresses for that entry, rather than the 
entry’s nickname (the addresses are listed in the Address(es) field for the entry), turn on the Expand 
Nickname option.

Once the composition window is displayed, you can use the To, Cc, and Bcc buttons to insert additional 
nicknames into the corresponding fields, subject do the following restrictions.

If the Address Book is a docked or floating window (either alone or as part of a tabbed window group), the To, 
Cc, and Bcc buttons apply to the topmost composition window, if any. If the Address Book is a normal window 
(either alone or as part of a tabbed window group), the To, Cc, and Bcc buttons apply to the composition 
window, if any, that is immediately under either the Address Book or the tabbed window group containing the 
Address Book. For more information on docked, floating, normal, and tabbed windows, see Window States and 
Tabbed Windows .



The "Make Address Book Entry" Command

The Make Address Book Entry command is used to create entries in your Address Book, and is especially 
helpful for making group entries.

In the Address Book, do the following:

1. Highlight several different entries (hold down the Shift key to select multiple entries in sequence, or the Ctrl
key to make disjoint selections), 

2. From the Special menu, choose Make Address Book Entry. The Make Address Book Entry dialog is 
displayed, prompting you for the nickname of the new entry. The Address(es) field of the new entry will 
include the nicknames for the entries you selected, not the real addresses.

Note: When the Address Book is docked or floating, the Make Address Book Entry command applies to 
the Address Book only if the keyboard focus is in the Address Book. When the Address Book is a 
normal window, this command applies to the Address Book only if it is the topmost normal window, or 
if the tabbed window group containing it is the topmost normal window and the Address Book is the 
active window in the group.

In a mailbox, highlight the message summaries you want and from the Special menu, choose Make Address 
Book Entry. The Make Address Book Entry dialog is displayed, prompting you for the nickname of the new 
entry. Follow the instructions for creating a new entry. If the current message is an outgoing message, the new 
entry will include all of the addresses in the To, Cc, and Bcc fields. If the current message is an incoming 
message, the new entry will include the address in the From field. If multiple messages are current (i.e., you 
have several message summaries selected in a mailbox window), addresses are taken from each message and
are all put in the new entry.

Note: The Make Address Book Entry command uses the Reply Options. If the Include yourself option is 
on, your address is included in the new entry. If this option is off, your address is not included. To 
determine who you are for the Include yourself option, Eudora uses the addresses listed under your 
“me” nickname, if you have one set up.

In an open message window, from the Special menu, choose Make Address Book Entry. The Make Address 
Book Entry dialog is displayed, prompting you for the nickname of the new entry. Follow the instructions for 
creating a new entry. If the open message is an outgoing message, the new entry will include all of the 
addresses in the To, Cc, and Bcc fields. If the open message is an incoming message, the new entry will 
include the address in the From field. If multiple messages are open, addresses are taken only from the 
currently active (topmost) open message. Also see the note above about the Include yourself option.

In the Directory Services window, finish a query, select in the results list the target(s) you want to include in the 
entry, and from the Special menu, choose Make Address Book Entry. The Make Address Book Entry dialog is
displayed so that you can name the nickname. The real name and e-mail address of each selected target is 
included in the new entry. See Making an Address Book Entry from Your Query Results for more details.



The "Finish Address Book Entry" Command

With the Finish Address Book Entry command, you can enter a unique portion of a nickname in the To, Cc, 
or Bcc fields of a message, then from the Edit menu, choose Finish Address Book Entry, and the nickname 
will be completed for you. You must enter the characters in the nickname that make it unique, or Eudora will not
know which nickname to use. For example, if you have two nicknames, joan and john, you would have to enter 
“joa” or “joh” for Eudora to complete them.

To insert the real addresses for the entry, instead of the nickname, hold down the Shift key and from the Edit 
menu, choose Finish Address Book Entry. To set this to happen all the time, turn on the Automatically 
expand nicknames option in the Miscellaneous options window found in Options under the Tools menu.



Using Central Address Book Files on a Server

You can set up central Address Book files on a server and configure Eudora clients so that they refer to the 
central files.

First, be sure the files are plain text, have a .txt extension, and are formatted as follows: One nickname on 
each line with the real addresses separated by commas, and one line for notes and info with the Notes text 
following the Info data. For example:

alias Wow joe@wow.com,lisa@wow.com,chris@wow.com
note Wow <fax: 222.2223><phone: 222.2222><address:1234 Street>

<name:Wow Inc.>My favorite company

Then, for each client application, add an ExtraNicknameDirs entry to the [Settings] section of the Eudora.ini 
file. This entry should be followed by the list of directories that contain Address Book files, separated by 
semicolons (;). Any Address Book files located in those directories are added to the Address Book. Users will 
need to exit and re-open Eudora to see the new entries.



Using Address Book Files Not Created by Eudora

To use an Address Book file that was not created in Eudora, put the file in the Nickname directory (in your 
Eudora directory), and be sure the format is as shown in Using Central Address Book Files on a Server . You 
will need to exit and reopen Eudora to see your new entries in the Address Book.



Using the Quick Recipient List 

The Quick Recipient List is your list of recipients to whom you often send mail.

To add a nickname to the Quick Recipient List, do the following:

1. From the Tools menu, choose Address book. Or, if the Address book window is an inactive window in a 
visible tabbed window group, click its tab.

2. Select the desired entry in the list on the left by clicking once on the item; right-click the item. 

3. From the pop-up menu, choose Add to Recipient List. The entry’s nickname is added to the Quick 
Recipient List, and the entry is bolded in the Address Book list.

To add an e-mail address to the Quick Recipient List, select the text that makes up the full address. Then, from 
the Special menu, choose Add as Recipient.

To remove an entry from the list, do the following:

1. Open the Address Book.

2. Select the desired entry in the list on the left by clicking once on the item; right-click the item 

3. From the pop-up menu, choose Remove From Recipient List. The entry’s nickname is removed from the 
Quick Recipient List, and the entry is unbolded in the Address Book list. Or, select the item you wish to 
remove from the Remove Recipient submenu under the Special menu.

To open a new message addressed to someone on your Quick Recipient List, do the following:

1. From the Message menu, choose New Message To, Forward To, or Redirect To. 

2. Select the nickname from the displayed list.

To insert a recipient into a message that you have already opened, put the cursor where you want the recipient 
and select the recipient from the Insert Recipient submenu under the Edit menu.

To insert the real address(es), instead of a nickname, hold down the Shift key and select the recipient from the 
Insert Recipient submenu under the Edit menu. To set this to happen all the time, turn on the Automatically 
expand nicknames option in the Miscellaneous options window found in Options under the Tools menu.

More than one recipient from the Quick Recipient List can be added to the To, Cc, and Bcc fields of any 
message. If you use the Insert Recipient submenu, commas are added where necessary.



Opening Directory Services

Eudora lets you look individuals up on the Internet, within your company, and in your Eudora Address Book (if 
you have one set up) using four directory service protocols: Ph, Finger, LDAP (Lightweight Directory Access 
Protocol), and Eudora Address Book.

To use directory services to look someone up, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 
window in a visible tabbed window group, click its tab. (See Window States and Tabbed Windows for more 
information on tabbed windows.)

The directory service protocols available to you for your search are listed in the Protocols section of the 
window. See Directory Service Protocols for more information.

The databases you can use to look up your target individual are listed in the Databases list. For more details, 
see Directory Service Databases , Creating a New Database , Modifying an Existing Database , and Deleting a 
Database .

To resize the left and right halves of the window relative to each other, drag the vertical separator bar to the left 
or right.



Keeping the Directory Services Window on Top

To keep the Directory Services window on top so that you can easily continue using it, turn on the Keep On 
Top option. Eudora remembers the state of this option when you quit and restart the program.

Note: The behavior of this option is subject to the restrictions in Window State Considerations .



Looking Someone Up (Making a Query)

To look someone up on the Internet, within your company, or in your Eudora Address Book, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 
window in a visible tabbed window group, click its tab.

2. In the Databases list, select the database(s) you want to search in your query.

3. To select a database, click the checkbox to the left of the database until a checkmark appears in the box. You 
can select multiple databases, and you can use multiple protocols. You must select at least one database in the
list in order for Eudora to perform the query. 

Note: Eudora remembers which databases you’ve selected when you quit and restart the program.

5. In the Query field, type a text string you want to search against.

If one or more of your selected databases use a protocol other than Ph, your entry in this field will always 
be interpreted as a name. If you only have Ph servers selected as your databases, you can enter any 
commands that Ph will interpret.

6. After you’ve typed the text, start the query by pressing Enter or clicking the Start button.

The query begins, and the Start button changes to Stop.

7. To stop the query before it is completed, click the Stop button.

When the query is completed, or if you click Stop to cancel the query, the Stop button changes back to Start.



Reading Your Query Results

Your query results are listed in the left half of the Directory Services window, in the results list (top view) and the
details pane (bottom view). You can resize the two views relative to each other using the separator between 
them; drag the separator up or down.

The results list consists of one-line summaries of the “hits” or successful targets of your query. These are listed 
by four columns: Name, Email, Phone, and Database. Name indicates the username (or other name) of the 
target. Email is the e-mail address of the target. Phone is the target’s telephone number. Database tells you in 
which of your selected databases the target was found.

Click a column header to sort the results list alphabetically (or numerically) by that column. Shift-click to sort in 
reverse order.

To resize the columns, drag the divider line to the right of the desired column to the left or right. Note that the 
columns resize dynamically during a query, to accommodate the width of each target’s data.

The Status field displays the status of your query (such as Ready, Connecting, Getting Data, etc.) and the 
number of items found as shown in your summary list. This number is updated dynamically until the query is 
complete or you stop it.

If the results list does not fit in the available viewing space, scroll bars appear to let you navigate through the 
remaining part of the list.

To view the details of a result in the details pane, select the result in the results list by clicking once on it. The 
full data appears in the details pane. If nothing is selected in the results list, the details pane is blank. If multiple 
summaries are selected in the results list, the details pane lists the details for each item, with each item 
separated by a divider line.

To select multiple items in the results list, use the Shift key to select a continuous range, and use the Ctrl key 
to make disjoint selections.

Scroll bars appear in the details pane if the displayed information cannot fit in the viewing space.



Addressing a Message from the Directory Services Window

You can create and address a message with the query results in the Directory Services window.

To create a new message, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 
window in a visible tabbed window group, click its tab.

2. Make sure there are no outgoing messages open. 

3. Perform your query. 

4. Select one or more summaries in your results list. 

5. Click the To, Cc, or Bcc button. A new message is created, and it is addressed appropriately with the 
selected query results.

To add an address to an existing message, make sure the message you want to address is active, open the 
Directory Services window, perform the query, and select one or more summaries in the results list. Now click 
the To, Cc, or Bcc button. The addresses from the selected query results are added to the appropriate field of 
the current message.

Note: The behavior of the To, Cc, and Bcc buttons is subject to the restrictions in Window State 
Considerations .



Making an Address Book Entry from Your Query Results

You can make a nickname from your query results in the Directory Services window and add the entry to your 
Address Book.

To make a nickname, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 
window in a visible tabbed window group, click its tab.

2. Perform a query. 

3. Select one or more summaries in the results list. 

4. From the Special menu, choose Make Address Book Entry. The Make Address Book Entry dialog is 
displayed so that you can name the nickname. The real name and e-mail address for each selected query 
result is included in the new entry. 

Note: The use of this command from this window is subject to the restrictions in Window State 
Considerations .



Printing Your Query Results

You can print, and preview for printing, the results of your query as shown in the details pane.

To print your query results, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 
window in a visible tabbed window group, click its tab.

2. Perform your query.

3. Select one or more summaries in the results list. The details pane lists the details of each selected item, 
with each item’s details separated by a divider line.

4. To preview your query details for printing, from the File menu, choose Print Preview. The Print Preview 
dialog is displayed, showing how the query details will look when printed.

5. To print your query details, from the File menu, choose Print.

Note: The use of this command from this window is subject to the restrictions in Window State 
Considerations .



Window State Considerations

The behavior of some Eudora features internal and external to the Directory Services window depends on the 
state of the window. For definitions of window states, see Window States and Tabbed Windows.

When the Directory Services window is in the docked or floating state (either alone or as part of a tabbed 
window group), the following applies:

• The Keep on top setting in the window is ignored.

• The To, Cc, and Bcc buttons in the window apply to the topmost composition window, if any.

• The Special menu Make Address Book Entry command, and the File menu Print Preview and Print 
commands, apply to the Directory Services window only if the keyboard focus is in that window.

When the Directory Services window is in the normal state (either alone or as part of a tabbed window group), 
the following applies:

• The Keep on top setting in the window is obeyed.

• The To, Cc, and Bcc buttons in the window apply to the composition window, if any, immediately under the 
Directory Services window or the tabbed window containing it.

• The Special menu Make Address Book Entry command, and the File menu Print Preview and Print 
commands, apply to the Directory Services window only if it is the topmost normal window and is active, or if
the tabbed window containing it is the topmost normal window and the Directory Services tab is active.



Directory Service Protocols

The Protocols section of the Directory Services window lists the directory service protocols available to you 
that you can use when creating and modifying databases for looking up individuals via these services.

Eudora comes with four protocols installed by default: Ph, Finger, LDAP (Lightweight Directory Access 
Protocol), and Eudora Address Book.

Note: The Eudora Address Book protocol does not appear in the list until you have created an Address 
Book in Eudora.

To sort the protocols alphabetically, click the column heading (Registered Drivers). Shift-click the column 
heading to sort in reverse order.

You can resize the column by dragging the divider line to the right of the column heading to the left or right.

The use of the New Database button, shown in this section of the window, is described in Creating a New 
Database .



Directory Service Databases

The Databases section of the Directory Services window lists the databases that are available to you for 
searching for individuals over the Internet, within your company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

• ldap.bigfoot.com

• ldap.switchboard.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com

• Eudora Nicknames [or the name of your nicknames file; this last item appears only if you have a Eudora 
Address Book set up]

You can modify or delete these databases, and you can also create new databases and modify and delete 
them. 

You use the databases in this list to perform your lookup queries. To perform a query, you must first select one 
or more databases in the list. To select a database, click the checkbox to the left of the database name, until a 
checkmark appears in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list by that column, alphabetically. Shift-click the column heading to sort in 
reverse order.

To resize columns, position the mouse pointer over the divider line to the right of the desired column, and drag 
the line to the left or right.

The use of the Modify button in this section of the window is described in Modifying an Existing Database . The
use of the Delete button is described in Deleting a Database .



Creating a New Database

In addition to the default directory service databases that already come configured with Eudora, you can create 
new Ph, Finger, and LDAP databases for your Directory Services queries. Databases are created from the 
Protocols section of the window, and they must be created using one of these three listed protocols.

Note: You cannot create a new database using the Eudora Address Book protocol in the list. Nickname 
files must be created from the Address Book window. See Using the Address Book for more details.

To create a new database in Directory Services, do the following:

1. From the Tools menu, choose Directory Services. Or, if the Directory Services window is an inactive 
window in a visible tabbed window group, click its tab.

2. In the Protocols list, click the desired protocol to select it.

3. Click New Database. Or, just double-click the protocol in the Protocols list. The New Database dialog is 
displayed. This dialog will differ depending on the protocol you’ve selected.

4. Fill out the fields of the dialog and 

5. Click OK to save your entries and close the dialog, or click Apply to save your entries without closing the 
dialog. The new database is added to the Databases list and is given a checkbox so that you can select 
the database for a query. If you chose to Apply, the dialog remains open and you can make additional 
changes.

To create a Ph database, do the following: 

1. In the General window, enter the Server name, the Host name, and the Port. 

2. In the Attributes window, click Add to add an attribute to the attributes list. Attributes determine what is 
listed in the columns of the results list and must be tied to a valid attribute name, corresponding to one of 
the column headings in the results list. To edit an attribute, click the attribute in the list and click the Edit 
button, then edit the attribute name. To remove an attribute, click it to select it and then click the Remove 
button. 

3. When you are finished making entries to the New Database dialog, click OK to create your new Ph 
database. The database is added to the Databases list with its checkbox.

To create a Finger database, do the following: 

1. In the General window, enter the Server name, the Host name, and the Port.

2. Click OK to create the new Finger database.

To create an LDAP database, do the following: 

1. In the Network window, enter the Server name, the Host Name, and the Port. 

2. If you turn on the This server requires me to log on option, then enter an Account name and a 
Password. 

3. In the Attributes window, add, edit, or remove attributes using the buttons. Attributes determine how your 
query results are listed in the results list. Key the attributes to the column heading names in the results list. 



4. In the Search Options window, specify the Search timeout, the Maximum number of matches to return 
(or turn on the No Limit option to specify unlimited matches), and the Search Base. 

5. In the Log window, specify whether you want to generate log files and if so, how to store them; specify 
whether you want to enable logs for Protocol interactions and/or a Configuration data load/store; enter 
a Log file name or select one using the Browse button and turn on the Overwrite existing log file option 
if you want new logs to replace the old ones. 

6. When all your information is entered in the New Database dialog, click OK and your new LDAP database is
created with its checkbox.



Modifying an Existing Database

You can modify any Ph, Finger, or LDAP database in your Databases list.

Note: You cannot modify a Eudora Address Book database from the Directory Services window, but you 
can view the path where the file is stored. Nickname files must be modified from the Address Book. 
See Using the Address Book for more details.

To modify an existing database, do the following:

1. Open the Directory Services window.

2. Click the database name or icon in the Databases list to select it.

3. Click Modify. Or, just double-click the database in the list. The Modify Database dialog is displayed with    
its fields pre-filled in with the information from the selected database.

Note: You can only modify one database at a time. Multiple selections disable the modify feature.

3.        Make your changes in the Modify Database dialog and click OK to save the changes and close the dialog,
or click Apply to save the changes and leave the dialog open. You can then make additional changes and 
save or discard them.

The Modify Database dialog will differ depending on the protocol you’ve selected. For details on the fields of 
the different dialogs, see Creating a New Database .

Note: If you attempt to modify a Eudora Address Book database, the Modify Database dialog merely 
displays the path where the address book file is stored.



Deleting a Database

To delete a database, do the following:

1. Open the Directory Services window.

2. Click the database name or icon in the Databases list to highlight the item.

3. click the Delete button. You are prompted to confirm the delete. Click Yes and the database is removed 
from the list. Click No and the deletion is canceled, and the database remains.

You can delete multiple databases at once; use the Shift key to select a range in the list, and use the Ctrl key to
select items disjointly.



Printing

You can print the current message or messages, a plain text window, selected text within a message or text 
window, the contents of the Directory Services window, and your filters. Eudora automatically prints headers 
and footers on each page, giving the window title, page number, and your return address.

To print the current message or item, choose Print from the File menu. 



Plugins (Extended Messaging Services)

Plug-ins are special add-ons that can be installed to add features to Eudora. For example, you could use a 
language conversion plug-in to translate a message to another language, a security plug-in to automatically 
secure a message, or a text manipulation plugin to change lowercase to uppercase. Plug-ins interface to 
Eudora using the Extended Messaging Services Application Programming Interface (EMSAPI). 

• To make plug-ins available to Eudora, put them in the Plugins directory in your Eudora Pro directory, then 
restart Eudora. Depending on the plug-in type, it will be available in Eudora through the following methods:

- The Message Plugins submenu (in the Edit menu) typically includes plug-ins that are used to modify the
text of a message. These are referred to as on-request plug-ins. Some samples of these types of plug-
ins are available with Eudora: Sort, UpperLower, and Unwrap.

- Icons in the message window are typically for plug-ins that are used to manipulate messages as they are
sent or when they are received. These are referred to as on-transmission and on-display plug-ins.

- The Tools menu typically includes plug-ins that are used to do tasks that are not directly related to 
Eudora functions. These are referred to as tools plug-ins.

- The Attach [to New] submenu (in the Message menu) typically includes plug-ins that are used to create 
and attach particular files to a message. These are referred to as attachment plug-ins.

- Plug-ins that are automatically used when a message is received are not available through the user 
interface.

• To see all of your currently installed plug-ins, choose Message Plugins Settings from the Special menu. If a
plug-in has any settings options, you can use the Settings button to change them. 

For information about available plug-ins, send e-mail to <eudora-rep@eudora.com> or visit the World Wide 
Web site <http://www.eudora.com/>.



Messaging Application Program Interface (MAPI)

MAPI is an interface that lets you send e-mail messages from any MAPI-compatible application, such as your 
word processor, spreadsheet, graphics application, etc.

MAPI-compatible applications have a Send or Send Mail option in the File menu. When you select the option, 
the Eudora MAPI server displays a new outgoing message with your current document attached. All you need 
to do is address the message, type any details you want to include in the body of the message, and click Send 
or Queue.

• To run the Eudora MAPI server, use the MAPI options window. To display the MAPI options window , choose
Options from the Tools menu and click the MAPI icon.

You have several options in the MAPI options window for loading the Eudora MAPI server. You can set it to 
always run or to run only when Eudora is running, or you can specify that it never run. These three options 
open or exit the server as soon as you select them.

Note: When you are running the Eudora MAPI server, Microsoft Exchange will not work. If you need to use 
Exchange, turn off the Eudora server. 

See the Eudora Reference Manual for technical details on the Eudora MAPI server.

Also, you have several options for saving or deleting MAPI attachments. When you use MAPI to attach a file 
and send a message, that file is immediately copied into the Attach directory (or a directory you have specified).
You can use the MAPI options to save those copies, delete them after sending their corresponding messages, 
or delete them after their messages are emptied from the trash.



Modifiers

Many operations in Eudora can be implemented by holding down one or more modifier keys. Eudora uses the 
Shift, Ctrl, and Alt keys as modifiers.

Shift + Check Mail or Send Queued Messages
Display the Mail Transfer options window to define the interaction with your POP 
account.

Shift + Queue/Send Open the Change Queuing dialog.

Shift + New message command
Display the Message Options dialog to select a personality and stationery for the 
new message.

Shift + Open an incoming message
Opens the message with all headers displayed.

Shift + Insert Recipient Insert the address(es) instead of the nickname.

Shift + Ctrl + , or Shift + Finish Address Book Entry
Finish the Address Book entry with the address(es) instead of the nickname.

Shift + Sort command Sort in ascending order.

Shift + Transfer Put a copy of the current message in the selected mailbox and leave the original 
where it is.

Shift + Copy Copies the selected text without the carriage returns (copy unwrapped).

Shift + Paste or Shift + Paste as quotation
Paste the selection as plain text (do not paste the style information).

Shift + Wrap Selection Removes the carriage returns from the selected text (unwraps).

Shift + Exit Sets all open windows to open again when Eudora is next started.

Shift + Save Saves changes to all open windows.

Shift + Close Closes all open windows.

Alt + k Turn on Keep on top in the Directory Services window.



Shortcuts

The keyboard shortcuts for Eudora functions are as follows:

Ctrl + 0 Open Out mailbox
Ctrl + 1 Open In mailbox
Ctrl + 6 Check Spelling
Ctrl + ' Paste as quotation
Ctrl + , Finish nickname
Ctrl + A Select all
Ctrl + B Make the selected text bold
Ctrl + C Copy
Ctrl + D Delete
Ctrl + E Send or Queue
Ctrl + F Find dialog
Ctrl + H Attach document
Ctrl + I Make the selected text italic
Ctrl + J Filter messages
Ctrl + K Make nickname
Ctrl + L Address Book
Ctrl + M Check mail
Ctrl + N New message
Ctrl + O Open file
Ctrl + P Print
Ctrl + Q Exit Eudora
Ctrl + R Reply
Ctrl + S Save
Ctrl + T Send queued messages
Ctrl + U Make the selected text underlined
Ctrl + V Paste
Ctrl + W Close message
Ctrl + X Cut
Ctrl + Y Directory Services
Ctrl + Z Undo

arrows Move from one message to another in a mailbox (depends on your Miscellaneous 
Options ). 

enter Select the outlined button in any dialog, alert, or window, or open the selected 
messages or URL.

esc Stop any operation currently in progress.
F1 Display Help.
page up, page down Scroll up or down through the window.
F6 Toggles the cursor position between the left and right window panes in the Filters 

dialog and the Address Book.



Using the Eudora Taskbar

The Eudora taskbar appears along the bottom edge of the window work area in the main Eudora window, and 
normally shows the QUALCOMM logo at the right.

The Eudora taskbar displays a button for each normal Eudora window that is open or minimized. The taskbar 
provides a convenient way to switch between normal windows by clicking buttons, without having to display the 
different windows from the Window menu.

The Eudora taskbar is modeled after the Windows 95 and Windows NT 4.0 system taskbars, which usually 
appear at the bottom of the screen, but there are important differences, noted below.

To show or hide the Eudora taskbar, do the following: 

1. From the Tools menu,    choose Options to open the Options dialog. 

2. Scroll and select Display.    The Display options window is displayed.

3. Check or uncheck the Show MDI task bar box to turn the option on or off.

Any normal Eudora window that is open or minimized is represented by a button on the taskbar. This includes 
composition messages, received messages, mailbox windows, and any tool windows or tabbed windows that 
are in the normal state. Any open tool or tabbed windows that are in the docked or floating state are not 
represented as buttons on the taskbar.

If a tabbed window is represented by a button on the taskbar, the button shows the name and icon associated 
with the active tool window in that tabbed window.

Click a taskbar button to make that normal window active. The window comes to the front of the stack of all 
normal Eudora windows.

If you right-click a taskbar button, the standard Windows context menu displays, letting you Restore, Minimize, 
Maximize, or Close that normal window.

If you right-click an exposed area of the taskbar (not on a button), the standard Eudora context menu displays.

If you drag an object over a taskbar button and pause for several seconds, Eudora activates the normal window
associated with that button. For a tabbed window, Eudora activates the tabbed window with the indicated 
window active. You can then complete the drag and drop operation into the normal window. For a tabbed 
window, you can further pause the pointer over one of the inactive window tabs, and that window becomes 
active and you can complete the drop.

Each taskbar button displays both the window icon and the window title of the normal window. If there is not 
enough room to display the entire title, Eudora truncates the title and places an ellipsis (...) to indicate the 
truncation. If you pause the mouse pointer over such a button, Eudora displays the entire window title in a 
tooltip.

If you have many normal windows open or minimized, the taskbar buttons shrink so that all buttons are visible. 
When the bar gets sufficiently crowded, the QUALCOMM logo is hidden to make room.

Note that, unlike with the Windows 95 and Windows NT 4.0 taskbars, you cannot move the Eudora taskbar to 
another edge of the main Eudora window; it always stays at the bottom of the window work area. You also 



cannot resize the taskbar as a separate item. It resizes automatically, however, when you resize the main 
Eudora window.



Reporting Bugs

If you experience something you think might be a bug in Eudora, please report it by sending a message to 
<win-eudora-bugs@qualcomm.com>. Describe what you did, what happened, what version of Eudora you 
have, any error messages Eudora gave (the numbers in ()'s are especially important), what kind of computer 
you have, which operating system you're using, and anything else you think might be relevant.

You will receive an automated response indicating that your bug report has been received and forwarded to our
engineering staff. Unless additional information is needed, you will not receive a direct response.



Suggestions

From time to time, everyone comes up with an idea for something they'd like their software to do differently. 
This is true of all applications, no less Eudora. If you come across an idea that you think might make a nice 
enhancement to Eudora, your input is always welcome. Please send any suggestions or requests for new 
features to <eudora-suggest@qualcomm.com>.

You will receive an automated response indicating that your suggestion has been received and forwarded to 
our engineering staff. Unless additional information is needed, you will not receive a direct response.



EUDORA.INI Settings File

The EUDORA.INI file is where Eudora keeps most of the settings. It is a standard Windows INI file, and may be
edited with any text editor. 

Note: Since Windows caches information from INI files in memory while the program is running, you should 
never change the EUDORA.INI file while Eudora is in use. If you need to make a change, first quit 
Eudora, then edit the file, and then restart Eudora.

The EUDORA.INI file is divided into a number of sections, the following of which appears by default:

· [Settings]

· [Mappings]

· [Window Position]

· [Tool Bar]

· [DirectoryServices]

· [Debug]

Optional Sections

The following sections will appear in the INI file only when the appropriate conditions are met or the appropriate
items created:

· [Personalities] ¾ The [Personalities] section appears only when you have created alternate e-mail 
accounts (personalities).

· [Stationery] ¾ The [Stationery] section appears only when you have created stationery files.

· [Open Windows] ¾ The [Open Windows] section appears only when there are windows currently open in 
Eudora.

· [WazooBars] ¾ The [WazooBars] section appears only when normal Eudora windows are currently open or
minimized on the desktop (and thus buttons appear on the Eudora taskbar, which is what this section 
controls).

· [Recent File List] ¾ The [Recent File List] section appears only when files have been opened since the 
most recent Eudora startup.

                    NOTE: We strongly urge that you do not change the values in these optional sections of the INI 
file, and rather make any changes from the interface. For example, personalities can be created and 
edited from the Personalities window, and stationery can be created and edited from the Stationery 
window. Both windows are available from the Tools menu.

 The values of the settings in each of these optional sections reflect the current values of    the objects or 
conditions; there are no "default" values per se.

Name and Location of the INI File

The default name is EUDORA.INI and the default location is in the mail directory.    But the name and location 



can be changed.

To specify a different INI file from the EUDORA.INI that is not in the mail directory, add a second parameter to 
the command line in the Program Item for Eudora, e.g.

Command Line: c:\apps\eudora.exe c:\mymail c:\inis\myeudora.ini

To use a different INI file that is in the mail directory:

Command Line: c:\apps\eudora.exe c:\mymail myeudora.ini
Command Line: c:\apps\eudora.exe c:\mymail\myeudora.ini

This is a way to have multiple settings for one set of mailboxes, nicknames, etc.    For example, you may have 
multiple e-mail accounts in which you receive mail, but want to collect mail from all of the accounts in one place.
You could set up separate Program Items for each account (each having a different INI file on the command 
line), and switching between accounts would be as simple as double-clicking on a Program Item.

And for an even more tricky specification, if the first parameter is an INI filename without a path, then the mail 
directory is searched through the normal process of checking the EUDORA environment variable and then 
using the executable directory.

Examples:

SET EUDORA=c:\mymail
Command Line: c:\apps\eudora.exe myeudora.ini

will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

SET EUDORA=myeudora.ini
Command Line: c:\apps\eudora.exe

will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Default INI file

When an entry in the EUDORA.INI file is not found, Eudora will look in the DEUDORA.INI file located in the 
same directory as the EUDORA.EXE file. The [Mappings] section of the DEUDORA.INI file acts as though it 
was appended to the end of the [Mappings] section of the EUDORA.INI file.

Examples:

                    SET EUDORA=c:\mymail

                    Command Line: c:\apps\eudora.exe myeudora.ini

                    will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

                    SET EUDORA=myeudora.ini

                    Command Line: c:\apps\eudora.exe

                    will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

[SETTINGS]



Entry Default 
Value 

Description

AllowDefPlugins 1 Controls whether or not EMSAPI plug-ins can be 
automatically added to the toolbar.

AltClickMoveSummary 1 When you hold down the <Alt> key while clicking on an 
item in a mailbox, all messages in that mailbox with the 
same item are selected (e.g. <Alt> clicking on a subject 
will select all messages in that mailbox with the same 
subject).    If this switch is on, then the selected 
messages will be grouped together as well.    You can 
temporarily turn this off by holding down the <Shift> key
while doing the <Alt> click.

BadPasswordString When the POP server returns an error on sending the 
PASS command, the password will only be erased when 
the error response includes this text. 

BlackTocLines 0 If on, and displaying lines is mailboxes, draw lines as 
black instead of gray.

CenterUnreadStatus 1 When on (1), centers the bitmap in Mailbox menu items 
that indicate that the mailbox has unread messages. If 
the display of this bitmap is not correct, turn this switch 
off (0). 

CheckOwnerFreq 0 How often (in seconds) Eudora should check the 
OWNER.LOK file to see if another instance of Eudora has 
been started on the same set of mailboxes.

CompactDisk% 5 What the amount of "wasted space" taken up by deleted 
messages in a mailbox as a percentage of total free disk 
space must be before the mailbox automatically gets 
compacted when closed. 

CompactMailbox% 50 What the percentage of "wasted space" taken up by 
deleted messages in a mailbox must be before the 
mailbox automatically gets compacted when closed. 

CompSummaryItalic 1 In mailboxes other than the Out mailbox, display the 
summaries of outgoing messages in italics. 

Craig 0 Whether or not by default Eudora should do the red-
wavy-line type of spell checking as opposed to normal 
spell checking.    If this setting is off (set to 0), then you 
can get the red-wavy-line type of spell checking by 
holding down the Shift key while initiating a spell check.   
Way to go Mr. Lauer!

EnrichedSoftLine 72 Number of characters sent on a line before adding a soft 
newline when sending styled text. 

EudoraPassPort 106 Default port number for the Eudora password-changing 
service (epass). 

ExcerptBars 2 HTML style sheet parameter for excerpt bars.    Can use 
this to change the width, color, and style of excerpt bars.
(Only works when using the Microsoft viewer).

ExtraHeaders Extra headers that are sent with each outgoing message.



If multiple headers are to be sent, separate each with "\r\
n".
For example,
"ExtraHeaders=X-Header1: foo\r\nX-Header2: bar". 

ExtraNicknameDirs List of directories to search for additional nickname files. 
Multiple directories can be entered, separated by 
semicolons (;). 

FilterFromFolder When doing a Make Filter, the name of the mailbox folder
to place the default named mailbox that is created when 
filtering based on whom the message is from.

FilterRecipFolder When doing a Make Filter, the name of the mailbox folder
to place the default named mailbox that is created when 
filtering based on whom the message is to.

FilterSubjectFolder When doing a Make Filter, the name of the mailbox folder
to place the default named mailbox that is created when 
filtering based on the subject of the message.

FindMatchCase 0 "Match Case" checkbox in the Find dialog. 

FindSummariesOnly 0 "Summaries Only" checkbox in the Find dialog. 

FirstUnreadNormal 1 When checking mail on a POP server, download any mail 
that hasn’t been retrieved at this machine.

FirstUnreadStatus 0 When checking mail on a POP server, download only 
messages that haven’t been read on any machine.

FixCurlyQuotes 1 If on, then if a message contains 7-bit characters except 
for directional quotes, then those directional quotes are 
turned in to regular non-directional quotes so that the 
message may be sent out as 7-bit (no quoted-printable 
encoding needed).

GuessParagraphs 0 "Guess Paragraphs" checkbox in the Save As... dialog. 

IdleTime 60 The number of seconds that Eudora has to be idle before 
it will consider performing an automatic mail check. 

IMAPPreviewPane 1 Controls whether or not IMAP mailboxes have a preview 
pane.    On slower networks, it may be desirable to turn 
off the preview pane for IMAP mailboxes, but still have 
the preview pane for local mailboxes.    You can do that 
by keeping the normal Preview Pane option turned on, 
but turning this setting off (setting to 0).

IncludeHeaders 0 "Include Headers" checkbox in the Save As... dialog. 

KerberosSetUserName 0 Uses KClient SetUserName() function to set user name in
Kerberos system. Turning this switch on may cause 
Kerberos tickets to be invalidated. 

LastSettingsCategory 0 Last category that was displayed in the Options dialog. 

LexPath Directory in which the dictionary files for spell checking 
reside. 



MainLexFiles Main dictionary files. British dictionaries can be used by 
changing this to sscebrc.tlx, sscebrm.clx, ssceamc.tlx, 
ssceamm.clx 

MainWindowState 1 The state of the Main Window (normal = 1, minimized = 
2, or maximized = 3). The state is set when Eudora 
closes, and the Main Window is set to this state the next 
time Eudora starts up. 

NetworkOpenTimeout 60 The number of seconds Eudora will wait for a response to
opening a connection before it gives up. 

NoAutoSendPrecedence list,bulk When filtering incoming messages with precedence 
headers of list or bulk, do not automatically create new 
outgoing messages. 

NoSplashScreen 0 If on, the opening splash screen will not be displayed. 

OwnerLok 1 If this is non-zero, an OWNER.LOK file will be created on 
startup which helps to prevent possible corruption if 
multiple instances of Eudora are used on the same set of
mailboxes.

PhReturn A string that is appended to every Ph command before 
sending to the Ph server. For example, "PhReturn=return 
all" would return all fields of the records returned by the 
query, and "PhReturn=type=person" would return all 
matches to the query with the additional filter that the 
record is a person. 

POPPort 110 Default port number for the POP service (pop3). 

PreviewHeaders To:,Subject:,Cc
:

A comma-separated list of headers that should be shown
in the preview pane.    The matching is done on a prefix 
basis, so any header that begins with one of these values
will be shown.

PreviewSplitterPos 0 If non-zero, then if a mailbox hasn’t already specified a 
position for the splitter between the message list and the
preview pane, then the splitter will be positioned this 
many pixels from the top of the mailbox window.

PreviewTableEnd </table>\r\n HTML markup for the end of the table that’s used to 
display the headers in a preview pane.

PreviewTableRowEnd </td></tr>\r\
n

HTML markup for the end of the table row that’s used to 
display the headers in a preview pane.    Each header is 
displayed in a separate row of the table.

PreviewTableRowStart <tr bgcolor=
%s text=
%s><td>\r\n

HTML markup for the start of the table row that’s used to
display the headers in a preview pane.    Each header is 
displayed in a separate row of the table.

PreviewTableStart <table 
cellspacing=
0 
cellpadding=0
width=100%%
bgcolor=%s 

HTML markup for the beginning of the table that’s used 
to display the headers in a preview pane.



text=%s>\r\n
PrintHeaders 1 When on (1), printed messages get headers and footers. 

QuoteEnd The string that gets inserted after the original text of a 
forwarded message. A newline is added before the 
string. 

QuotePrefix > The string that precedes all lines of the original message 
in a forwarded message 

QuoteStart The string that gets inserted before the original text of a 
forwarded message. A newline is added after the string. 

ReadMessageStyleSheet <STYLE 
TYPE=""text/c
ss"">\r\
n{font-family 
= ""%s""}\r\
nTT {font-
family = 
""%s""}\r\
nBLOCKQUOT
E.CITE 
{border-
left = solid 
%s}\r\
nBLOCKQUOT
E.CITE 
{padding-left 
= 0.5em}\r\
nBLOCKQUOT
E.CITE {m
argin-left = 
0}\r\
nBLOCKQUOT
E.CITE 
{margin-top =
0.5em}\r\n

HTML style sheet used for displaying received messages.

ReadRecieptAsk 1 Ask user for read receipts. 

ReadRecieptNo 0 Always deny read receipts without prompting. 

ReadRecieptYes 0 Always return read receipts without prompting. 

ReplyAllAttribution At %1, %2
you wrote: 

Attribution line when a Reply to All is done. 

ReplyAttribution At %1, you 
wrote: 

Attribution line when a Reply is done. 

ReplyEnd The string that gets inserted after the original text of a 
replied message. A newline is added before the string. 



ReplyPrefix > The string that precedes all lines of the original message 
in a replied message 

ReplyStart The string that gets inserted before the original text of a 
replied message. A newline is added after the string. 

ReturnAddressFormat %1 < %2> Format of the From: field in outgoing messages. %1 is 
the Real name, and %2 is the Return address. 

SaveDialupPasswordText Where your dialup password is saved (in an encrypted 
format) if you have the Save Password switch turned on. 

SavePasswordText Where your POP password is saved (in an encrypted 
format) if you have the Save Password switch turned on. 

SendXAttachHeader 0 Do not send the full path to attachments in the X-
Attachments header. 

ShowAttachmentIcons 1 Show attachments as icons in messages.

ShowProgress 1 Show/hide the Progress window. 

ShowProgressInactive 0 If Eudora is not the foreground application, this controls 
whether the Progress window should be shown or not.

SMTPPort 25 Default port number for the SMTP service (smtp). 

SMTPRecipientWrap 72 Column at which recipient headers (To: and Cc:) are 
wrapped when sending a message. 

StationerySignatureRules 1 Signature precedence is as follows: User's selection; 
Stationery's signature; Personality's signature. Set this to
0 to put Personality's signature before Stationery's. 

SwitchPreviewWithTab 1 When on, pressing the <Tab> key in a mailbox will switch
focus between the message list and the previewed 
message.

TabooHeaders X-
UID,Received,
Status,X-
UIDL,Message,
In-
Reply,X-
Priority,Mime-
Version,Conte
nt-
,X-

A comma-separated list of headers (without colons) that 
should not be shown when the "Show all headers" switch
(the "Blah Blah Blah" icon) is off for a message. The 
matching is done on a prefix basis, so any header that 
begins with one of these values will not be shown. 



Persona,Resen
t-
Message,Refer
en
es,Return,X40
0,X-
400,Mail-
System,Errors-
To,X-
List,Delivery,D
isposi
tion,X-
Juno,Preceden
ce,
X-
Attachments,X
-
MSMail,X-
MimeOLE

TabSpaces 0 If on, then when the Tab key is pressed while the cursor 
is in the body of the message, spaces are inserted 
instead of a tab character. 

TabStop 8 How many spaces to insert for a <Tab> in the body of a 
composition message. 

TocDateLeeway 2 Number of seconds that the date on a mailbox .TOC file 
can be behind the .MBX file that Eudora will not flag as 
being out of date. Helpful for network file systems, 
especially Windows NT Server which seems to have 
problems correctly time/date stamping files. 

UnreadExpires 5 The number of days after which a message is no longer 
used to determine if a mailbox has unread messages in 
it. 

URLHelper The full path of the application used to launch URLs. 

URLHighlight 1 Display URLs in blue underline style. 

UsePOPSend 0 If UsePOPSend is on, Eudora will send mail using the 
POP3 extended command XTND XMIT. Since this is an 
optional command for POP3, many POP3 servers do not 
support this command (Berkeley's popper, however, 
does). There are pros and cons to using POP3 to send 
your mail. It provides a level of security since it requires 
a username/password pair to send mail messages, unlike
SMTP. It is faster than SMTP, especially when checking 
for new mail at the same time. It doesn't check for valid 
recipients until the entire message is sent, and some 
implementations (Berkeley's popper, for example) won't 
tell you which recipients are invalid and will send the 
message to the valid recipients anyway. 

UserChangeLex uchange.tlx Filename of user-defined list of words to change when 
spell checking. 



UserIgnoreLex uignore.tlx Filename of user-defined list of words to ignore when 
spell checking. 

UserSuggestLex usuggest.tlx Filename of user-defined list of words to suggest when 
spell checking. 

WordWrapColumn 76 When the "Word wrap" switch is on, this is the column in 
which lines in outgoing messages are wrapped. 

WordWrapMax 80 When the "Word wrap" switch is on, this is the length at 
which a line in an outgoing message is considered too 
long and must be wrapped. 

WordWrapOnScreen 0 If this is on (set to non-zero), then the composition 
window will automatically wrap text on the screen at the 
number of characters specified in WordWrapColumn, 
regardless of the width of the window.

[Mappings]

This is a sample [Mappings] section. It is not a default for Eudora if you have a missing or empty [Mappings] 
section. The [Mappings] section contains information for mapping between PC file extensions, Macintosh 
creator and type, and MIME type and subtype for attachment files (in that order). Entries marked "in" work on 
only incoming messages, and entries marked "out" work on only outgoing messages. Entries marked "both" 
work on both incoming and outgoing messages.
For a more detailed explanation, see the "MIME and Mappings" section of the Eudora Reference Manual.

out=txt,ttxt,TEXT,text,plain
both=doc,MSWD,,application,msword
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=xlc,XCEL,XLC3,,
both=xlm,XCEL,XLM3,,
both=ppt,PPT3,SLD3,,
both=wp,WPC2,.WP5,application,wordperfect5.1
both=zip,,,application,zip
both=rtf,,,application,rtf
both=ps,,,application,postcript
in=eps,,EPSF,,
out=eps,dPro,EPSF,application,postscript
both=mpg,,,video,mpeg
both=jpg,,,image,jpeg
both=gif,,,image,gif
both=tif,,,image,tiff
both=pct,,PICT,,
both=mac,MPNT,PNTG,,



[Window Position]

The [Window Position] section saves the positions of the standard windows (not your mailbox windows and 
message windows).

Entry Default Value 

CheckSpellingWindowPos
ition

0,0,0,0

FindWindowPosition 60,345,580,480

MainWindowPosition 0,0,640,480

ProgressWindowPosition 0,0,0,0

SignatureWindowPosition 10,60,630,240

TextFileWindowPosition 0,0,600,460

[Tool Bar]

This section reflects the current settings of the main Eudora toolbar. If you create additional Eudora toolbars, 
then additional [Tool Bar] sections will appear in the INI file.

Note: We strongly recommend that you do not change any of the settings in the [Tool Bar] section(s) 
of the INI file, and that you instead make any changes to any Eudora toolbar from the toolbar 
customization dialog (Customize dialog). This dialog is accessed by right-clicking anywhere on the 
toolbar and selecting Customize... from the popup menu. For more information, see "Customizing the
Main Toolbar" in the Eudora Reference Manual.

[DirectoryServices]

The [DirectoryServices] section controls the use of the Directory Services window (accessed from Eudora's 
Tools menu) and its associated databases. For more information on Directory Services, see its dedicated 
section in the Eudora User Manual.

Note: Of the entries listed below, only those marked with an asterisk (*) are user-settable.

Entry D
e
f
a
u
l

Description



t
 
V
a
l
u
e
 

OldKeepOnTopConverted What in pre-4.0 versions of Eudora
used to be [Settings] 
AddressKeepForeground is now 
KeepOnTop in this section. 
KeepOnTop saves the check state 
of the "Keep On Top" check button 
in the Directory Services window. 
Eudora uses this entry 
(OldKeepOnTopConverted) to 
determine if the 
AddressKeepForeground entry 
from a pre-4.0 version of Eudora 
has been mapped to the current 
version. When Eudora 4.x is run 
for the first time, it sets the 
KeepOnTop entry (described 
below) equal to the value of 
AddressKeepForeground. In 
addition, it also sets this entry 
equal to 1 so that the next time 
Eudora is run, it reads the check 
state from KeepOnTop rather than 
from AddressKeepForeground. 

PanesY* This entry reflects the height of 
the Directory Services window 
when Eudora was last shut down. 

LeftPaneX* This entry reflects the width of the
left pane of the Directory Services 
window when Eudora was last shut
down. 

RightPaneX* This entry reflects the width of the
right pane of the Directory 
Services window when Eudora was
last shut down. 

KeepOnTop* This entry reflects the check state 
of the "Keep On Top" check button 
in the Directory Services window 
when Eudora was last shut down. 

LDAP:ldap.bigfoot.com* This entry reflects the check state 
of the LDAP database 
"ldap.bigfoot.com" when Eudora 
was last shut down. The check 
state of other LDAP databases is 
reflected in similar entries. 



Ph:ph.bigfoot.com* This entry reflects the check state 
of the Ph database 
"ph.bigfoot.com" when Eudora 
was last shut down. The check 
state of other Ph databases is 
reflected in similar entries. 

Eudora Address 
Book:Eudora Nicknames*

This entry reflects the check state 
of the Eudora Address Book 
database "Eudora Nicknames" 
when Eudora was last shut down. 
The check state of other Eudora 
Address Book databases is 
reflected in similar entries. 

Finger:hostname.domain.
com*

This entry reflects the check state 
of the Finger database 
"hostname.domain.com" when 
Eudora was last shut down. The 
check state of other Finger 
databases (or daemons) is 
reflected in similar entries. 

DIRSERV-Major This entry reflects the major 
version of DirServ.dll that was last 
registered. Combined with the 
minor version of this DLL (see the 
next entry below), Eudora at run 
time determines whether the DLL 
is a newer version than the one 
last registered so that it can 
register the new COM objects, if 
any, in the newer DLL. 

DIRSERV-Minor This entry reflects the minor 
version of DirServ.dll that was last 
registered. See the description 
above for DIRSERV-Major. 

ISOCK-Major This entry reflects the major 
version of ISock.dll that was last 
registered. A similar description as
the one in DIRSERV-Major above 
applies. 

ISOCK-Minor This entry reflects the minor 
version of ISock.dll that was last 
registered. A similar description as
the one in DIRSERV-Major above 
applies. 

EUDORABK-Major This entry reflects the major 
version of EudoraBk.dll that was 
last registered. A similar 



description as the one in DIRSERV-
Major above applies. 

EUDORABK-Minor This entry reflects the minor 
version of EudoraBk.dll that was 
last registered. A similar 
description as the one in DIRSERV-
Major above applies. 

LDAP-Major This entry reflects the major 
version of Ldap.dll that was last 
registered. A similar description as
the one in DIRSERV-Major above 
applies. 

LDAP-Minor This entry reflects the minor 
version of Ldap.dll that was last 
registered. A similar description as
the one in DIRSERV-Major above 
applies. 

PH-Major This entry reflects the major 
version of Ph.dll that was last 
registered. A similar description as
the one in DIRSERV-Major above 
applies. 

PH-Minor This entry reflects the minor 
version of Ph.dll that was last 
registered. A similar description as
the one in DIRSERV-Major above 
applies. 

[Debug]

The [Debug] section controls aspects of the Eudora log file. The Eudora log file is a handy tool for debugging 
network connections, especially when using the dialup connection method.

Entry Default Value Description

LogFileName EUDORA.LOG The name of the log file. 

LogFileSize 100 The size (in KB) of the log file that, when reached, will 
cause the log file to be copied to the file EUDORLOG.OLD 
and a new log file to be started. 

LogLevel 11 (which is bits 
1, 2, and 4)

A bit-mapped value telling what type of information to 
log:
Bit 1 (1): Sending of a message
Bit 2 (2): Receipt of a message



Bit 3 (4): Dialup script navigation commands
Bit 4 (8): Alert messages
Bit 5 (16): Progress messages
Bit 6 (32): All bytes sent
Bit 7 (64): All bytes received 
Bit 8 (128): Corrupt mailbox TOC file messages
Bit 9 (256): Basic EMSAPI translator messages
Bit 10 (512): Advanced EMSAPI translator messages

To get the latest EUDORA.INI file settings, go to the following Web site: 
http://eudora.qualcomm.com/techsupport/ini.html

The EUDORA.INI settings are continuously being updated.                  



Putting Multiple Users on One PC

To have multiple users on one PC, make a separate mail directory and create shortcuts to the Eudora 
executable for each user. The mail directories can be named whatever you like, and put anywhere you like, 
including on floppies or network drives. To tell Eudora which directory to use, specify that directory in the Target 
field of your shortcut.

Specifying a mail directory



Customizing the Toolbar

The Toolbar is a group of buttons that gives you easy access to your frequently used Eudora commands. You 
can create buttons for most Eudora commands. 

· To position the toolbar on the monitor, hold down the left mouse button on the bar itself (not on a button) and
drag it around until you find a place you like. You can dock it to the top or bottom of the Eudora window or 
put it anywhere on your desktop. 

· To add buttons to the toolbar, click the right mouse button somewhere on the toolbar, and choose 
Customize. The Customize Toolbar dialog is displayed. Select a Eudora menu from the list on the left, 
then drag buttons from the list on the right down to the toolbar. 

· To change the placement of a button on the toolbar, hold down the Alt key and drag the button to where you 
want it.

· To remove a button from the toolbar, drag the button off of the toolbar.



Toolbar Categories

Toolbar button categories (These are the same as the Eudora menu commands).



Toolbar Buttons

The toolbar buttons available in the selected category. These are generally the commands that are available 
from that menu item.



Description

A description of the last-selected toolbar button.



Fonts and Color

Displays the Font dialog so that you can change the font, size, style, and color.



Checking Mail Options Window

The Checking Mail Options determine how Eudora checks for and receives incoming mail messages sent to 
your principal e-mail account, or dominant personality.

To display the Checking Mail options window, do the following:

1. From the Tools menu, select Options.

2. Click the Checking Mail icon. The Checking Mail options window is displayed.

Listed below are field descriptions for Checking Mail:

Mail Server ¾ This is the name of your incoming-mail server as entered in the Mail Server (Incoming) field of 
the Getting Started options. See the Getting Started Options Window for more details.

Login Name ¾ This is the login name you entered in the Login Name field of the Getting Started options. See 
the Getting Started Options Window section for more details.

Check for mail every ? minute(s) ¾ If you enter a number greater than zero in this field, then at regular 
intervals, Eudora automatically checks your incoming mail server for new mail and transfers to your PC any 
mail addressed to your primary account. The number you enter here specifies the number of minutes between 
automatic mail-checks. It’s a good idea to set this at no less than 15 minutes. Checking mail more frequently 
puts an unnecessary drain on your incoming mail server. This option only works when Eudora is running. 
Entering 0 in this field turns off automatic mail-checking.

Don’t check when using battery ¾ If this is on and your PC is running on battery power, mail is not 
automatically checked even if automatic mail-checking is on (that is, the Check for mail every ? minute(s) field 
has a number greater than zero in it).

Send on check ¾ If this is on, any messages that are queued in the Out mailbox are sent when a mail-check is
performed, whether the mail-check is automatic or manual. If this is off, messages queued in the Out box are 
not sent during a mail check.

Save password ¾ If this is on, your password is remembered even if you quit and restart Eudora, so you’ll 
never be prompted to enter it. If this is off, you must enter your password each time you quit and restart Eudora.
Only turn this option on if your PC is in a secure place.



Getting Started Options Window

On the Getting Started options window, you can determine the minimum information necessary to send and 
receive mail. The information here is for your “dominant” personality, which is your principal e-mail account.

 For your convenience, some fields appear in more than one category. For example, your return address 
appears in both the Getting Started options window and the Incoming Mail options window. Changing an option 
in one category changes the option in all categories in which it appears.

To display the Getting Started options window, do the following:

1. From the Tools menu, select Options.

2. Click the Getting Started icon. The Getting Started options window is displayed.

Listed below are field descriptions for Getting Started:

Real name—This is the real name assigned to your principal account generally your first and last name. The 
text you enter here is included in the From field of all your outgoing messages from this account, and identifies 
to your recipients who the mail is from.

Return address—This is the return e-mail address used in outgoing messages and recipients’ replies, if this 
address is different from your incoming mail account. The address you enter here is included in the From field 
of all your outgoing messages from this account, and when a recipient replies to a message from this account, 
the reply is sent to this address. If you do not enter an address in this field, Eudora uses your incoming mail 
account as the return address. Incoming mail accounts are usually of the form 
loginname@incomingmailserver. For example, suppose your incoming mail account is 
beatrixp@wabbits.qualcomm.com but your return address is beatrixp@qualcomm.com slightly different. 
You would then enter beatrixp@qualcomm.com in this field.
If you do enter an address in this field, first test the address to be sure that mail sent to it is indeed delivered to 
you. If you use an invalid return address, no one will be able to reply to your mail.

Mail Server (Incoming)—This is the name of the incoming-mail server for your principal e-mail account. All 
incoming messages to your primary account are routed through this server. Use the Incoming Mail options 
window to specify whether this server uses POP (Post Office Protocol) or IMAP (Internet Message Access 
Protocol). A sample server name might be popserver.qualcomm.com.

Login Name—This is the name you use to log in to your primary e-mail account, for accounts that require a 
user login. For example, in the incoming mail account beatrixp@wabbits.qualcomm.com, the login name is 
beatrixp.



Incoming Mail Options Window

The Incoming Mail options determine how Eudora receives incoming messages addressed to your primary e-
mail account. The options configure the incoming mail server, whose name is entered in the Mail Server 
(Incoming) field in the Getting Started Options Window.

To display the Incoming Mail options window, do the following:

1. From the Tools menu, select Options.

2. Click the Incoming Mail icon. The Incoming Mail options window is displayed.

Listed below are field descriptions for Incoming Mail:

Server configuration ¾ Specify which e-mail protocol the incoming mail server uses: POP (Post Office 
Protocol) or IMAP (Internet Message Access Protocol). Ask your e-mail administrator which one to use, if you 
are not sure.

The options in the rest of this window depend on whether you’ve chosen POP or IMAP in this field. Options for 
both configurations are described below:

When Server configuration = POP:

Leave mail on server ¾ If this is on, Eudora copies incoming messages to your PC and leaves the message 
on the POP server. If this is off, Eudora transfers incoming messages to your PC and deletes the message from
the POP server. For details, see Managing your Mail on a POP Server 

Delete from server after ? day(s) ¾ This option has a check box for turning it on and off and an edit box for 
specifying the number of days mail that was left on the POP server should be saved before being deleted. It is 
a good idea not to leave copies of your messages on the POP server indefinitely, as this will create mail storage
problems on the server.

Delete from server when emptied from Trash ¾ If this is on, any messages that are deleted from your Trash 
mailbox are also deleted from the POP server. For details, see Managing your Mail on a POP Server 

Skip messages over ? K in size ¾ If this is on, messages over the specified size are downloaded only in part. 
These messages include the first few lines, and a statement that says the message is not complete. This can 
be useful on slow connections.

Offline ¾ If this is on, Eudora won’t attempt to make any connections. This is good to have on if you’re using 
Eudora on a laptop computer that is not continuously connected.

Authentication style ¾ This specifies which POP account authentication technology to use for this account: 
Passwords, Kerberos, APOP, or RPA. Ask your e-mail administrator which one to use, if you are not sure. Use 
RPA for CompuServe.

When Server configuration = IMAP:

IMAP Mailbox Location Prefix ¾ This specifies the mailbox location prefix that IMAP will use when locating 
your mailboxes on the incoming mail server. An example prefix is /usr/mail. Ask your e-mail administrator what 
to enter here, if you are not sure.

For new mail, download ¾ These options (you must choose one) let you control the way incoming mail is 
downloaded from the IMAP server.

Minimal headers only ¾ If this option is on, only a limited set of message headers, and nothing else, is 



downloaded for each incoming message. (That means the remaining message headers, the message body, 
and any attachments are not downloaded for the message.)

Full message except attachments over ? K ¾ If this option is on, the full message (full set of message 
headers and the message body) and any attachments smaller than the specified size are downloaded for each 
incoming message. Also, any attachments larger than the specified size are not downloaded with the message. 
To download all of your IMAP attachments, enter a large number in this field.

Authentication style ¾ This specifies which IMAP account authentication technology to use for this account: 
Passwords or CRAM-MD5. Ask your e-mail administrator which one to use, if you are not sure.



Sending Mail Options Window

The Sending Mail options determine how Eudora sends your outgoing messages from your primary e-mail 
account (dominant personality).

To display the Sending Mail options window, do the following:

1. From the Tools menu, select Options.

2. Click the Sending Mail icon. The Sending Mail options window is displayed.

Listed below are field descriptions for Sending Mail:

Return address ¾ This is your return e-mail address, if different from your incoming mail account. See Getting 
Started Options Windowfor more details.

Domain to add to unqualified addresses ¾ This is the domain name that Eudora automatically adds to an 
unqualified address in messages sent from your primary account. An unqualified address is an address that 
doesn’t have an “@” sign followed by a domain name. This can be used to save time when addressing large 
numbers of messages to users in the same domain.

SMTP server ¾ This is the name of the outgoing mail server for your principal e-mail account. All outgoing 
messages sent from your primary account are routed through this server. If the computer that your primary 
incoming mail account is on also runs an SMTP server, you can leave this field blank. SMTP stands for Simple 
Mail Transfer Protocol.

Immediate send ¾ If this is on, the rightmost button in the Toolbar of the message composition window is 
labeled Send. Clicking on this button immediately sends the message to the SMTP server. If this option is off, 
the button is labeled Queue and clicking on it places the message in the Out mailbox marked ready for delivery 
(Q).

Send on check ¾ If this is on, any messages from your primary account that are queued in the Out mailbox 
are sent when mail is checked for this account, whether the mail-check is automatic or manual.

Select a default Stationery for new messages ¾ This is the default stationery to be used in all outgoing 
messages from your dominant account. Select a stationery file from the pop-up, or select <No Default> for no 
default stationery. If a stationery file is selected, that file is used when you open new messages from this 
account (except with the Redirect or Send Again commands). The message toolbar in the composition window 
is set according to how the stationery message was saved, regardless of how the options below are set. But, 
you can always change them after you open the message. For more on stationery, see Using Stationery    and 
Stationery Window .

Select defaults when not using Stationery ¾ The values you choose for the following options apply only 
when you are not using a default stationery file, that is, when the Select a default Stationery for new messages 
option, above, is set to <No Default>.
Otherwise, if you have selected a default stationery file in that pop-up, then the values below are ignored. 
Instead, Eudora uses their corresponding values that were set when the stationery file was saved. So, for 
example, if you choose default stationery that uses a custom signature and you set the Default signature pop-
up below to your Standard signature, your Standard signature will be ignored and the custom signature will be 
used.

Default signature ¾ This sets the default signature to be used in all outgoing messages sent from your 
dominant account. Select a signature from the pop-up, or select <No Default> for no default signature. If a 
signature is selected, that signature is used on the toolbar of new messages from your primary account. You 
can always change the signature in a particular outgoing message from the toolbar Signature pop-up. For more
on signatures, see the Using a Signature and Signatures Window. Default stationery overrides this option (see 
above).



Word wrap ¾ If this is on, Eudora automatically inserts carriage returns in long lines when a message is sent, 
creating roughly 76 characters per line. This makes the message legible on the recipient’s computer. It is a 
good idea not to include your own carriage returns within paragraphs if you have this option on—only use 
carriage returns to create new paragraphs. We strongly recommend that you leave this option on. Default 
stationery overrides this option (see above).

Keep copies ¾ If this is on, a copy of each message you send is kept in the Out mailbox. If this option is off, 
outgoing messages are put in the Trash mailbox after they are sent. Default stationery overrides this option 
(see above).

May use quoted-printable ¾ If this is on, Eudora uses quoted-printable encoding when necessary, such as 
when sending messages that contain special characters or long lines of text. If this option is off, quoted-
printable encoding is never used. We recommend that you leave this option on. Default stationery overrides this
option (see above).

Tabs in body of message ¾ If this is on, pressing the Tab key within the message body inserts a tab. If it is off,
pressing the Tab key within the message body moves the cursor to the To field. Default stationery overrides this
option (see above).



Replying Options Window

The Replying options determine how replies are created.

To display the Replying options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Replying icon. The Replying options window is displayed.

Listed below are field descriptions for Replying:

Map Ctrl+R to “Reply to All” ¾ If this is on, then when you hold down the Ctrl key and press R, a new 
message is created addressed to all of the recipients of the original message as well as the sender.

Copy original’s priority to reply ¾ If this is on, your replies use the same priority as the original message.

Automatically Fcc to original mailbox ¾ If this is on, replies are automatically copied to the same mailbox 
that contains the original message with the exception of the In box, whose replies are copied to the Out box.

When replying to all ¾ This specifies how to address a reply. If Include yourself is on, when you Reply to all 
(as described above) your address is left in the address list of the new message and you receive a copy of your
own reply. If this option is off (the default), your address is removed from the reply message and you do not 
receive a copy of the reply. If Put original To: recipients in Cc: field is on (the default is off), the addresses of the 
original message recipients are moved from the To field to the Cc field of the reply-to-all message. Only the 
address of the original sender is placed in the To field.



Attachments Options Window

The Attachments options determine how Eudora sends and receives file attachments.

To display the Attachments options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Attachments icon. The Attachments options window is displayed.

Listed below are field descriptions for Attachments:

Encoding method ¾ This specifies what encoding method to use for attached documents: MIME, BinHex, or 
Uuencode. To change the method for just the current message, use the Attachment Type popup in the outgoing
message window. For details, see the section “Attaching a File to a Message.”

Put text attachments in body of message ¾ If this is on, Eudora puts any plain-text attachment you send 
directly in the message body, as if it were typed in manually.

Attachment directory ¾ This specifies what directory to put incoming attachments into. To specify a folder, 
single-click on the folder name button. A dialog is displayed prompting you to select a folder.

Delete attachments when emptying Trash ¾ If this is on, Eudora automatically deletes an attachment 
received with a message when that message is deleted from your system, i.e., when the message is emptied 
from the Trash. The attachment must still be in the folder defined as the Attachments Folder. If you want to save
an attachment but delete the message, move the attachment to another folder or turn this option off.

Delete automatic attachments ¾ This specifies how to handle attachments to automatically generated 
messages, such as is created with the Insert System Configuration command.

Never ¾ If this is on, automatic attachments are never deleted from the attachment directory.

After sending message ¾ If this is on, automatic attachments are deleted from the attachment directory when 
their corresponding messages are sent.

When message emptied from Trash ¾ If this is on, automatic attachments are deleted from the attachment 
directory when their corresponding messages are emptied from the trash.



Fonts Options Window

The Fonts options determine how Eudora displays and prints text. Note that the choices available for each 
option, and the default, may depend on the fonts installed in your system.

To display the Fonts options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Fonts icon. The Fonts options window is displayed.

Listed below are field descriptions for Fonts:

Message ¾ These fields list the proportional and fixed-width fonts to be used for displaying the text in your 
received and composition messages and in the message preview pane in mailbox windows. Also included are 
the size of each font and the use of proportional or fixed-width font by default.

Proportional ¾ Specify the proportional font to use in message windows and the preview pane.

Fixed-width ¾ Specify the fixed-width font to use in message windows and the preview pane.

Use proportional font by default ¾ If this option is on, message windows and the preview pane use 
your specified proportional font by default. If this option is off, message windows and the preview pane 
use your specified fixed-width font by default.

Size ¾ Specify the size of the font to be used for text in message windows and the preview pane.

Printer ¾ These fields list the font and size to be used when printing any text from Eudora using the Print... 
command—messages, text files, signature files, etc.

Font ¾ Specify the font to use when printing text from Eudora.

Size ¾ Specify the font size to use when printing text from Eudora.

Screen ¾ These fields list the font and size to be used when displaying any Eudora screen text other than that 
displayed in received and composition messages and the message preview pane. This includes text files, 
signature files, and message summaries in mailbox windows.

Font ¾ Specify the font to use when displaying all other screen text in Eudora.

Size ¾ Specify the font size to use when displaying all other screen text in Eudora.



Display Options Window

The Display options determine how Eudora displays various objects in the main Eudora window and the 
category icons in the Options list.

To display the Display options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Display icon. The Display options window is displayed.

Listed below are field descriptions for Display:

Show toolbar ¾ If this option is on, the main window toolbar is displayed (see the section “Customizing the 
Toolbar).

Show toolbar tips ¾ If this option is on, holding the mouse pointer over a button in the main window toolbar 
displays a very brief description of that button’s function.

Show cool bars ¾ If this option is on, the main window toolbar buttons have a flat look and only become raised
when you position the mouse pointer over the button. If this option is off, the main window toolbar buttons 
always have a raised look.

Show status bar ¾ If this option is on, Eudora displays a status bar at the bottom of the main window. The 
status bar provides a brief description of menu items and toolbar buttons.

Show category icons ¾ This option allows you to turn the Category icons in the Options dialog on and off.

Show MDI task bar ¾ If this option is on, Eudora displays the Eudora taskbar at the bottom of the window work
area. This taskbar contains buttons for all open and minimized normal Eudora windows. See Using the Eudora 
Taskbar.



Signatures Window

Use this window to manage and apply signatures.

To open the Signature window, do the following:

1. From the Tools menu, choose Signatures. Or, if the Signature window is in a visible tabbed window, click 
its tab.

The Signature window displays a single-column list of your signature files.

Note: You can only select one item at a time in the list; you cannot select multiple items.

If you right-click a signature in the list, a context menu is displayed with the following commands (the standard 
Eudora window-management commands appear at the bottom):

• New — Create a new signature. Eudora prompts you for the name of the new signature, then opens an 
editing window for you to type the signature text. Save the text with the File menu Save command, or close 
without saving to discard.

• Edit — Open an editing window for the selected signature. Double-click a signature as a shortcut for this 
command. Save your changes with the File menu Save command, or close the window without saving to 
discard your changes.

• Delete — Delete the selected signature. Eudora asks you to confirm the deletion. Use the Del key (Delete) 
as a shortcut for this command.

• Rename — Rename the selected signature. Use the F2 key as a shortcut for this command, or click the 
signature item’s name box, then edit the name right in the box.

You can also display the context menu and create a new signature by right-clicking anywhere in an empty 
Signature window or by right-clicking anywhere off a signature item in a non-empty Signature window.



Viewing Mail Options Window

The Viewing Mail options determine how Eudora displays incoming and outgoing message windows and the 
message preview pane in mailbox windows.

To display the Viewing Mail options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Viewing Mail icon. The Viewing Mail options window is displayed.

Listed below are field descriptions for Viewing Mail:

Message Window ¾ These options determine how Eudora displays received and composition messages.

Use Microsoft’s viewer ¾ If this is off, Eudora displays advanced formatting, graphics, and multimedia in 
incoming and outgoing messages, using its own built-in viewer. If this is on, Eudora takes full advantage of the 
Web browser capabilities of Microsoft’s Internet Explorer 3.0 or later by showing Web content right in incoming 
and outgoing messages or linking to the Internet, without your having to open the Web browser. This option is 
only available if you have Microsoft’s Internet Explorer version 3.0 or higher installed and available on your 
system.

Message window width ¾ This specifies the width of new and received message windows (in characters). 
This option has no effect on what your mail looks like when it is sent. When mail is sent, Eudora wraps at or 
before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the average width of the 
characters in the font.

Message window height ¾ This specifies the height of new and received message windows (in lines).

Note: If the Zoom windows when opening option is turned on, received message window heights are 
automatically adjusted to the height of the message text.

Preview Pane ¾ These options determine the visibility and behavior of the message preview pane that 
appears at the bottom of mailbox windows. For more information, see the Message Preview Pane.

Show message preview pane ¾ If this option is on, Eudora displays the message preview pane in mailbox 
windows. The preview pane previews a single selected message. A splitter between the preview pane and the 
message summary list lets you resize the preview pane relative to the list.
Mark previewed messages as read after ? second(s) ¾ If this option is on and the Show message preview 
pane option is turned on, the message currently selected in the mailbox window and previewed in the preview 
pane is automatically marked as read (blank in the Status column) after the specified number of seconds. If this
option is off, a previewed message will not automatically be marked as read. Note: You can use the 
Shift+Space shortcut to convert a message back and forth between the Unread (•) and Read status.

Automatically open next message ¾ If this is on, deleting or transferring the current message opens the next 
message in the mailbox, but only if that message is unread.

Zoom windows when opening ¾ If this option is on, new message windows automatically open to their 
“zoomed” size. The zoomed size is computed on a window-by-window basis. For message windows, zoomed 
size is just long enough to display all of the message (but no longer than the main window), and as wide as the 
Message window width setting. Composition windows zoom to the height specified by the Message window 
height setting.

Show attachment icons ¾ If this is on, the icon for an attachment is displayed, along with the attachment 
name, in the body of incoming message windows and the message preview pane in mailbox windows. If this is 
off, only the attachment’s name is displayed in incoming messages and the preview pane.





Styled Text Options Window

The Styled Text options determine when to use style information in outgoing and incoming messages.

To display the Styled Text options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Styled Text icon. The Styled Text options window is displayed.

Listed below are field descriptions for Styled Text:

Show formatting toolbar ¾ If this is on, the formatting toolbar displays by default in new message windows. If 
this is off, the formatting toolbar is hidden by default in new message windows. This toolbar lets you easily 
format text styles in new messages.

When sending mail with styled text (HTML) ¾ This specifies what to do with HTML text styles when you send
mail. The styles are delivered to your recipients using the HyperText Marking Language (HTML) format. 
However, the styles your recipient sees depends on how well their e-mail software supports this standard. 
HTML is the text formatting standard used in the World Wide Web by Web browsers and newer e-mail 
applications. HTML allows you use enriched text, which includes different fonts, color, sizes, bold, etc. Also, 
HTML lets you embed pictures and create bullet lists in the e-mails you send.

Send plain and styled version in message ¾    If this is on, all text including plain and HTML text styles are 
sent with your messages. 

Send styled text only ¾    If this is on, only HTML text styles are sent with your messages. 

Send plain text only ¾ If this is on, the HTML text styles are not sent with your messages, only plain text.

Ask me each time ¾ If this is on, you are warned when you try to send or queue a message with text styles.



Spell Checking Options Window

These options control the behavior of Eudora’s built-in spelling checker when it performs a spelling check on 
the body of a message composition window, a text file, or a signature file. You can also change these options 
from the Spelling Options dialog, accessed by clicking the Options button in the Check Spelling dialog. For 
more information, see Checking Your Spelling.

To display the Spell Checking options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Spell Checking icon. The Spell Checking options window is displayed.

Listed below are field descriptions for Spell Checking:

Ignore capitalized words ¾ The spelling checker ignores words that begin with a capital letter, such as proper 
nouns.

Ignore words with all capitals ¾ The spelling checker ignores words that contain all capital letters, such as 
acronyms.

Ignore words with numbers ¾ The spelling checker ignores words that contain numbers.

Ignore words with mixed case ¾ The spelling checker ignores words that contain a mixture of uppercase and 
lowercase characters.

Report doubled words ¾ The spelling checker reports words that appear twice in sequence in text and 
identifies them as Doubled words.

Suggest words ¾ If this is on, then when the spelling checker encounters an unknown word, it displays 
Eudora’s suggestions for the correct spelling of the word in the Suggestions field of the Check Spelling dialog 
(see Checking Your Spelling ). You can also select any combination of the suggestion options: Phonetic words 
(off by default), Split words (on by default), Typographic words (on by default).

Note: If in its dictionary Eudora has no suggestions for the word, then no suggestions are listed.

Outgoing messages:
Ignore original text ¾ The spelling checker ignores any text that is preceded by a quote mark, which is a right 
angle-bracket (>) for unstyled text, and an excerpt bar (|) for styled text. Eudora assumes that this text was 
originally from another message, and therefore does not need to be spell-checked.

Check when message queued/sent ¾The spelling checker checks the spelling of outgoing messages when 
you use the Queue or Send commands.

Warn me when I queue/send a message: Without completing the spell check ¾ If this option is on and the 
Check when message queued/sent option is on, Eudora displays a warning if you attempt to queue or send a 
message without completing the spell check.



Date Display Options Window

The Date Display Options determine how message dates are displayed in the Date column of mailbox window 
message summaries.

To display the Date Display options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Date Display icon. The Date Display options window is displayed.

Listed below are field descriptions for Date Display:

Display dates using ¾ This specifies what time zone to use to display dates. 

Sender’s timezone ¾ If on, messages are displayed with the sender’s time and date, as determined by the 
sender’s time zone. 

Local timezone ¾ If on, messages are displayed with your time and date, based on your local time zone.

Date formats [default: Fixed] ¾ These options and fields specify how to display message dates whether with a 
fixed or an age-sensitive format and the specific formatting for the selected option. A fixed format means that all
dates are displayed under the same formatting rule. An age-sensitive format means that message dates are 
displayed differently depending on how old the messages are. Formatting is entered in the text fields using the 
format key at the bottom of the Date Display Options window (discussed further below).

Fixed [defaults: %1 %2 %4] ¾ If this is on, all message dates are displayed using the formatting entered in the 
edit field, based on the formatting key (see below). The default format (%1%2%4) specifies that all message 
dates will be in this format: message time followed by message date followed by message time zone (but only if
the message did not originate from your local time zone). Example: 02:56PM11/21/97-0800.

Age-sensitive ¾ If this is on, message dates are displayed differently based on the age of the messages. The 
three age categories are RECENT, OLD, and ANCIENT. The age of a message is measured from the date and 
time at which the message was composed or sent, based on the sender’s e-mail package, and this depends on
your setting for the Display dates using option. RECENT messages are all those that are “younger” than the 
hours you specify in the Hours to be OLD field. ANCIENT messages are all those that are older than the 
“expiration time” entered in the Hours to be ANCIENT field. OLD messages are all those whose age falls 
between that of RECENT and ANCIENT messages: they are older than the number of hours specified in the 
Hours to be OLD field, but younger than the number of hours specified in the Hours to be ANCIENT field. The 
date display format for all messages falling in the RECENT, OLD, and ANCIENT categories is determined by 
your entry in the RECENT format, OLD format, and ANCIENT format fields, respectively.

RECENT format [default: %1] ¾ Your entry in this field determines the format in which the dates of RECENT 
messages are displayed. RECENT messages are all those younger than the number in the Hours to be OLD 
field. The default RECENT format of %1 and the default Hours to be OLD of 24 means that all messages from 
the past 24 hours are displayed with the time.

Hours to be OLD [default: 24] ¾ Your entry in this field determines the point at which RECENT messages 
become OLD messages. The default entry of 24 hours means that messages become OLD after one day.

OLD format [default: %3] ¾ Your entry in this field determines the format in which the dates of OLD messages 
are displayed. OLD messages are those that are older than the Hours to be OLD but younger than the Hours to
be ANCIENT. The default OLD format of %3, the default Hours to be OLD of 24, and the default Hours to be 
ANCIENT of 168 means that all messages older than one day and younger than one week are displayed with 
the day of the week.

Hours to be ANCIENT [default: 168] ¾ Your entry in this field determines the point at which OLD messages 
become ANCIENT messages. The default entry of 168 hours means that messages become ANCIENT after a 



week.

ANCIENT format [default: %2] ¾ Your entry in this field determines the format in which the dates of ANCIENT 
messages are displayed. ANCIENT messages are all those older than the number in the Hours to be ANCIENT 
field. The default entry of %2 and the default Hours to be ANCIENT of 168 means that all those messages older
than a week are displayed with the date.

Format Key ¾ Use the format key to determine how to program entries in the Fixed field and the format fields 
(RECENT, OLD, and ANCIENT) of this Options window. In each field, enter %1 to stand for the Time, enter %2 
to stand for the Date, enter %3 to stand for the Day of the week, and enter %4 to stand for the Time zone, but 
only if the message did not originate from the local time zone. Separate each entry with a space to improve 
readability of the display output: for example, %1%2%4.



Labels Options Window

The Labels options determine the title and color of the seven labels that can be used to categorize messages.

To display the Labels options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Labels icon. The Labels options window is displayed.

To change a label title, type the new title in the field to the right of the label number. To change a label color, 
single-click on the label number to display the Color dialog.

The Color dialog

You can select from one of the pre-defined Basic colors or create your own Custom colors. To assign a basic 
color to a label, select the color and click OK. To create a custom color, click the Define Custom Colors button 
to display the custom colors palette.

The custom colors palette

To define a custom color, do the following:

1. Select one of the 16 custom color boxes. 

2. Using the mouse pointer, click anywhere on the color palette to select the color Hue and Saturation. Use 
the color control bar to the right of the color palette to adjust the color. 

3. When you are satisfied with the color, click Add to Custom Colors. 

4. Once you have completed creating the custom colors, select the desired label color and click OK.



Getting Attention Options Window

The Getting Attention options determine what Eudora does when it is running in the background and wants your
attention, or when new mail arrives.

To display the Getting Attention options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Getting Attention icon. The Getting Attention options window is displayed

Listed below are field descriptions for Getting Attention:

Use an alert dialog box ¾ If this is on, an alert dialog notifies you when new mail is received.

Open mailbox ¾ If this is on, mailboxes are automatically opened when new mail arrives in them, and the first 
unread message of the last unread batch of messages is selected.

Play a sound ¾ If this is on, a sound is played when Eudora needs attention. To select a sound (.wav) file, click
on the button below the Play a sound option (the button is empty by default). The Select sound file dialog is 
then displayed, allowing you to select a sound.

Generate filter report ¾ If this is on, a filter report is generated when filters are used. Filter reports are 
displayed in the Filter Report window, accessed from the Tools menu. Note that this option must be on in order 
for such reports to be displayed in that window. For more details, see Filter Report Window .



Extra Warnings Options Window

The Extra Warnings options determine whether you are warned before making a possible mistake. Most of the 
warnings are displayed with an option to stop that warning from being displayed again. You can toggle warnings
to be either on or off.

To display the Extra Warnings options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Extra Warnings icon. The Extra Warnings options window is displayed.

Listed below are field descriptions for Extra Warnings:

Delete unread mail ¾ If this is on, you are warned if you try to delete mail that is marked unread.

Delete queued mail ¾ If this is on, you are warned if you try to delete mail that is queued to be sent (marked 
“Q,” or “T” for timed-queue) in the Out mailbox.

Delete unsent mail ¾ If this is on, you are warned if you try to delete messages that are marked sendable 
(with a bullet in the Out mailbox) but not yet sent.

Queue a message with no subject ¾ If this is on, you are warned if you try to queue a message that contains 
no text in the Subject line. It is considered a point of e-mail etiquette to give each message a subject.

Queue a message bigger than ? K [default: 500] ¾ If this is on, you are warned if you try to queue or send a 
message that is greater in size than the specified number. This number must be between 0 and 1000000 (one 
million, no commas).

Quit with messages queued to be sent ¾ If this is on, you are warned if you try to quit Eudora while there are
still queued messages in your Out mailbox.

Empty the Trash mailbox ¾ If this is on, you are warned if you try to empty the Trash mailbox (one way is with
the Special menu Empty Trash command). Once messages are deleted from the Trash, they are completely 
gone from your system.

Start Eudora and it’s not the default mailer ¾ If this is on, you are warned if you try to start Eudora when it’s 
not the default mailer. When Eudora is the default mailer, “mailto:” commands open a Eudora message, 
regardless of what application the command is in.

Switch views for Find ¾ If this is on, you are warned if you try to perform a Find operation (using the Edit 
menu Find submenu) while viewing an incoming message using the Microsoft Internet Explorer version 3.0 
viewer. The warning indicates that Eudora will switch to a different viewer to complete the Find operation. 
Eudora uses Internet Explorer (IE) 3.0 as the default viewer if IE 3.0 is installed on your system and the Use 
Microsoft’s viewer option is turned on in the Viewing Mail Options.



Advanced Network Options Window

These options control some of Eudora’s advanced network functions.

Note: Consult your e-mail administrator before modifying any of these options.

To display the Advanced Network options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Advanced Network icon. The Advanced Network options window is displayed.

Listed below are field descriptions for Advanced Network:

Use asynchronous Winsock calls for ¾ This option lets you select asynchronous calls for Database functions
(default on) and/or All others (default on) when using the Winsock connection method. There are two methods 
of making Winsock calls using TCP/IP stacks: blocking and asynchronous. Because of the ability to handle 
error conditions more gracefully, asynchronous is the preferred method. However, some TCP/IP stacks do not 
handle asynchronous calls correctly, so if you are experiencing trouble with your Winsock connection, make 
sure both of these asynchronous options are off.

Network open timeout ? seconds [default: 60] ¾ This option lets you set the number of seconds before an 
attempt to make a network connection will time out. For some servers (especially those with heavy loads), the 
attempt to establish the network connection can take longer than it takes to send data back and forth once the 
connection has been made. A familiar example: When you are browsing the World Wide Web, you may find that
it takes a while to connect to a server, but then, once you have connected to the server, the Web page can 
seem to download very quickly. This option therefore gives you the ability to set a different (and usually longer) 
timeout for establishing the network connection than the timeout after the connection has been made (the latter 
timeout is set via the Network timeout after ? seconds option, below).

Network timeout after ? seconds [default: 60] ¾ This option lets you set the number of seconds before an 
established network connection will time out. See the discussion above for the Network open timeout ? seconds
option.

Network buffer size of ? bytes [default: 4096] ¾ This option lets you set the size, in bytes, of the buffer that 
Eudora uses to transfer information to and from the server.

Note: If you are having trouble transferring large messages, the size of this buffer may be decreased.

Cache network info ¾ This option causes Eudora to remember the results of previous database functions 
when using the Winsock connection method. This speeds up database functions within a single Eudora 
session.

Unload Winsock DLL after closing socket ¾ This option causes Eudora to unload the Winsock DLL after 
closing the socket. This is useful if you don’t want Eudora to keep your Winsock DLL open continuously.

Automatically dial & hangup this connection ¾ If this is checked, the specified dialup connection (referred to
in Windows NT 4.0 as a “phonebook entry”) is used when Eudora does any network operation. This option is 
only available if you have installed the dial-up networking services with Windows 95 or Windows NT 4.0.

Entry ¾ Use the pop-up menu to select a dial-up connection in this field.

Username ¾ This specifies the username for the auto connection.

Save password ¾ If this is on, the auto connection password is saved in Eudora so that you do not have to re-
enter it after you exit and restart Eudora. If you select Forget Password(s) from the Special menu, you will need
to re-enter the password the next time you check mail.





MAPI Options Window

The MAPI Options control the Eudora MAPI Server. Eudora’s MAPI support allows you to quickly attach 
documents to e-mail messages directly from the application that created the document. Without MAPI, users 
must first save the document, remember what folder the document is in, switch to Eudora, and then remember 
to manually attach the document to the outgoing message.

MAPI streamlines this process dramatically. To e-mail the current, open document from your word processor, 
select the Send command from your word processor’s File menu. This automatically activates Eudora and 
attaches a snapshot of the open document to a new composition message.

The MAPI system standardizes how messages are handled by client applications so that each client application
does not have to have custom code for each target messaging application. MAPI accomplishes this by 
providing a standard application program interface used by all MAPI-enabled client applications.

An additional MAPI feature supported by Microsoft Office applications is the ability to add a “routing slip” to a 
Word, Excel, or PowerPoint document. This routing slip contains a list of e-mail recipients obtained from the 
MAPI subsystem. Once a document has an embedded routing slip, then it can be semi-automatically routed as 
an attachment via e-mail to all recipients listed in the routing slip. Once the routing is complete, the annotated 
document is returned back to the original sender.

For more information, see the Messaging Application Program Interface (MAPI) .

To display the MAPI options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the MAPI icon. The MAPI options window is displayed.

Listed below are field descriptions for MAPI:

Use Eudora MAPI server ¾ If Never is selected, the Eudora MAPI server is off and is never automatically 
loaded. If When Eudora is running is selected, the Eudora MAPI server is on when Eudora is running. If 
Always is selected, the Eudora MAPI server is on and is always loaded on startup.

Delete MAPI attachments ¾ If Never is selected, MAPI attachments are never deleted from the attachment 
directory. If After sending message is selected, MAPI attachments are deleted from the attachment directory 
when their corresponding messages are sent. If When message emptied from Trash is selected, MAPI 
attachments are deleted from the attachment directory when their corresponding messages are emptied from 
the Trash.

Send single MAPI file attachment as inline attachment (TXT and HTML files only) ¾ Turn this on when you
need to have the MAPI client send a single TXT or HTML file as an attachment with no body text. Eudora turns 
off the Text As Attachment button in the outgoing message toolbar (if it is on), so that the document is sent to 
the recipient as inline text in the message body. This allows MAPI clients, such as Internet Explorer, to pass 
Web pages and other HTML and TXT documents right into the body of the Eudora message. (The Text As 
Attachment button, if turned on in the outgoing message toolbar, instructs Eudora to attach text files, such as 
TXT and HTML, to the message rather than incorporating the text into the message as part of the message 
body. The default state of this button is controlled by the Put text attachments in body of message option in the 
Attachments options . See the section Using the Composition Window .



Automation Options Window

The Automation options let you control and exchange information with Eudora from other programs that support
the Windows Automation Interface, such as Microsoft Visual Basic.

Automation gives you external access to Eudora mail folders, mailboxes, and messages, and to the Eudora 
application itself. With automation enabled, you can create, delete, and move Eudora mail folders, mailboxes, 
and messages, as well as get notification of these three operations when they are performed manually. You can
also get lists of the subfolders under folders and of the messages within mailboxes.

For more information on the automation feature, visit the Web site www.eudora.com, where you can find up-to-
date automation SDKs (Software Developer’s Kits) and documentation.

To display the Automation options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Automation icon. The Automation options window is displayed.

Listed below is the field description for Automation:

Automation enabled from this machine ¾ If this option is on, you can perform the automation operations 
described above from the computer on which Eudora is installed.



Auto Configure Options Window

Eudora needs just a few pieces of information in order for you to send and receive mail. Normally you enter this
information in the first few windows of the Options windows, but if you like, you can use the Auto Configure 
options to retrieve these basic settings from an ACAP server. Your e-mail administrator can let you know if such
a server is available to you. ACAP, which stands for “Application Configuration Access Protocol,” is a 
communications protocol that lets e-mail and other applications store setup data on and retrieve it from a 
central server.

To display the Auto Configure options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Auto Configure icon. The Auto Configure options window is displayed.

Listed below is the field description for Auto Configure:

Server Name ¾ In this field, enter the name of the ACAP server you wish to connect to in order to retrieve the 
Eudora settings. If you are not sure what to enter here, see your e-mail administrator.

User Name ¾ Enter your user name required for connection to the ACAP server. Your e-mail administrator can 
provide you this name if you do not know it.

Password ¾ Enter your password required for connection to the ACAP server. See your e-mail administrator 
for your ACAP password.

Retrieve Settings Now ¾ After you have entered the Server Name for the ACAP server, your User Name, and 
your Password (see above), click this button to retrieve your Eudora settings from the ACAP server. The 
retrieved settings replace your current Eudora settings.



Kerberos Options Window

These options control the Kerberos authentication system. If your network uses Kerberos for authentication, the
appropriate options are provided by your e-mail administrator.

To display the Kerberos options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Kerberos icon. The Kerberos options window is displayed.

Listed below is the field description for Kerberos:

Kerberos POP3 port ¾ This is the port that the Kerberos POP server is listening on.

Realm ¾ This is the network realm that the Kerberos server resides in.

Service name [default: rcmd] ¾ This is the type of service that you’re requesting.

Service format [default: %1.%4@%3] ¾ This is the name of the ticket that Eudora requests from the Kerberos 
server. The formatting key below this field indicates what to enter. Enter %1 to stand for the service name 
entered in the Service name field; enter %2 to stand for the full domain name of the POP host; enter %3 to 
stand for the realm entered in the Realm field; enter %4 to stand for the name of the POP host.



Miscellaneous Options Window

The Miscellaneous options determine additional Eudora capabilities that are not categorized with other 
functions.

To display the Miscellaneous options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Miscellaneous icon. The Miscellaneous options window is displayed.

Listed below are the field descriptions for Miscellaneous:

Switch messages with:
Unmodified arrow keys ¾ If this is on and there is an incoming message window open on the screen, the up 
or left arrow key closes the current message and opens the previous message in the mailbox, and the down or 
right arrow key closes the current message and opens the next message in the mailbox. If this is on and the 
Show message preview pane option is on in the Viewing Mail options , and keyboard focus is currently in the 
preview pane of an open mailbox window, then pressing the unmodified arrow keys changes the view in the 
preview pane going up or down the message summary list, as appropriate. If the Unmodified arrow keys option 
is turned off, the arrow keys can be used to move the cursor (insertion point) in messages and the preview 
pane.

Note: Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there is an outgoing 
message topmost on the screen.

Ctrl+arrow keys ¾ If this is on, you can switch messages by holding down the Ctrl key and pressing the arrow 
keys. The switching behavior is as described above under the Unmodified arrow keys option. The Ctrl+arrow 
keystrokes do not work when composition windows are open on the screen.

Alt+arrow keys ¾ If this is on, you can switch messages by holding down the Alt key and pressing the arrow 
keys. The switching behavior is as described above under the Unmodified arrow keys option. The Alt+arrow 
keystrokes do work when composition windows are open on the screen.

Empty Trash when exiting ¾ If this is on, the Trash mailbox is emptied when you exit Eudora. If this is off, the 
Trash is only emptied when you select Empty Trash from the Special menu.

Say OK to alerts after ? second(s) [default: 120] ¾ If this is on, any alerts that announce a problem with the 
network communication automatically go away after the specified number of seconds. Many network problems 
are temporary, so this allows Eudora to try the communication again. This is most useful if you have automatic 
mail-checking enabled for any of your accounts.

Turbo redirect by default ¾ If this is on and you select Redirect To, a redirected message is created with the 
specified recipient, the message is queued, and the original message is deleted.

Intercept Netscape mailto URLs ¾ If this is on, then when you execute a Netscape “mailto:” command, by 
clicking on an active e-mail address in a Web page, a new Eudora message opens.

Include outdated ‘Return-Receipt-To’ ¾ If this is off, Eudora uses the “Disposition-Notification-To:” header in 
return receipt requests to request that you be sent a notification when your message is displayed by the 
recipient. If this is on, Eudora also sends the “Return-Receipt-To:” header in return receipt requests. This 
header is understood by some older mail delivery systems, and may return you a receipt when your message is
delivered to your recipient’s mailbox. The “Return-Receipt-To:” header cannot give you any information about 
whether or not your recipient displayed your mail, and is not supported by many newer mail delivery systems.

Automatically expand nicknames ¾ If this is on, nicknames in message headers are replaced with the real 
addresses when you switch fields.





Mailboxes Options Window

The Mailboxes options determine how Eudora displays various objects in mailbox window columns. It also 
allows you to configure Eudora to select and drag message(s) for mailbox transfers.

To display the Mailboxes options window, do the following:

1. From the Tools menu, select Options.

2. Scroll and click the Mailboxes icon. The Mailboxes options window is displayed.

Listed below are field descriptions for Mailboxes:

Show Mailbox Columns ¾ These options determine which columns are displayed in mailbox windows. Turn 
on an option to display that column in all mailbox windows. The options are Status, Priority, Attachment, Label, 
Sender, Date, Size, Server status, and Subject.

Show mailbox lines ¾ If this option is on, lines are displayed in the message summaries portion of mailbox 
windows, horizontal lines to separate message summaries, and vertical lines to separate columns.

Close messages with mailbox ¾ If this is on, all opened messages in a mailbox will close automatically when 
you close the mailbox .

Select newly inserted messages (FUMLUB) ¾ If this is on, the first message of the most current block of 
unread messages is highlighted in the Table of Contents window. FUMLUB means First Unread Message of the
Last Unread Block.    For example, you may have a series of unread messages in a mailbox scattered 
throughout your Table of Contents. The first message of the last block of unread messages listed in your Table 
of Contents is selected. 

When dragging in a mailbox:
Allow drag and drop transfers ¾ If this is on, you can transfer a message to another mailbox using drag and 
drop: select one or more messages in a mailbox, drag them to another mailbox and drop them in the target 
mailbox.

Allow drag select of messages ¾ If this is on, you can click and drag on adjacent messages to select them as
a group in the Table of Contents window. This allows you to transfer a group of messages to a mailbox or to 
delete them if the “Allow drag and drop transfers” is turned on. The drag select works only if the drag starts on 
an unselected (not highlighted) message.



Priority popup
Specifies the priority of the message as it is displayed in the mailbox window.



BLAH ,BLAH, BLAH Icon
If this is on, all message headers (and any formatting codes) are displayed.



Font Size Button
Click this button and choose a size from the popup menu to change the selected or current text to that size. 
Choices are Very Small, Small, Medium, Large, Larger, Very Large, and Humongous.



Typewriter Button
Click this button to change the selected or current text to the fixed-width (typewriter-style) font set in the Fixed-
width field of the Message portion of the Fonts Options (Tools:Options:Fonts). Fixed-width fonts are useful for 
composing and reading aligned text, such as in columns and tables.



Fixed Width Button (FW)
Click this button to convert the entire message text to a fixed-width (typewriter-style) font. Fixed-width fonts are 
useful for viewing aligned text, such as columns and tables. Note that this option does not edit the message but 
only changes the view mode while the message is open. Eudora turns the FW button off when you close the 
message.



Pencil Button
Click this button to edit the message text. When you are finished editing, select Save from the File menu, or press 
Ctrl+S, to save your changes. If you close the message without saving changes, Eudora prompts you to save or 
discard your changes. You cannot edit the message headers: only the message body text. Once you save your 
changes, you cannot undo the editing, so edit messages with care.



Insert Object Button
Click this button and select Picture... or Horizontal Line from the popup menu to insert a picture (JPEG graphic 
file) or horizontal rule at the current cursor position in the message body. Pictures, once inserted, can be dragged 
around within the message. A horizontal line is inserted on a line by itself. Note that whether or not your recipient 
can see the inserted object depends on the viewing capabilities of his or her e-mail package and computer.



Word Wrap Icon
If this is on, a carriage return is not required at the end of each line. When the message is sent, the text is 
automatically “wrapped,” meaning that carriage returns are inserted at the end of each line of text, with roughly 76
characters per line.



Trash Icon
If this is on, the next time Eudora checks the server for mail it also deletes this message from the server.



Fetch Icon
If this is on, the next time Eudora checks the server for mail it also downloads this entire message.
You can also turn on the Trash icon so that the message is downloaded then deleted.



Subject Field
Use this field to change the subject of the message as it is displayed in the mailbox window. To change the 
subject, type the new subject in this field and press [Enter].



Signature popup
The Signature popup menu lets you automatically attach a signature file to the end of the message.
If you have a default signature set, it is displayed in the Signature popup menu, but you can change it at any time 
before you send the message.



Attachment Type popup
The Attachment Type popup menu lets you select what format documents that you attach to outgoing messages 
are encoded in: Multipurpose Internet Mail Extensions (MIME), BinHex, or Uuencode.
MIME is best for recipients with MIME.
BinHex is most compatible with old Macintosh mailers and previous versions of Eudora.
Uuencode is best for communicating with older PC or UNIX systems.



Quoted-Printable Encoding
If this is on, quoted-printable (QP) encoding may be used when sending messages that contain long lines of text 
or special characters. When on, it is used for all attachments. It is recommended that this button always be on.



Text as Attachment
If this is on, plain text files (ASCII) are attached as normal. If it is off, plain text files are included in the body of the 
message.



Word Wrap
If this is on, carriage returns are inserted automatically when the message is sent, at roughly 76 characters per 
line.
It is a good idea not to include your own carriage returns within paragraphs if you have this option on. Only use 
carriage returns to create new paragraphs.



Tabs in Body
If this is on, when you press the tab key within the message body, a tab is inserted. If it is not on, when you press 
the tab key within the message body the cursor moves to the To field.



Keep Copy
If this is on, a copy of each sent message is kept in the Out mailbox (their summaries are marked with an S in the 
far left column of the Out mailbox window, indicating that they have been sent). These messages are saved until 
they are deleted or transferred to a different folder.



Return Receipt
If this is on, your recipients receive a request to notify you that they received the message.
This function does not work in all cases, depending on the e-mail application your recipients are using.



Open Next Message
Opens the next message in the mailbox.



Open Previous Message
Opens the previous message in the mailbox.



New File
Opens a text window so you can create a text file from within Eudora.



Open File
Displays the standard File dialog so you can find and open a file.



Open Attachment
Opens an attachment in a composition window or a received message, as long as the attachment is highlighted (in
a composition window) or the cursor is on the same line as the attachment (in a received message).



Close
Closes the current message or window.
Hold down the Shift key to close all open windows.



Save
Saves changes to the topmost window. This applies to message composition windows, signature windows, the 
Nicknames window, and the Filters window.
Hold down the Shift key to save the changes to all open windows.



Save As
Displays the standard Save As dialog so that you can save the current message to a plain text file.
If you select several messages they are all saved as one file.



Save As Stationery
Saves the current message to a stationery file.



Send Queued Messages
Sends all queued messages to the mail server.
Hold down the Shift key to display the Mail Transfer Options dialog.
Queued messages are listed in the Out mailbox with a “Q” in the status column.



Check Mail
Checks your POP server for new messages and transfers them to your PC.
Hold down the Shift key to display the Mail Transfer Options dialog.
If a time appears in parentheses next to this command, it is the next time an automatic mail check will occur.



Print
Prints messages, a text file, a signature file, the Filter Report window, the dialup Navigation Trace window, or the 
Ph window.



Print Preview
Displays the Print Preview window for messages, a text file, a signature file, the Filter Report window, the dialup 
Navigation Trace window, or the Ph window.



Print Setup
Displays the standard Windows Print Setup dialog.



Exit
Exits Eudora. If edited messages or windows are still open, you will be asked to save or discard your changes.
Hold down the Shift key to instruct Eudora that all currently open windows are to automatically reopen at the next 
startup.



Undo
Reverses the last editing action done on a piece of text (multiple levels).



Redo
Re-performs the last undone action (multiple levels).



Cut
Deletes the selected text and copies it to the clipboard.



Copy
Copies the selected text to the clipboard.
Hold down the Shift key to remove the carriage returns from “wrapped” text prior to copying it to the clipboard.



Paste
Pastes the contents of the clipboard at the insertion point in a message or message header.



Paste As Quotation
Pastes the contents of the clipboard at the insertion point with quote characters at the beginning of each line to 
denote quoted text.



Clear
Deletes selected text without copying it to the clipboard.



Plain
Makes the selected text plain.



Bold
Makes the selected text bold.



Italic
Makes the selected text italic.



Underline
Makes the selected text underlined.



Select All
Selects the entire contents of a message or mailbox.



Normal
Converts the selected or current paragraph to normal margin (no indentation).



Indent In
Indents the selected or current paragraph in one level.



Indent Out
Removes one level of indent from the selected or current paragraph.



Left
Makes the selected paragraph aligned to the left.



Right
Makes the selected paragraph aligned to the right.



Center
Makes the selected paragraph aligned to the center.



Bulleted List
Converts the selected or current text to a bulleted list.



Make Hyperlink
Lets you convert any piece of selected text or graphic which hyperlinks to a URL you specify. When your recipient 
clicks on the text string or picture, he or she is immediately taken to that URL.



Clear Formatting
Clears all formatting from the message: removes all styles. Styled text is sent as plain text.
Clear all the formatting from the selected text or paragraph.



Picture
Inserts a graphic (JPEG file only) at the current cursor position in the message. Once the picture is inserted, you 
can drag it to where you want it in the message. Your recipient will see the picture right in the message.



Horizontal Line
Inserts a horizontal rule at the current line level and the drops the text line containing the cursor to the next line 
down.



Wrap Selection
Inserts carriage returns at the end of each line of the current selection, in the same way Eudora does when it 
sends mail.
Hold down the Shift key to unwrap the current selection (removes the carriage returns).



Finish Address Book Entry
Completes the partial text of a nickname in a message header field.
Hold down the Shift key to insert the full nickname expansion in the message header field.



Insert Recipient
Inserts the chosen recipient at the insertion point.



Find
Displays the Find dialog so that you can find a character string within one message, multiple messages, or even 
multiple mailboxes.



Find Again
Finds the next occurrence of the specified text string, beginning with the current message and searching through 
subsequent messages and mailboxes.



Enter Selection
Enters your selected text in the text field of the Find dialog. Use this to avoid having to type in complicated or 
lengthy search strings.



Sort by Status
Sorts the message summaries within a mailbox by status.
To sort in descending order, hold down the Shift key and use a Sort command.



Sort by Priority
Sorts the message summaries within a mailbox by priority.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Attachment
Sorts the message summaries within a mailbox by attachment.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Label
Sorts the message summaries within a mailbox by label.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Sender
Sorts the message summaries within a mailbox by sender.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Date
Sorts the message summaries within a mailbox by date.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Size
Sorts the message summaries within a mailbox by size.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Server Status
Sorts the message summaries within a mailbox by server status.
To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Subject
Sorts the message summaries within a mailbox by subject.
To sort in descending order, Hold down the Shift key and use a Sort command.



Check Spelling
Checks current message composition windows, text files, and signature files for spelling errors. If a misspelled, 
unknown, or repeated word is found, the Check Spelling dialog is displayed with the word listed in the Unknown 
field.



Message Plugins
Applies the selected plug-in to the selected message or text.



In
Opens the In mailbox.
All incoming messages are stored in this mailbox until they are filtered, transferred, or deleted.

Note: Try not to keep too many messages in your In box because it can slow down your system’s performance. 
However, you can transfer messages from your In box to other mailboxes.    



Out
Opens the Out mailbox.
All messages you compose, save, and queue are stored in this mailbox until they are sent. Also, if the Keep 
copies option in the Sending Mail Options is on, a copy of each outgoing message is    saved in this mailbox.

Note: Try not to keep too many messages in your Out box because it can slow down your system’s 
performance. However, you can transfer messages from your Out box to other mailboxes.    



Trash
Opens the Trash mailbox.
All deleted messages are stored in this mailbox until you select Empty Trash from the Special menu. If the 
Empty Trash when exiting option in the Miscellaneous Options is on, the Trash is automatically emptied when 
you exit Eudora. Deleting a message from this mailbox permanently deletes the message.



Your Mailbox
Opens a mailbox you have created.



New... 
Displays the New Mailbox dialog so that you can create a new mailbox or mailbox folder.



New Message
Opens a new message composition window.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality to make the message from. You can also select a stationery file 
to use.



Reply
Generates a reply message to a current incoming message.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality to make the message from. You can also select a stationery file 
to use.



Reply to All
Generates a reply message addressed to all of the recipients of the selected message.



Forward
Generates a forward message from a current incoming message.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality to make the message from. You can also select a stationery file 
to use.



Redirect
Generates a redirect message from a current incoming message.
The address in the From: field of the message header is that of the original sender “by way of” your address.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality to make the message from. You can also select a stationery file 
to use.



Send Again
Reformats a message that was returned to you by the mail server so that you can send it again without including 
all of the return information. A message is typically rejected because of an error in the recipient’s address, 
although there are many other possible reasons.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality to make the message from. You can also select a stationery file 
to use.



New Message To
Opens a new message to the selected recipient.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality for which you can make a new message. You can also select a 
stationery file to use.



Forward To
Opens a forwarded message to the selected recipient.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality for which you can make a new message. You can also select a 
stationery file to use.



Redirect To
Opens a redirected message to the selected recipient.
To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog 
is displayed so that you can select the personality for which you can make a new message. You can also select a 
stationery file to use.



New Message With
Opens a new message with the selected stationery file.



Reply With
Opens a reply message with the selected stationery file.



Attach File
Displays a standard File dialog so that you can attach a file to a new or current message. Any file can be attached 
to and sent with a Eudora message.



Send Immediately
Sends the current message to the SMTP server.
You can change this command to “Queue For Delivery” so that your outgoing messages are put in a queue until 
you send them all at the same time. To do this, turn off Immediate send in the Sending Mail Options.



Queue For Delivery
Saves the current message in the Out mailbox and marks it as Q (queued for delivery). Send your Queued 
messages by selecting Send Queued Messages from the File menu.
You can change this command to Send Immediately so that your outgoing messages are sent out immediately. 
To do this, turn on Immediate send in the Sending Mail Options



Change... Queueing
Displays the Change Queuing dialog so that you can modify the queueing status of an outgoing message.
Use this dialog to queue the current messages, unqueue messages, or set a time for queued messages to be 
sent.



Change... Status... Unread
Changes the status of the current messages to unread.



Change... Status... Read
Changes the status of the current messages to read.



Change... Status... Replied
Changes the status of the current messages to replied.



Change... Status... Forwarded
Changes the status of the current messages to forwarded.



Change... Status... Redirected
Changes the status of the current messages to redirected.



Change... Status... Unsendable
Changes the status of the current messages to unsendable.



Change... Status... Sendable
Changes the status of the current messages to sendable.



Change... Status... Queued
Changes the status of the current messages to queued.



Change... Status... Time Queued
Changes the status of the current messages to time queued.



Change... Status... Sent
Changes the status of the current messages to sent.



Change... Status... Unsent
Changes the status of the current messages to unsent.



Change... Priority... Highest
Changes the priority of the current messages to highest.



Change... Priority... High
Changes the priority of the current messages to high.



Change... Priority... Normal
Changes the priority of the current messages to normal.



Change... Priority... Low
Changes the priority of the current messages to low.



Change... Priority... Lowest
Changes the priority of the current messages to lowest.



None
Do not put a label on the current message (take off any existing label).



Change Label
Changes the label of the current messages to the selected label that you have created.



Change... Server Status... Leave
Changes the server status to Leave. The message will stay on the server.



Change... Server Status... Fetch
Changes the server status to Fetch. The message will be transferred from your POP account the next time you 
check or send mail.



Change... Server Status... Delete
Changes the server status to Delete. The message will be deleted from the server the next time you check or 
send mail.



Change... Server Status... Fetch then Delete
Changes the server status to Fetch then Delete. The message will be transferred from your POP account, then 
deleted from the server the next time you check or send mail.



Delete
Transfers the current message to the Trash mailbox, or if your incoming mail server uses IMAP,    marks the 
current message for deletion from your system and the IMAP server.



UnDelete
Unmarks for deletion a message that has been marked for deletion using the Delete command. If your incoming 
mail server uses IMAP, then use Delete to mark your messages for deletion. Use UnDelete to unmark them (they 
will not be deleted), and use Remove Deleted Messages to remove the marked messages from your system and 
the IMAP server.



Remove Deleted Messages
Removes from your system and from the IMAP server all messages that have been marked for deletion using the 
Delete command.



In
Transfers the current message(s) to the In mailbox.



Out
Transfers the current message(s) to the Out mailbox.



Trash
Transfers the current message(s) to the Trash mailbox.



Your Mailbox
Transfers the current message(s) to the mailbox you have created.



New...
Displays the New Mailbox dialog so that you can create a new mailbox and transfer the current message(s) into it.



Filter Messages
Runs all manual filters on the current messages.
This is the only way that filters designated as Manual in the Filters window can be used.



Filter Report
Opens the Filter Report window, which displays a report of all filtering activity since the last Eudora startup. The 
Generate filter report option must be turned on in the Getting Attention Options for these reports to be created.



File Browser
Opens the File Browser window, which operates similar (but not identical) to Windows Explorer. It lets you drag 
files to open composition messages to add them as attachments.



Stationery
Opens the Stationery window, which lets you create, edit, rename, delete, and otherwise manage your stationery 
files.



Signatures
Opens the Signature window, which lets you create, edit, rename, delete, and otherwise manage your signature 
files.



Personalities
Opens the Personalities window, which lets you create, edit, delete, and otherwise manage your personalities (e-
mail accounts).



Make Address Book Entry...
Creates a single Address Book entry from selected messages or Address Book entries.
If you make an Address Book entry from incoming messages, the addresses in the From fields are used. If you 
make an Address Book entry from outgoing message, the addresses in the To and Cc fields are used.



Add as Recipient
Adds the highlighted e-mail address(es) to the Quick Recipient list.
To do this, highlight one or more addresses in a message window, then select Add as Recipient.



Remove Recipient
Removes the selected recipient from the Quick Recipient list.



Empty Trash
Permanently deletes messages from the Trash mailbox.
If the Empty Trash when exiting option in the Miscellaneous Options is on, the trash is emptied automatically 
when you exit Eudora.



Compact Mailboxes
Recovers the unused (“wasted”) space from all of your mailboxes.
This wasted space was created when messages were deleted or transferred from the mailboxes.



Forget Password(s)
Makes Eudora forget that you have already entered your password(s) for this session.
You will be prompted to re-enter password(s) at the next mail check.



Change Password...
Displays the Password change dialog so that you can change the selected password.
This will only work if you have the necessary software on your server.



Message Plug-ins Settings...
Displays the Message Plug-ins Settings dialog so that you can setup your Message Plug-ins.



Filters
Displays the Filters dialog so that you can create filters that automatically sort your incoming and outgoing mail.



Mailboxes
Displays the Mailboxes window so that you can create, rename, and remove mailboxes and folders.



Address Book
Displays the Address Book so that you can create, edit, or remove entries and their nicknames.
Entries can consist of multiple addresses so that you can create mailing lists.



Directory Services
Displays the Directory Services windows so that you can access Ph and finger directory services.



New Signature
Displays the New Signature window so that you can add a signature.



Delete Signature
Displays the Delete Signature window so that you can delete a signature.



Standard
Displays the Standard Signature window so that you can create a standard signature to be included at the end of 
your outgoing messages.



Signature
Displays the selected Signature window so that you can create a signature to include at the end of your outgoing 
messages.



Options...
Displays the Options dialog so that you can set Eudora options.



Cascade
Arranges all open windows in a cascade.



Tile Horizontal
Arranges all open windows as horizontal tiles.



Tile Vertical
Arranges all open windows as vertical tiles.



Arrange Icons
Arranges iconified windows along the bottom of the Eudora window.



Send To Back
Sends the active window to the back.



Topics
Displays the online Help contents.



Context Sensitive Help
Displays compact, pop-up help for an item you select or an object at which you point and click.



Register Eudora…
Opens the registration window allowing you to electronically register your copy of Eudora.



Insert System Configuration
Inserts detailed information about your system into a composition message. Use this when reporting Eudora bugs.



About Eudora…
Opens a window giving detailed information about this version of Eudora and its credits.





Make Filter
Opens the Make Filter window allowing    you to create a simple filter. A message in one of your mailboxes must be
selected before you can use this command.



Mail Server (Incoming POP/IMAP)
Specifies the name of your account on your incoming server (POP or IMAP) that delivers your e-mail.
For example, if your assigned login name is “justine,” and the name of the computer where you receive e-mail is 
“incoming.qualcomm.com” type “justine@incoming.qualcomm.com” in this field. (When you enter your account name here, it is 
made available in the incoming Mail Server field of other Options categories.)
A POP account is an account on a computer that runs a Post Office Protocol version 3 (POP3 or POP) server. An IMAP account 
is an account on a computer that runs an Internet Message Access Protocol server. This is the account to which your e-mail 
messages are delivered so that Eudora can find them and transfer them to your PC. You must have a POP or IMAP account to 
be able to receive mail with Eudora. 



Real name
Specifies your real name.
Enter your name as you want it to appear in the From field of your outgoing mail messages. Your return address is also given in 
that field.



Mail Server (Incoming)
Enter the full name of the computer that receives your incoming mail. 
For example, if your assigned login name is “justine,” and the name of the computer where you receive e-mail is 
“incoming.qualcomm.com” type “justine@incoming.qualcomm.com” in this field. (When you enter your account name here, it is 
made available in the incoming Mail Server field of other Options categories.)
Your incoming server is either a POP or IMAP server. A POP account is an account on a computer that runs a Post Office 
Protocol version 3 (POP3 or POP) server. An IMAP account is an account on a computer that runs an Internet Message Access 
Protocol server. This is the account to which your e-mail messages are delivered so that Eudora can find them and transfer them
to your PC. You must have a POP or IMAP account to be able to receive mail with Eudora.    
Most likely, you receive your mail from a POP server; however, if you are using Eudora in an organization, please check with you
system administrator to see what kind of server you are using for your incoming mail.



Login Name
Enter the name you use to log in to your primary e-mail account. This is often the text that appears before the at sign (@) in your 
e-mail address.
Example: For the account beatrixp@qualcomm.com, the login name is beatrixp.



Return address
Specifies a return address if it is different than your incoming account.
If you enter an address in this field, first test the address to be sure that mail sent to it is indeed delivered to you. If you use an 
invalid return address, no one can reply to your mail.



SMTP server (Outgoing)
This is the name of the server where you send your messages to. The name of this server is SMTP (Simple Mail Transfer 
Protocol).
Enter the name of your SMTP server if it is different from the computer that is running your incoming server. You do not need a 
login name on this server, but you must have access to it through your network.



Check for mail every ? minutes
Specifies how often Eudora checks the incoming server(s) for new mail. It's a good idea to set this to at least 15 minutes. 
Checking mail more frequently puts an unnecessary drain on your incoming server.



Don’t check when using battery
If this option is on and your PC is running on battery power, mail is not automatically checked even if automatic mail-checking is 
on (i.e., even if the Check for mail every ? minutes field has a number other than 0 in it).



Send on check
If this is checked, any messages that are queued (Q) in the Out mailbox are sent when Eudora checks the incoming server for 
new mail. 



Save password
If this is checked, your password is stored in Eudora and you never have to enter it again, even if you exit Eudora and restart.
Only use this option if your PC is in a secure place.



Leave mail on server
If this is checked, incoming messages are transferred to your PC and also left on the server. (Normally your mail is transferred, 
then deleted from the incoming server.)



Delete from server after ? days
This option has a checkbox for turning it on and off and an edit box for specifying the number of days mail that was left on the 
incoming server should be saved before being deleted. It's a good idea not to leave copies of your messages on the incoming 
server indefinitely, as this will create mail storage problems on the server.



POP
Select POP if the incoming mail server for this account uses the POP Internet-mail protocol (Post Office Protocol).



IMAP
Select IMAP if the incoming mail server for this account uses the IMAP Internet-mail protocol (Internet Message Access 
Protocol).



Download Options (IMAP)
Listed are options you can choose when downloading e-mail.



Minimal Headers Only (IMAP)
If this setting is on, only a limited set of message headers is downloaded from the IMAP server for each incoming message. If 
this setting is off, the full set of message headers is downloaded for each incoming message.



Skip Attachments over ? K
If this setting is on and a number is entered in the edit box, then any attachment larger than the specified size will not be 
downloaded with the message. If this setting is off, all attachments are downloaded regardless of size.



Skip messages over ? K in size/Full message except attachments over ? in size
If this setting is on and a number is entered in the edit box, then any message larger than the specified size will not be 
downloaded. If this setting is off, all messages are downloaded regardless of size.



IMAP Mailbox Location Prefix
This specifies the mailbox location prefix that IMAP will use when locating your personal mailboxes on the incoming mail server. 
An example prefix is /usr/mail. Ask your e-mail administrator what to enter here, if you are not sure.



Delete from server when emptied from Trash
If this is checked, all messages that you have deleted from your trash mailbox are also deleted from the server.
This only applies to messages that were transferred to your PC under the Leave mail on server option. Normally Eudora 
deletes a message from the server immediately after the message is transferred.



Authentication Style
Specifies the authentication style. Ask your e-mail administrator which one is being used at your site. To get mail from a 
CompuServe incoming server, choose RPA as the authentication style.

For POP, you can use Passwords, Kerberos, APOP, or RPA.

For IMAP, you can use Passwords or CRAM-MD5.



 Domain to add to unqualified names
Specifies a domain to be added to unqualified names.
An unqualified name is one that doesn't have an "@" sign followed by a domain name. If you address a message to someone 
without including their domain name, Eudora automatically adds this domain to that address. This setting can be used as a time-
saving device when addressing large numbers of messages to users who reside in the same domain.



Immediate send
If this is checked, all send options are set to Send Immediately.
If this is not checked, messages are saved in the Out mailbox and marked “Q” (queued for delivery).
Send options include the rightmost button in the icon bar of the message composition window and the Send Immediately option 
in the Message menu.



Select a default stationery
Select a stationery file to use as the default for all your outgoing messages from your main account, or choose <No Default> for 
no default stationery.
Once you select a stationery, new messages are created with that stationery and will include the toolbar settings for the 
stationery.
If there is no stationery selected, new messages are created with toolbar settings based on the options selected below the 
stationery pop-up.



Default signature
Select a signature file to use as the default for all your outgoing messages from your main account (when you are not using 
stationery), or choose <No Default> for no default signature. You can always change the signature for a particular message by 
selecting a signature from the Signature pop-up menu on the message toolbar. Your signature is automatically attached to the 
end of outgoing messages.



Word wrap
If this is checked, carriage returns are inserted automatically when the message is sent, at roughly 76 characters per line.
It is a good idea not to include your own carriage returns within paragraphs if you have this option on. Only use carriage returns 
to create new paragraphs.



May use Quoted-Printable
If this is checked, Eudora uses quoted-printable encoding when necessary, such as when messages that contain long lines of 
text or special characters are sent.
If this is not checked, quoted-printable encoding is never used.



Keep copies
If this is checked, a copy of each message you send is saved in the Out mailbox and marked Ö.
If this is not checked, Eudora moves outgoing messages to the Trash mailbox after they are sent.



Tabs in body of message
If this is checked, when you press the tab key within the message body, a tab is inserted.
If this is not checked, when you press the tab key within the message body the cursor moves to the To field.



Encoding Method
These options specify what encoding method should be used with attached files.



MIME
If this is checked, documents attached to outgoing messages are encoded in MIME.
MIME is best for recipients with MIME.



BinHex
If this is checked, documents attached to outgoing messages are encoded in BinHex.
BinHex is best for recipients with old Macintosh mailers and previous versions of Eudora.



Uuencode
If this is checked, documents attached to outgoing messages are encoded in Uuencode Data Fork.
Uuencode is best for communicating with older PC or UNIX systems.



Put text attachments in body of message
If this is checked, Eudora puts any plain-text attachment you send directly in the message body as if it were typed in manually. If 
this is unchecked, the plain-text attachment is sent as an attachment file.



Attachment Directory
Specifies what directory your incoming attachments will be put in.
To change the directory, single-click on the directory name button (the default is blank). A dialog is displayed allowing you to 
select the attachment destination directory.
If you do not select an attachment directory, attachments are placed in your Eudora directory.



Delete attachments when emptying Trash
If this is checked, attachments are deleted when their corresponding messages are deleted from the Trash (or the Trash is 
emptied).
The attachment must be in the directory defined as the Attachments Directory.
If you want to save an attachment but delete the message, move the attachment to another directory or leave this option off.



Delete automatic attachments: Never
If this is checked, automatic attachments are never deleted automatically.
Automatic attachments are attachments to automatically generated messages, such as with the Insert System Configuration 
command.



Delete automatic attachments: After sending message
If this is checked, automatic attachments are deleted automatically after the corresponding message is sent.
Automatic attachments are attachments to automatically generated messages, such as with the Insert System Configuration 
command.



Delete automatic attachments: When message emptied from Trash
If this is checked, automatic attachments are deleted when their corresponding messages are deleted from the Trash (or the 
Trash is emptied).
Automatic attachments are attachments to automatically generated messages, such as with the Insert System Configuration 
command.



Screen Font
Specifies the font and point size to be used for displaying the text of your Eudora messages and mailbox windows.
To change the selection, click on this button. The Font dialog is displayed so that you can select a new font and size.



Printer Font
Specifies the font and point size to be used when printing messages using the Print command.
To change the selection, click on this button. The Font dialog is displayed so that you can select a new font and size.



Proportional
Specifies the proportional font to use in message windows and in the message preview pane in mailbox windows.



Fixed-width
Specifies the fixed-width font to use in message windows and in the message preview pane in mailbox windows.



Use proportional font by default
If this is checked, your specified proportional font is used to display text in message windows and the message preview pane. If 
this is unchecked, your specified fixed-width font is used to display this text.



Size
Specifies the size of the font to be used for text in message windows and the message preview pane.



Size (printer)
Specifies the size of the font to use when printing text from Eudora.



Font (screen)
Specifies the font to use when displaying all Eudora screen text other than that in message windows and the message preview 
pane.



Size (screen)

Specifies the size of the font to use when displaying all Eudora screen text other than that in message windows and the 
message preview pane



Show cool bars
If this is checked, the main window toolbar buttons have a flat look and only become raised when you position the mouse pointer
over the button. If this is unchecked, the main window toolbar buttons always appear raised.



Show toolbar
If this is checked, the main window toolbar is displayed.



Show MDI task bar
If this is checked, Eudora displays the Eudora taskbar at the bottom of the window work area. This taskbar contains buttons for 
all open and minimized normal Eudora windows. Click the buttons on the taskbar to activate the indicated window. The Eudora 
taskbar functions similarly to the Microsoft Windows 95 and NT taskbars, but the Eudora taskbar cannot be moved and cannot 
be separately resized.



Use Microsoft viewer

If this is unchecked, Eudora displays advanced formatting, graphics, and multimedia in incoming and outgoing messages using 
its own built-in viewer. If this is checked, Eudora takes full advantage of the Web browser capabilities of Microsoft's Internet 
Explorer 3.0 or 4.0 by showing Web content right in incoming and outgoing messages or linking to the Internet, without your 
having to open the Web browser. This option is only available if you have Microsoft's Internet Explorer version 3.0 or higher 
installed and available on your system.



Show message preview pane

If this is checked, Eudora displays the message preview pane in mailbox windows. The preview pane previews a single selected 
message. A splitter between the preview pane and the message summary list lets you resize the preview pane relative to the list.



Mark previewed messages as read after ? second(s)

If this is checked and the Show message preview pane option is checked, the message currently selected in the mailbox window
and previewed in the preview pane is automatically marked as read (blank in the Status column) after the specified number of 
seconds. If this is unchecked, a previewed message will not be automatically marked as read. To return a message to the 
Unread status (bullet in the Status column) after it has been marked as read, press Ctrl+Space. Press again to return to read 
status.



Zoom windows when opening

If this option is on, new message windows automatically open to their "zoomed" size. The zoomed size is computed on a 
window-by-window basis. For message windows, zoomed size is just long enough to display all of the message (but no longer 
than the main window), and as wide as the Message window width setting. Composition windows zoom to the height specified 
by the Message window height setting.



Show toolbar tips
If this is checked, holding the mouse pointer over a button in the main window toolbar displays a very brief description of that 
button's function.



Show status bar
If this is checked, a status bar is displayed at the bottom of the main window. The status bar provides a brief description of menu 
items and toolbar buttons.



Show category icons
If this is checked, the Options categories are presented with icons and the name.
If this is not checked, the categories are presented with just the name.



Show attachment icons
If this is checked, the icon for an attachment is displayed, along with the attachment name, in the body of incoming message 
windows and the message preview pane in mailbox windows. If this is unchecked, only the attachment's name is displayed in 
incoming messages and the preview pane.



Labels
The Labels options define the title and color of the seven labels that can be used to categorize messages. To change a label title,
type the new title in the field to the right of the label number. To change a label color, single-click on the label number to display 
the Color dialog.
In the Color Dialog, you can select from one of the pre-defined Basic Colors or create your own Custom Colors. To assign a 
basic color to a label, select the color and click OK. To create a custom color, click the Define Custom Colors button to display 
the custom colors palette.
To define a custom color, select one of the 16 custom color boxes. Using the mouse pointer, click anywhere on the color palette 
to select the color Hue and Saturation. Use the color control bar to the right of the color palette to adjust the color. When you are 
satisfied with the color, click the Add to Custom Colors button. Once you have completed creating the custom colors, select the 
desired label color and click OK.



Use an alert dialog box
If this is checked, an alert dialog notifies you when you have new mail.



Open mailbox
If this is checked, mailboxes are opened when new mail is received, and the first unread message is highlighted.



Play a sound
If this is checked, Eudora plays the sound when new mail arrives.
To select a sound (.wav) file, click on the Play a sound button. The Select Sound File dialog is displayed so that you can select 
a sound.



Select Sound File
Specifies the sound file to be played when new mail arrives.
To select a sound (.wav) file, click on this button. The Select Sound File dialog is displayed so that you can select a sound.



Generate Filter Report
If this is checked, a Filter Report is generated with information about filtered messages.



Delete unread mail
If this is checked, a warning dialog is displayed when you try to delete unread mail.



Delete queued mail
If this is checked, a warning dialog is displayed when you try to delete queued mail.



Delete unsent mail
If this is checked, a warning dialog is displayed when you try to delete unsent mail.



Queue a message with no subject
If this is checked, a warning dialog is displayed when you try to queue a message with no subject.



Ask me each time
If this is checked, a warning dialog is displayed when you try to queue a message with styled text.



Quit with messages queued to be sent
If this is checked, a warning dialog is displayed when you try to quit with messages queued to be sent.



Queue a message bigger than ? K
If this is checked, a warning dialog is displayed when you try to queue a message bigger than the specified size.



Empty the Trash mailbox
If this is checked, a warning dialog is displayed when you try to empty the Trash mailbox.



Start Eudora and it's not the default mailer
If this is checked, a warning dialog is displayed when you try to start Eudora and it’s not the default e-mail application.



Switch views for Find

If this is checked, you are warned if you try to perform a Find operation (using the Edit menu Find submenu) while viewing an 
incoming message using Microsoft's Internet Explorer version 3.0 viewer. The warning indicates that Eudora will switch to a 
different viewer to complete the Find operation. Eudora uses Internet Explorer (IE) 3.0 as the default viewer if IE 3.0 is installed 
and available on your system and the Use Microsoft's viewer option is checked in the Viewing Mail Options.



Map Ctrl+R to "Reply to All"
If this is checked, when you type Ctrl-r a reply message is created addressed to all the recipients of the selected message The 
change is reflected on the Message menu.



Copy original's priority to reply
If this is checked, when you do a Reply the reply has the same priority as the original message.



Automatically FCC to original mailbox
If this is checked, replies are automatically copied to the mailbox the original message is in.



When Replying to all
These options specify how a reply message will be generated.



Include yourself
If this (and Reply to all) is checked, when you do a Reply the reply includes your address so that you receive a copy of your own
reply.
If this is not checked, the reply does not include your address and you do not receive a copy. (Unless you have checked Keep 
copies of outgoing mail in the Sending Mail category.)



Put original To: recipients in Cc: field
If this (and Reply to all) is checked, when you do a Reply the reply includes the addresses of the original message recipients in 
the Cc: field. The To: field contains only the address of the original sender.



Show Mailbox Columns: Status
If this is checked, the Status column is displayed in Mailbox windows.



Show Mailbox Columns: Priority
If this is checked, the Priority column is displayed in Mailbox windows.



Show Mailbox Columns: Attachment
If this is checked, the Attachment column is displayed in Mailbox windows.



Show Mailbox Columns: Label
If this is checked, the Label column is displayed in Mailbox windows.



Show Mailbox Columns: Sender
If this is checked, the Sender column is displayed in Mailbox windows.



Show Mailbox Columns: Date
If this is checked, the Date column is displayed in Mailbox windows.



Show Mailbox Columns: Size
If this is checked, the Size column is displayed in Mailbox windows.



Show Mailbox Columns: Server status
If this is checked, the Server status column is displayed in Mailbox windows.



Show Mailbox Columns: Subject
If this is checked, the Subject column is displayed in Mailbox windows.



Ignore capitalized words
If this is checked, words that start with capital letters, such as proper nouns, are ignored.



Ignore words with numbers
If this is checked, words that contain numbers are ignored.



Ignore words with mixed case
If this is checked, words that contain both upper and lower case characters are ignored.



Report doubled words
If this is checked, words that appear twice in sequence in text are reported and identified as doubled words.



Ignore words with all capitals
If this is checked, the spelling checker ignores words that contain all capital letters, such as acronyms.



Suggest Words
If this is checked, then when the spelling checker encounters an unknown word, it displays Eudora's suggestions for the correct 
spelling of the word in the Suggestions field of the Check Spelling dialog. You can also select any combination of the suggestion 
options: Phonetic words, Split words, Typographic words. Note that if Eudora has no suggestions in its dictionary for the word, 
then no suggestions are listed.



Ignore Original Text
If this is checked, quoted text (preceded by “>” or “|” ) is ignored. Eudora assumes that this text was originally from another 
message, and therefore does not need to be checked.



Check when message queue/send selected
If this is checked, the spelling in a message is checked when you queue or send the message.



Warn me when I queue/send a message without completing the spell check
If this is checked, a warning dialog is displayed when a message is queued or sent without a complete spell check.



Display dates using Sender’s timezone
If this is checked, messages are displayed with the sender’s time and date, as determined by the sender’s time zone.



Display dates using Local timezone
If this is checked, messages are displayed with your time and date based on your time zone.



Date formats: Fixed
If this is checked, all messages are displayed with the time and date as specified by the formatting you enter in this field. See the
formatting key in the Options panel.



Date formats: Age-sensitive
If this is checked, all messages are displayed with times and dates as specified by your entries in the fields related to RECENT, 
OLD, and ANCIENT times. The hours determining these times are specified in the Hours to be OLD and Hours to be Ancient 
fields. See the formatting key in the Options panel.



RECENT format
Enter the formatting you with to use to display dates and times of the most recent messages. See the formatting key in the 
Options panel.



Hours to be OLD
Enter the number of hours at which messages are to be considered old. The number of hours is measured from the current 
system time. This number is the cutoff point between RECENT and OLD messages.



Hours to be ANCIENT
Enter the number of hours at which messages are to be considered ancient. The number of hours is measured from the current 
system time. This number is the cutoff point between OLD and ANCIENT messages.



OLD format
Enter the formatting you with to use to display dates and times of messages considered OLD. OLD messages are determined by
the number in the Hours to be OLD field. See the formatting key in the Options panel.



ANCIENT format
Enter the formatting you with to use to display dates and times of messages considered ANCIENT. ANCIENT messages are 
determined by the number in the Hours to be ANCIENT field. See the formatting key in the Options panel.



Switch messages with
These options specify what keys can be used to quickly open and close message windows.



Unmodified arrow keys
If this is checked, the keyboard arrow keys can be used to close the current message and open the next or previous message in 
the mailbox.
The up or left arrow key opens the previous message; the down or right arrow key opens the next message. If this option is off, 
the arrow keys can be used to move the caret in messages.
Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there is a message composition window topmost 
on the screen.



Ctrl+arrow keys
If this is checked, you can switch between open messages by holding down the [Ctrl] key and then pressing the arrow keys.



Alt+arrow keys
If this is checked, you can switch between open messages by holding down the [Alt] key and then pressing the arrow keys.



Close messages with mailbox
If this is checked, all open messages are closed when you close the mailbox they are in.



Empty Trash when exiting
If this is checked, the Trash mailbox is emptied every time you exit Eudora.
If this is not checked, the Trash is only emptied when you select Empty Trash from the Special menu.
If you want to remove some messages from the Trash mailbox but don't want to empty it entirely, highlight the summaries you 
want to delete and select Delete from the Message menu. The selected messages are deleted.



Say OK to alerts after ? seconds
If this is checked and a number of seconds is specified, any notices of network problems are dismissed after the specified 
number of seconds.
If this is not checked, notices are left in place and Eudora cannot try the communication again until you dismiss the alert.



Turbo redirect by default
If this is checked, a Redirect to Recipient command does the following:
Opens a redirected message to the selected recipient
Queues the new message
Deletes the original message
To turn this option on or off (regardless of this setting), hold down the [Shift] key while selecting a redirect recipient.



Allow Drag and Drop Transfers
If this is checked, you are able to “drag and drop” messages among mailboxes.



Intercept Netscape mailto URLs
If this is checked, when you click on a mailto URL in Netscape (a e-mail address link) a new Eudora message is opened for that 
address.



Include outdated ‘Return-Receipt-To’
If this is checked, the old-style Return-Receipt-To header is included with the new Disposition-Notification-To header.



Automatically expand nicknames
If this is checked, when you enter nicknames into message address fields the entire address(es) of the nickname is entered into 
the field, not just the nickname.



Server Name (ACAP)
This is the ACAP server name to which you wish to connect to retrieve the pre-configured Eudora settings. If the ACAP server 
name is not displayed in this field, contact your administrator or postmaster.



User Name (ACAP)
Enter your user name. With your user name and password, you can access the ACAP server to retrieve your preconfigured 
Eudora settings. Your system administrator or postmaster will provide this user name to you if your settings are available on an 
ACAP server.



Password (ACAP)
Enter your password. With your user name and password, you can access the ACAP server to retrieve your preconfigured 
Eudora settings. Your system administrator or postmaster will provide this password to you if your settings are available on an 
ACAP server.



Retrieve Settings Now
Click this button to retrieve you preconfigured settings. The preconfigured settings will replace the settings you now have on 
Eudora.



Use asynchronous Winsock calls for
These options specify how Winsock calls are made using a TCP/IP stack. If you're experiencing trouble with your Winsock 
connection, make sure both of these options are off.



All non-database functions
Specifies asynchronous Winsock calls for all non-database functions.
There are two methods of making Winsock calls using TCP/IP stacks, blocking and asynchronous. Because of the ability to 
handle error conditions more gracefully, asynchronous is the preferred method when using Eudora. However, some TCP/IP 
stacks do not handle asynchronous calls correctly. If you're experiencing trouble with your Winsock connection, make sure both 
of these options are off.



Database functions
Specifies asynchronous Winsock calls for database functions.
There are two methods of making Winsock calls using TCP/IP stacks, blocking and asynchronous. Because of the ability to 
handle error conditions more gracefully, asynchronous is the preferred method when using Eudora. However, some TCP/IP 
stacks do not handle asynchronous calls correctly. If you're experiencing trouble with your Winsock connection, make sure both 
of these options are off.



Network open timeout ? seconds
Specifies the number of seconds before a network connection will time out.



Network timeout after ? seconds
Specifies the number of seconds before a network connection will time out.



Network buffer size of ? bytes
Specifies the size of the buffer that Eudora uses to transfer information to and from the server.
If you are having trouble transferring large messages, the size of this buffer may be decreased.



Cache network info
If this is checked, Eudora remembers the results of previous database functions when using the Winsock connection method.
This speeds up database functions within a single Eudora session.



Unload Winsock DLL after closing socket
If this is checked, the Winsock DLL is unloaded after the socket is closed.
This is useful if you don’t want Eudora to keep your Winsock DLL open continuously.



Automatically dial & hangup this connection
If this is checked, the specified dialup connection (referred to in Windows NT 4.0 as a “phonebook entry”) is used when Eudora 
does any network operation. Use the popup menu of connections to be sure the Entry is correct.
This option is only available if you have installed the dialup networking services with Windows 95 or Windows NT 4.0.



Username
This specifies the username to be used with the auto connection.



Save password
If this is on, the password for the auto connection is saved in Eudora so that you do not have to re-enter it after exiting Eudora.
If you select Forget Password(s) from the Special menu, you will be prompted for the password the first time you try to check 
mail.



Use Eudora MAPI server
These options specify when the Eudora MAPI server should run.



Use Eudora MAPI Server: Never
If this is checked, the Eudora MAPI server is off and is never automatically opened.



Use Eudora MAPI Server: Always
If this is checked, the Eudora MAPI server is on and is always opened on startup.



Use Eudora MAPI Server: When Eudora is running
If this is checked, the Eudora MAPI server is on when Eudora is running.



Delete MAPI attachments
These options specify when MAPI attachments should be deleted.



Delete MAPI attachments: Never
If this is checked, MAPI attachments are never deleted.
MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you want to save
them, use this option.



Delete MAPI attachments: After sending message
If this is checked, MAPI attachments are deleted after their corresponding messages are sent.
MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you do not want 
to save them, use this option.



Delete MAPI attachments: When message is emptied from trash
If this is checked, MAPI attachments are deleted after their corresponding messages are emptied from the trash.
MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you do not want 
to save them after their corresponding messages have been deleted, use this option.



Kerberos POP3 port
Specifies the port that the Kerberos POP server is listening on.



Realm
Specifies the network realm that the Kerberos server resides in.



Service name
Specifies the type of service that you're requesting.



Service format
Specifies the name of the ticket that Eudora requests from the Kerberos server.



Discard style information
If this is checked, no text style information will be sent with messages.



Add Details
After setting up your filter information, click this button to both create your filter and also open the Filters window so that you can 
add additional information to your new filter and make it more powerful or just change it. The filter is added to the bottom of your 
filters list and is immediately available in the form in which it was set up in the Make Filter dialog. Any changes you make in the 
Filters window must be saved before they become effective. 



Offline
Turn this on if you don’t want Eudora to make any connections. This is good to have on if you’re using Eudora on a laptop 
computer that is not continuously connected.



Message window height
This specifies the height of new and received message windows (in lines).

Note: If the Zoom windows when opening option is turned on, received message window heights are automatically adjusted 
to the height of the message text.



Automatically open next message
If this is on, deleting or transferring the current message opens the next message in the mailbox, but only if that message is 
unread.



Message window width
This specifies the width of new and received message windows (in characters). This option has no effect on what your mail looks 
like when it is sent. When mail is sent, Eudora wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the average width of the characters in the font.



Show mailbox lines
If this option is on, lines are displayed in the message summaries portion of mailbox windows, horizontal lines to separate 
message summaries, and vertical lines to separate columns.



Select newly inserted messages (FUMLUB)
Turn this on if you want the first message of the most current block of unread messages highlighted in the Table of Contents 
window. FUMLUB means First Unread Message of the Last Unread Block.    For example, you may have a series of unread 
messages in a mailbox scattered throughout your Table of Contents. The first message of the last block of unread messages listed
in your Table of Contents is selected. 



Allow drag select messages
Turn this on to click and drag adjacent messages in the Table of Contents window. This allows you to transfer a group of 
messages to a mailbox or to delete them if the “Allow drag and drop transfers” is turned on. The drag select works only if the drag 
starts on an unselected (not highlighted) message.



Show formatting toolbar
Turn this on to display the formatting toolbar by default in new message windows. If this is off, the formatting toolbar is hidden by 
default in new message windows. This toolbar lets you easily format text styles in new messages.



When sending mail with styled text (HTML)
This specifies what to do with HTML text styles when you send mail. The styles are delivered to your recipients using the 
HyperText Marking Language (HTML) format. However, the styles your recipient sees depends on how well their e-mail software 
supports this standard. 

HTML is the text formatting standard used in the World Wide Web by Web browsers and newer e-mail applications. HTML allows 
you use enriched text, which includes different fonts, color, sizes, bold, etc. Also, HTML lets you embed pictures and create bullet 
lists in the e-mails you send.

Send plain and styled version in message ¾    Turn this on to send all text including plain and HTML text styles with your 
messages. 

Send styled text only ¾    Turn this on to send only HTML text styles with your messages. 

Send plain text only ¾ Turn this on to send only plain text, not HTML text styles with your messages.



Send single MAPI file attachment as inline attachment (TXT and HTML files only)
Turn this on when you need to have the MAPI client send a single TXT or HTML file as an attachment with no message body text. 
Eudora turns off the Text As Attachment button in the outgoing message toolbar (if it is on), so that the document is sent to the 
recipient as inline text in the message body. This allows MAPI clients, such as Internet Explorer, to pass Web pages and other 
HTML and TXT documents right into the body of the Eudora message. (The Text As Attachment button, if turned on in the outgoing
message toolbar, instructs Eudora to attach text files, such as TXT and HTML, to the message rather than incorporating the text 
into the message as part of the message body. The default state of this button is controlled by the Put text attachments in body of 
message option in the Attachments options. 



Automation enabled from this machine
Turn this on to perform the automation operations from the computer on which Eudora is installed.

The Automation options let you control and exchange information with Eudora from other programs that support the Windows 
Automation Interface, such as Microsoft Visual Basic.

Automation gives you external access to Eudora mail folders, mailboxes, and messages, and to the Eudora application itself. With 
automation enabled, you can create, delete, and move Eudora mail folders, mailboxes, and messages, as well as get notification 
of these three operations when they are performed manually. You can also get lists of the subfolders under folders and of the 
messages within mailboxes.



Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your 
questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Go the Eudora Technical Support Web Pages at <http://www.eudora.com/techsupport/>.

For additional support, refer to your Eudora site license contract for the telephone number or email address provided.

Additional Software Technical Support

Eudora Pro includes a number of additional "bundled" software licenses that are supported by their 
publishers. To obtain technical support for these licenses, use the contact information provided below.

Note: The software products listed below are limited to those not supported by the Eudora technical 
support staff.

McAfee VirusScan
For the latest technical support information, link to <http://www.mcafee.com>. Otherwise, McAfee also 
offers you:

Automated Voice and Fax Response System: (408) 988-3034
Internet email: support@mcafee.com
McAfee BBS: (408) 988-4004
1200 bps to 28,800 bps, 8 bits, no parity, 1 stop bit, 24 hours, 365 days a year

If the automated services did not solve your problem, you may contact McAfee Monday through Friday, 
between 6:00 A.M. and 6:00 P.M. Pacific time, at (408) 988-3832, or fax your problem to (408) 970-9727.

Aladdin StuffIt Expander
To obtain support for Aladdin StuffIt Expander, send e-mail to support@aladdinsys.com; fax (408) 761-
6206; or phone (408) 761-6200. For additional product information, link to <http://www.aladdinsys.com>.

Verity KeyView
For additional product information, link to <http://www.keyview.com>.

In addition to the above licenses, your copy of Eudora may also include one or more of the following 
licenses:

JFAX
Contact technical support at (310) 966-1818, or send e-mail to: help@jfax.com.



ichat and Eudora Internet Pager by ichat
iChat offers you web-based technical support at <http://www.ichat.com>.



Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Go the Eudora Technical Support Web Pages at <http://www.eudora.com/techsupport/>.

Send mail to eudora-support@qualcomm.com. Please include your registration number.

Users eligible for telephone support can call 1-619-658-1292. Purchasers of Eudora are eligible for a limited 
period of support. Please have your registration number ready.

Additional Software Technical Support

Eudora Pro includes a number of additional "bundled" software licenses that are supported by their 
publishers. To obtain technical support for these licenses, use the contact information provided below.

Note: The software products listed below are limited to those not supported by the Eudora technical 
support staff.

McAfee VirusScan
For the latest technical support information, link to <http://www.mcafee.com>. Otherwise, McAfee also 
offers you:

Automated Voice and Fax Response System: (408) 988-3034
Internet email: support@mcafee.com
McAfee BBS: (408) 988-4004
1200 bps to 28,800 bps, 8 bits, no parity, 1 stop bit, 24 hours, 365 days a year

If the automated services did not solve your problem, you may contact McAfee Monday through Friday, 
between 6:00 A.M. and 6:00 P.M. Pacific time, at (408) 988-3832, or fax your problem to (408) 970-9727.

Aladdin StuffIt Expander
To obtain support for Aladdin StuffIt Expander, send e-mail to support@aladdinsys.com; fax (408) 761-
6206; or phone (408) 761-6200. For additional product information, link to <http://www.aladdinsys.com>.

Verity KeyView
For additional product information, link to <http://www.keyview.com>.

In addition to the above licenses, your copy of Eudora may also include one or more of the following 
licenses:

JFAX
Contact technical support at (310) 966-1818, or send e-mail to: help@jfax.com.

ichat and Eudora Internet Pager by ichat
iChat offers you web-based technical support at <http://www.ichat.com>.



Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Go the Eudora Technical Support Web Pages at <http://www.eudora.com/techsupport/>.

Additional Software Technical Support

Eudora Pro includes a number of additional "bundled" software licenses that are supported by their 
publishers. To obtain technical support for these licenses, use the contact information provided below.

Note: The software products listed below are limited to those not supported by the Eudora technical 
support staff.

McAfee VirusScan
For the latest technical support information, link to <http://www.mcafee.com>. Otherwise, McAfee also 
offers you:

Automated Voice and Fax Response System: (408) 988-3034
Internet email: support@mcafee.com
McAfee BBS: (408) 988-4004
1200 bps to 28,800 bps, 8 bits, no parity, 1 stop bit, 24 hours, 365 days a year

If the automated services did not solve your problem, you may contact McAfee Monday through Friday, 
between 6:00 A.M. and 6:00 P.M. Pacific time, at (408) 988-3832, or fax your problem to (408) 970-9727.

Aladdin StuffIt Expander
To obtain support for Aladdin StuffIt Expander, send e-mail to support@aladdinsys.com; fax (408) 761-
6206; or phone (408) 761-6200. For additional product information, link to <http://www.aladdinsys.com>.

Verity KeyView
For additional product information, link to <http://www.keyview.com>.

In addition to the above licenses, your copy of Eudora may also include one or more of the following 
licenses:

JFAX
Contact technical support at (310) 966-1818, or send e-mail to: help@jfax.com.

ichat and Eudora Internet Pager by ichat
iChat offers you web-based technical support at <http://www.ichat.com>.



Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Go the Eudora Technical Support Web Pages at <http://www.eudora.com/techsupport/>.

Send mail to eudora-support-bus@qualcomm.com. Please include your registration number.

Users eligible for telephone support can call 1-619-658-1938. Designated technical contacts are eligible for a 
limited period of support. Please have your registration number ready.

Additional Software Technical Support

Eudora Pro includes a number of additional "bundled" software licenses that are supported by their 
publishers. To obtain technical support for these licenses, use the contact information provided below.

Note: The software products listed below are limited to those not supported by the Eudora technical 
support staff.

McAfee VirusScan
For the latest technical support information, link to <http://www.mcafee.com>. Otherwise, McAfee also 
offers you:

Automated Voice and Fax Response System: (408) 988-3034
Internet email: support@mcafee.com
McAfee BBS: (408) 988-4004
1200 bps to 28,800 bps, 8 bits, no parity, 1 stop bit, 24 hours, 365 days a year

If the automated services did not solve your problem, you may contact McAfee Monday through Friday, 
between 6:00 A.M. and 6:00 P.M. Pacific time, at (408) 988-3832, or fax your problem to (408) 970-9727.

Aladdin StuffIt Expander
To obtain support for Aladdin StuffIt Expander, send e-mail to support@aladdinsys.com; fax (408) 761-
6206; or phone (408) 761-6200. For additional product information, link to <http://www.aladdinsys.com>.

Verity KeyView
For additional product information, link to <http://www.keyview.com>.

In addition to the above licenses, your copy of Eudora may also include one or more of the following 
licenses:

JFAX
Contact technical support at (310) 966-1818, or send e-mail to: help@jfax.com.

ichat and Eudora Internet Pager by ichat
iChat offers you web-based technical support at <http://www.ichat.com>.



Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Go the Eudora Technical Support Web Pages at <http://www.eudora.com/techsupport/>.

Send mail to eudora-eval@qualcomm.com. Please include your registration number.

Users eligible for telephone support can call 1-619-658-1939. Purchasers of Eudora are eligible for a limited 
period of support. Please have your registration number ready.

Additional Software Technical Support

Eudora Pro includes a number of additional "bundled" software licenses that are supported by their 
publishers. To obtain technical support for these licenses, use the contact information provided below.

Note: The software products listed below are limited to those not supported by the Eudora technical 
support staff.

McAfee VirusScan
For the latest technical support information, link to <http://www.mcafee.com>. Otherwise, McAfee also 
offers you:

Automated Voice and Fax Response System: (408) 988-3034
Internet email: support@mcafee.com
McAfee BBS: (408) 988-4004
1200 bps to 28,800 bps, 8 bits, no parity, 1 stop bit, 24 hours, 365 days a year

If the automated services did not solve your problem, you may contact McAfee Monday through Friday, 
between 6:00 A.M. and 6:00 P.M. Pacific time, at (408) 988-3832, or fax your problem to (408) 970-9727.

Aladdin StuffIt Expander
To obtain support for Aladdin StuffIt Expander, send e-mail to support@aladdinsys.com; fax (408) 761-
6206; or phone (408) 761-6200. For additional product information, link to <http://www.aladdinsys.com>.

Verity KeyView
For additional product information, link to <http://www.keyview.com>.

In addition to the above licenses, your copy of Eudora may also include one or more of the following 
licenses:

JFAX
Contact technical support at (310) 966-1818, or send e-mail to: help@jfax.com.

ichat and Eudora Internet Pager by ichat
iChat offers you web-based technical support at <http://www.ichat.com>.




